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Preface

This guide is the primary source of user and reference information on the Oracle
Application Server Integration Adapter for IMS/DB, which enables client
applications to access Virtual Storage Access Method (VSAM) data through the Sun
2JEE Connector Architecture (JCA) API using Structured Query Language (SQL).

This document describes the features of Oracle Application Server Integration
Adapter for IMS/DBS software that apply to the IBM OS/390 and z/OS Series,
Windows NT, Windows 2000, Windows XP, and Windows Server 2003 operating
systems.

This preface contains these topics:
= Audience

= Organization

= Related Documentation

= Conventions

s Documentation Accessibility
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Audience

This manual is intended for Oracle integration administrators who perform the
following tasks:

» Installing and configuring the Oracle Application Server Integration Adapter
for IMS/DB

= Diagnosing errors

= Using Oracle Application Server ProcessConnect to access IMS/DB data

Note: You should understand the fundamentals of Oracle
Application Server ProcessConnect and the IBM OS/390 and z/OS
series and Microsoft Windows operating system before using this
guide to install or administer the Oracle Application Server
Integration Adapter for IMS/DB.

Organization

This document contains:

Chapter 1, "Overview of the Oracle Application Server Integration Adapter for
IMS/DB"

This chapter introduces the Oracle Application Server Integration Adapter for
IMS/DB.

Chapter 2, "Installing the Oracle Application Server Integration Adapter for
IMS/DB"

This chapter explains how to install Oracle Connect for IMS/DB on an IBM OS/390
or z/OS series operating system and Oracle Studio on a Windows platform.

Chapter 3, "Modeling Interactions for Oracle Application Server Integration
Adapter for IMS/DB"

This chapter describes how to model interactions in Oracle Studio.
Chapter 4, "Using Interactions in a Business Process"

This chapter describes how to include Oracle Connect for IMS/DB interactions in a
business process in Oracle Application Server ProcessConnect.
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Chapter 5, "Oracle Application Server Integration Adapter for IMS/DB Features
and Restrictions"

This chapter describes specific features of the Oracle Application Server Integration
Adapter for IMS/DB.

Chapter 6, "Troubleshooting the Oracle Application Server Integration Adapter
for IMS/DB"

This chapter describes how to troubleshoot problems both during modeling and
runtime.

Appendix A, "The Oracle Connect for IMS/DB Metadata Definitions"

This appendix describes the metadata for an IMS/DB data source and an Oracle
Connect for IMS/DB backend adapter definition.

Appendix B, "Datatype Support"

This appendix describes how COBOL datatypes are converted to Oracle Connect
for IMS/DB datatypes and Oracle datatypes.

Appendix C, "Supported SQL Syntax and SQL Enhancements"

This appendix describes the supported SQL syntax that can be used with the Oracle
Application Server Integration Adapter for IMS/DB and SQL enhancements that
are not part of standard ANSI 92 SQL.

Appendix D, "Daemon Configuration Settings"

This appendix describes daemon configuration used to control client/server
communication.

Appendix E, "COBOL APIs to Applications"

This appendix describes how to access the Oracle Application Server Integration
Adapter for IMS/DB from a COBOL program.

Related Documentation
For more information, see these Oracle resources:
»  Oracle Application Server ProcessConnect User’s Guide
Printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/
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To download free release notes, installation documentation, white papers, or other
collateral, please visit the Oracle Technology Network (OTN). You must register
online before using OTN; registration is free and can be done at

http://otn.oracle.com/membership/

If you already have a username and password for OTN, then you can go directly to
the documentation section of the OTN Web site at

http://otn.oracle.com/documentation/

Conventions

This section describes the conventions used in the text and code examples of this
documentation set. It describes:

s Conventions in Text
= Conventions in Code Examples

= Conventions for Windows Operating Systems

Conventions in Text

We use various conventions in text to help you more quickly identify special terms.
The following table describes those conventions and provides examples of their use.

Convention Meaning Example
Bold Bold typeface indicates terms that are When you specify this clause, you create an
defined in the text or terms that appear in index-organized table.
a glossary, or both.
Italics Italic typeface indicates book titles or Oracle9i Database Concepts
emphass. Ensure that the recovery catalog and target
database do not reside on the same disk.
UPPERCASE Uppercase monospace typeface indicates ~ You can specify this clause only for a NUMBER
monospace elements supplied by the system. Such column.

(fixed-width)
font

xviii

elements include parameters, privileges,
datatypes, RMAN keywords, SQL
keywords, SQL*Plus or utility commands,
packages and methods, as well as Query the TABLE_NAME column in the USER_
system-supplied column names, database TABLES data dictionary view.

objects and structures, usernames, and
roles.

You can back up the database by using the
BACKUP command.

Use the DBMS_STATS.GENERATE_STATS
procedure.



Convention

Meaning

Example

lowercase Lowercase monospace typeface indicates Enter sglplus to open SQL*Plus.
monospace executables, filenames, directory names, . R .
(fixed-width) and sample user-supplied elements. Such The password is specified in the orapwd file.
font elements include computer and database  Back up the datafiles and control files in the
names, net service names, and connect /diskl/oracle/dbs directory.
identifiers, as well as user-supplied The department_id, department_name,
database objects and structures, column ; ; .
and location_id columns are in the
names, packages and classes, usernames
. hr.departments table.
and roles, program units, and parameter
values. Set the QUERY_REWRITE_ENABLED
. initialization parameter to true.
Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase. Connect as oe user.
Enter these elements as shown. The JRepUtil class implements these
methods.
lowercase Lowercase italic monospace font You can specify the parallel_clause.
italic represents placeholders or variables. Run Uold release.SOL where old._
monospace .
: ; release refers to the release you installed
(fixed-width) . di
Font prior to upgrading.
Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line
statements. They are displayed in a monospace (fixed-width) font and separated
from normal text as shown in this example:
SELECT username FROM dba_users WHERE username = 'MIGRATE';
The following table describes typographic conventions used in code examples and
provides examples of their use.
Convention Meaning Example
[ 1] Brackets enclose one or more optional DECIMAL (digits [ , precision ])

{

}

items. Do not enter the brackets.

Braces enclose two or more items, one of
which is required. Do not enter the braces.

A vertical bar represents a choice of two
or more options within brackets or braces.
Enter one of the options. Do not enter the
vertical bar.

{ENABLE | DISABLE}

{ENABLE | DISABLE}
[COMPRESS | NOCOMPRESS]



Convention

Meaning

Example

Other notation

Italics

UPPERCASE

lowercase

Horizontal ellipsis points indicate either:

= That we have omitted parts of the
code that are not directly related to
the example

= That you can repeat a portion of the
code

Vertical ellipsis points indicate that we
have omitted several lines of code not
directly related to the example.

You must enter symbols other than
brackets, braces, vertical bars, and ellipsis
points as shown.

Italicized text indicates placeholders or
variables for which you must supply
particular values.

Uppercase typeface indicates elements
supplied by the system. We show these
terms in uppercase in order to distinguish
them from terms you define. Unless terms
appear in brackets, enter them in the
order and with the spelling shown.
However, because these terms are not
case sensitive, you can enter them in
lowercase.

Lowercase typeface indicates
programmatic elements that you supply.
For example, lowercase indicates names
of tables, columns, or files.

Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase.
Enter these elements as shown.

CREATE TABLE ... AS subquery;

SELECT coll, col2, ... ,
employees;

coln FROM

SQL> SELECT NAME FROM VSDATAFILE;

/fsl/dbs/tbs_01.dbf
/fsl/dbs/tbs_02.dbf

/fsl/dbs/thbs_09.dbf
9 rows selected.

acctbal NUMBER (11,2);
acct CONSTANT NUMBER (4) := 3;

CONNECT SYSTEM/system password
DB NAME = database name

SELECT last_name, employee id FROM
employees;

SELECT * FROM USER TABLES;

DROP TABLE hr.employees;

SELECT last_name, employee id FROM
employees;

sglplus hr/hr

CREATE USER mjones IDENTIFIED BY ty3MU9;
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Conventions for Windows Operating Systems
The following table describes conventions for Windows operating systems and

provides examples of their use.

Convention

Meaning

Example

Choose Start >

File and directory
names

C:\>

Special characters

HOME,_NAME

How to start a program.

File and directory names are not case
sensitive. The following special characters
are not allowed: left angle bracket (<),
right angle bracket (>), colon (:), double
quotation marks ("), slash (/), pipe (1),
and dash (-). The special character
backslash (\) is treated as an element
separator, even when it appears in quotes.
If the file name begins with \\, then
Windows assumes it uses the Universal
Naming Convention.

Represents the Windows command
prompt of the current hard disk drive.
The escape character in a command
prompt is the caret (*). Your prompt
reflects the subdirectory in which you are
working. Referred to as the command
prompt in this manual.

The backslash (\) special character is
sometimes required as an escape
character for the double quotation mark
(") special character at the Windows
command prompt. Parentheses and the
single quotation mark (') do not require
an escape character. Refer to your
Windows operating system
documentation for more information on
escape and special characters.

Represents the Oracle home name. The
home name can be up to 16 alphanumeric
characters. The only special character
allowed in the home name is the
underscore.

To start the Database Configuration Assistant,
choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools >
Database Configuration Assistant.

c:\winnt"\"system32 is the same as
C: \WINNT\SYSTEM32

C:\oracle\oradata>

C:\>exp scott/tiger TABLES=emp
QUERY=\"WHERE job='SALESMAN' and
sal<1600\"

C:\>imp SYSTEM/password FROMUSER=scott
TABLES= (emp, dept)

C:\> net start OracleHOME NAMEINSListener
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Convention

Meaning

Example

ORACLE_HOME
and ORACLE._
BASE

In releases prior to Oracle8i release 8.1.3,
when you installed Oracle components,
all subdirectories were located under a
top level ORACLE_HOME directory. For
Windows NT, the default location was
C:\orant.

This release complies with Optimal
Flexible Architecture (OFA) guidelines.
All subdirectories are not under a top
level ORACLE_HOME directory. There is a
top level directory called ORACLE_BASE
that by defaultis C: \oracle. If you
install the latest Oracle release on a
computer with no other Oracle software
installed, then the default setting for the
first Oracle home directory is
C:\oracle\orann, where nnis the
latest release number. The Oracle home
directory is located directly under
ORACLE_BASE.

All directory path examples in this guide
follow OFA conventions.

Refer to Oracle9i Database Getting Started
for Windows for additional information
about OFA compliances and for
information about installing Oracle
products in non-OFA compliant
directories.

Go to the ORACLE,_BASE\ORACLE.__
HOME\rdbms\admin directory.

Documentation Accessibility

XXii

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to

evolve over time, and Oracle Corporation is actively engaged with other

market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,

visit the Oracle Accessibility Program Web site at

http://www.oracle.com/accessibility/



Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This
documentation may contain links to Web sites of other companies or organizations
that Oracle Corporation does not own or control. Oracle Corporation neither
evaluates nor makes any representations regarding the accessibility of these Web
sites.
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Overview of the Oracle Application Server

Integration Adapter for IMS/DB

This chapter introduces the Oracle Application Server Integration Adapter for
IMS/DB. The Oracle Application Server Integration Adapter for IMS/DB is a
plug-in component of Oracle Application Server ProcessConnect, enabling Oracle
Application Server ProcessConnect to access IMS/DB data on IBM OS/390 or z/OS
series operating systems.

This chapter contains the following sections:

Overview of Application Integration

Overview of IMS/DB and Oracle Application Server Integration Adapter for
IMS/DB

Integrating Oracle Application Server ProcessConnect with the Adapter for
IMS/DB

Modeling the IMS/DB Adapter Using Oracle Studio
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Overview of Application Integration

Overview of Application Integration

When business applications need to communicate with each other, the output from
one application is not always understandable by the other application. Application
adapters enable different applications to interoperate.

Adapters for application integration address a mismatch between the integrating
interface of a source or target application and the integration infrastructure, such as
Oracle Application Server ProcessConnect. Simple adapters only exchange data
using an API, but complex adapters can also do transformations (such as SQL to
XML), as well as deal with exception conditions. Therefore, adapters are a
combination of modeling tools and runtime software that act as "glue" to link
applications, considered as sources or targets (or both), to the integration
infrastructure that transports, translates, transforms, and routes data between
systems. On the one hand, an adapter deals with a group of touchpoints (one or
more entry/exit points, collectively an interface) for a source or target; on the other
hand, an adapter links to the integration infrastructure. This means that adapters
generally have two interfaces - one that is native to the source or target application
and the other that is native to the integrating infrastructure. Adapters perform a
variety of key tasks, including recognizing events, collecting and transforming data,
and exchanging data with the integration infrastructure. They also handle exception
conditions, and can often dynamically (or with minor reconfiguration changes)
accommodate new revisions of back-end applications.

Each task performed by the adapter is defined as an interaction. Interactions that
are initiated by the source or target application are referred to as inbound
interactions. Interactions that are initiated by the integrating infrastructure are
referred to as outbound interactions.

Overview of IMS/DB and Oracle Application Server Integration Adapter

for IMS/DB

The Oracle Application Server Integration Adapter for IMS/DB is a plug-in
component of Oracle Application Server ProcessConnect.

The Oracle Application Server Integration Adapter for IMS/DB models IMS/DB as
a database with an SQL front end. The adapter is native to the data source and
0S5/390, providing direct access that results in improved performance.
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IMS/DB Data

IMS/DB (Information Management System - Data Base) is a high-performance
hierarchical database.

The data access API to IMS/DB is called DL/I, which is a function by which the
IMS/DB database can be traversed and operated on. Working with DL /I requires
the caller to run under the control of IMS/DB. APIs are also available to enable
access to IMS/DB from CICS and IMS/TM transactions.

The Oracle Application Server Integration Adapter for IMS/DB captures and
maintains a metadata schema for IMS/DB by importing various IMS definition files
such as a PSB file, DBD files and COBOL copybooks. These are transformed into
mapping definition for Oracle Connect for IMS/DB on the OS/390 machine.

The Oracle Application Server Integration Adapter for IMS/DB uses an enterprise
application integration (EAI) model. Users of a requesting application can model
the interactions that they want implemented, specifying what each interaction does,
when it occurs and the inputs and outputs expected for each interaction. Moreover,
the Oracle Application Server Integration Adapter for IMS/DB maps data
structures, facilitating access to IMS/DB data from within Oracle Application
Server ProcessConnect.

The Oracle Application Server Integration Adapter for IMS/DB implements
outbound interactions as parameterized SQL with the parameters forming the input
record, and with the output (in cases where there is an output) aggregated into an
XML document forming the output record.

IMS/DB does not have a concept of procedures or triggers. Applications that use
IMS/DB may need to interact with Oracle Application Server ProcessConnect by
sending it a native event. For inbound interactions the IMS/DB application uses a
special API to send a native event to a queue running on the mainframe and the
adapter subscribes to that queue for inbound event handling. Typically, each
application associated with Oracle Connect for IMS/DB will subscribe to a
dedicated queue.

The Oracle Application Server Integration Adapter for IMS/DB includes the
options to access IMS/DB data managed by CICS, IMS/TM or directly.

Accessing IMS/DB Data Under CICS

When IMS/DB records are defined under CICS, all access to the data is managed by
CICS. The Oracle Application Server Integration Adapter for IMS/DB includes an
option to access the IMS/DB data under CICS.
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Accessing IMS/DB Data Under IMS/TM

When IMS/DB records are defined under IMS/TM, all access to the data is
managed by IMS/TM. The Oracle Application Server Integration Adapter for
IMS/DB includes an option to access the IMS/DB data under IMS/TM.

Accessing IMS/DB Data Directly

The Oracle Application Server Integration Adapter for IMS/DB includes an option
to access the IMS/DB data directly.

Architecture of the Oracle Application Server Integration Adapter for IMS/DB

The Oracle Application Server Integration Adapter for IMS/DB includes the
following components:

=  The IMS/DB adapter, which resides in Oracle Application Server
ProcessConnect

s Oracle Connect for IMS/DB, which resides on the OS/390 machine

= A GUI-based configuration tool, called Oracle Studio for Legacy Adapters,
which resides on a Windows platform.

Note: Throughout this manual Oracle Studio for Legacy Adapters
is referred to as Oracle Studio.

The components of the Oracle Application Server Integration Adapter for IMS/DB
interact with each other, as shown in Figure 1-1 on page 1-5.
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Figure 1-1 Architecture of the Oracle Application Server Integration Adapter for

IMSs/DB
Oracle Application Server IBM 0S/390 Platform
ProcessConnect
Platform Oracle Connect for
IMS /DB
Oracle Application
Server Database
ProcessConnect <4—P| Adapter
Daemon| pep
!/_\'\ggé,?eBr 4 »| Listener :
—p| IMS/DB
Driver
Oracle Studio for | *
Legacy Adapters Platform *
Oracle -
Studio
IMS/DB
Data

The IMS/DB adapter enables communication with Oracle Connect for IMS/DB on
the OS/390 platform.

Oracle Connect for IMS/DB is comprised of three main components:

Daemon (a listener) - Responsible for managing and allocating server processes
for client requests coming from Oracle Application Server ProcessConnect.
Server processes can be started per client or kept in a pool for reuse. The
daemon resides in a single address space and is executed as a started task.

See Also: "Troubleshooting the Daemon" on page 6-4 and
Appendix D, "Daemon Configuration Settings" for details about the
daemon

Database adapter - Provides the interaction definitions and input and output
record schemas required to access the IMS/DB data

IMS/DB driver - Accesses the IMS/DB data based on database adapter
interactions

Oracle Studio is used to model the adapter interactions and manage the back-end
component.
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Inbound Interactions

When IMS/DB runs under CICS or IMS/TM, it can interact with Oracle Application
Server ProcessConnect by sending it a native event. The native event is sent to a
queue running on the mainframe and the adapter subscribes to that queue for
inbound event handling. Typically, each application associated with Oracle Connect
for IMS/DB will subscribe to a dedicated queue.

The Oracle Application Server Integration Adapter for IMS/DB provides the
following ways to send an inbound interaction:

= Invoking a special CICS transaction
= Invoking a special IMS/TM transaction
= Using an API from a COBOL program

Integrating Oracle Application Server ProcessConnect with the Adapter
for IMS/DB

Oracle Application Server Integration Adapter for IMS/DB is fully integrated with
Oracle Application Server ProcessConnect, both during the modeling and runtime
phases.

The Modeling Phase

The Oracle Application Server Integration Adapter for IMS/DB is integrated with
Oracle Application Server ProcessConnect as follows:

= Modeling the Oracle Application Server Integration Adapter for IMS/DB is
performed using Oracle Studio. This step includes modeling both the metadata
for the IMS/DB data source and modeling inbound and outbound interactions
as required.

See Also: "Modeling the IMS/DB Adapter Using Oracle Studio”
on page 1-7

= After the Oracle Application Server Integration Adapter for IMS/DB has been
modeled in Oracle Studio, the integration between the adapter and the
application in Oracle Application Server ProcessConnect is modeled. Within
Oracle Application Server ProcessConnect you define a delivery channel for the
adapter and then add interactions from the list modeled using Oracle Studio.
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See Also: Oracle Application Server ProcessConnect User’s Guide

Runtime

At runtime, the interactions specified in the Oracle Application Server
ProcessConnect application are executed.

For outbound interactions, the interactions for the Oracle Application Server
Integration Adapter for IMS/DB are handled by Oracle Connect for IMS/DB on the
0S/390 machine. The IMS/DB data source is queried and the results of this query
are returned to Oracle Application Server ProcessConnect.

For inbound interactions, the interactions are initiated on the OS/390 machine and
sent to Oracle Application Server ProcessConnect.

Modeling the IMS/DB Adapter Using Oracle Studio

Oracle Studio is used to model and manage the Oracle Application Server
Integration Adapter for IMS/DB.

Oracle Studio uses perspectives enabling you to focus specific information
necessary to model the Oracle Application Server Integration Adapter for IMS/DB.

The following perspectives are available:
= The Configuration Perspective

»  The Metadata Perspective

»  The Metadata Import Perspective

s The Runtime Manager Perspective

The Configuration Perspective

Use the Configuration perspective to define access to the IBM OS/390 machine and
to IMS/DB data on the machine.

The Metadata Perspective
Use the Metadata perspective to model the following;:

= The Oracle Application Server Integration Adapter for IMS/DB interactions
and the expected inputs and output

s The IMS/DB data source records and the fields in these records
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The Metadata Import Perspective

Assuming that metadata for the IMS/DB data source is available, use the Metadata
Import perspective to import this information for use by Oracle Connect for
IMS/DB to create outbound interactions.

The Runtime Manager Perspective

Use the Runtime Manager perspective to troubleshoot Oracle Connect for IMS/DB
by monitoring daemon activity on the OS/390 machine.
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Installing the Oracle Application Server
Integration Adapter for IMS/DB

This chapter explains how to install Oracle Connect for IMS/DB and Oracle Studio
software from the distribution CD-ROM.

Note: In addition to the installation procedures described in this
chapter, the IMS/DB adapter component of the Oracle Application
Server Integration Adapter for IMS/DB software must be installed
with Oracle Application Server ProcessConnect. Installing the
IMS/DB adapter component is described in the Oracle Application
Server ProcessConnect Installation Guide.

This chapter includes the following sections:

= Before You Begin

= Installing Oracle Connect for IMS/DB on an OS/390 Platform
»  Updating Oracle Connect with IMS/DB

» Installing Oracle Studio

s Configuring Oracle Connect for IMS/DB

= Securing Access to Oracle Connect for IMS/DB
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Before You Begin

Confirm that you have met all hardware and software requirements. Refer to the
following sections:

= Determining the Hardware and Software Requirements for the OS/390

= Determining the Hardware and Software Requirements for Windows

Determining the Hardware and Software Requirements for the 0S/390

This section describes the following requirements for installing Oracle Connect for
IMS/DB:

= Hardware Requirements

= Software Requirements

Hardware Requirements

The following table summarizes the hardware requirements for Oracle Connect for
IMS/DB.

Hardware Component  Requirements

Processor IBM S/390 machine

Memory The minimum requirement is 1MB per user. The actual memory
requirement depends on the size of the database and the number
of databases accessed.

CD-ROM Drive An internal or external CD-ROM drive

Disk Space (3380 and 150 cylinders
3390 disks)

Software Requirements

The system software configuration described in this section is supported by Oracle
Corporation as long as the underlying system software products are supported by
their respective vendors. Verify the latest support status with your system software
vendors.

The following table summarizes the software requirements for Oracle Connect for
IMS/DB.
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Software Component Requirements

Operating System IBM OS/390 V2R5 and up or z/OS series
IMS/DB database V6R1 and up
Oracle Application Oracle Application Server 10g (9.0.4)

Server ProcessConnect

Oracle Application Server ProcessConnect can reside on any
supported platform

Note: The CICS TP Monitor, V4R1 and up, is required when using
Oracle Connect for IMS/DB under CICS. In this case, CICS EXCI
support must be installed and IRCSTRT=YES must be specified in
the CICS initialization parameters, so that the IRC (Inter Region
Communication) starts.

You can also set the IRC to open by issuing the following
command: CEMT SET IRC OPEN. Also the IBM group DFH$EXCI
(or an equivalent user-defined group) must be installed in the CICS
region - using the CEDA RDO facility.

Note: The IMS/TM TP Monitor, V6R1 and up, is required when
using Oracle Connect for IMS/DB under IMS/TM.

Determining the Hardware and Software Requirements for Windows

This sec

tion describes the following requirements for installing Oracle Studio:

» Hardware Requirements

= Software Requirements

Hardwa

re Requirements

The following table summarizes the hardware requirements for Oracle Studio.

Hardware Components Requirements

Processo

Memory

r An Intel or 100% compatible personal computer (PC), based on a
Pentium processor

128 MB of RAM
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Hardware Components Requirements

CD-ROM Drive An internal or external CD-ROM drive
Disk Space 75MB of free disk space

Software Requirements

The system software configuration described in this section is supported by Oracle
Corporation as long as the underlying system software products are supported by
their respective vendors. Verify the latest support status with your system software
vendors.

The following table summarizes the software requirements for Oracle Studio.

Software Components Requirements

Operating System Microsoft Windows NT Server Version 4.0 with service pack 5 or
higher, Microsoft Windows 2000 with service pack 2 or higher, or
Microsoft Windows XP

Microsoft Network transport protocol software, TCP/IP, included with

Microsoft Windows

Installing Oracle Connect for IMS/DB on an 0S/390 Platform

Note: If you have an Oracle Connect legacy adapter already
installed on the OS/390 machine, follow the instructions described
in "Updating Oracle Connect with IMS/DB" on page 2-18.

The other legacy adapters that run on an OS/390 machine are:

= Oracle Application Server Integration Adapter for CICS

= Oracle Application Server Integration Adapter for IMS/TM
= Oracle Application Server Integration Adapter for VSAM

This section explains how to install Oracle Connect for IMS/DB software from the
distribution CD-ROM. This section includes the following:

s Installation Worksheet

s Preinstallation Instructions
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» Installing the Kit on the Mainframe
» Installation Instructions

m Postinstallation Instructions

Installation Worksheet

Verify that you have all the information detailed in the following installation
worksheets, so you can refer to it during the configuration process.

Table 2-1 Preinstallation Information

Topic Required Information Default Comment

General Operating system - 0S/390 V2R5 and up (including z/OS)

- Disk space - 150 cylinders

- Memory - Minimum 1MB per user

- Installation high-level OCL904 -

qualifier

- Volume - -

- Unit 3390 SMS only: unit where SMS resides

- Output class A -

- JCL job card - An optional card (up to 6 lines) to replace
the prefix job (entered as it will appear in
the job)

- ISPF load library name ISP.SISPLOAD -

CICS CICS EXCI load library name CICS.CICS.SDFHEXCL To access IMS/DB data under CICS

Table 2-2 Required Permissions

Permission

Permission to define an APF-authorized library

Permission to write to an active proclib (such as user.proclib)

Permission to read the CICS EXCI library (when accessing IMS/DB data under CICS)
Permission to update the security manager (such as RACF)

Optionally, permission to specify an output class for Oracle Connect for IMS/DB output
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Table 2-3 Installation Checklist

Step

Comment/Outputs

tso profile prefix
Allocate dataset: {HLQ}.TRANSMIT.KIT
Allocate dataset: {HLQ}.TRANSMIT.LOAD

FTP files to OS/390 (or z/OS)

RECEIVE INDSNAME('{HLQ}.TRANSMIT.KIT")
da('{HLQ}.TRANSMIT.LIB') UNIT(unit) VOLUME(volume)
EX {HLQ}.TRANSMIT.LIB(PREPARE)

EX {HLQ}.BUILDKIT.SRC(NAVINST)

Ensures that the user name is not used as part of
the dataset name allocated in the next steps

130 tracks (3390), format=FB, record length=80,
block size=3120

420 tracks (3390), format=FB, record length=80,
block size=3120

FTP using binary mode

Successful MAXCCis 0,4 or 8
BUILDKIT.SRC and BUILDKIT.LOAD created

Successful MAXCC is 0 or 4

Preinstallation Instructions

Before starting the installation, make sure that you have the following information

available:

= The output class for the installation output if you do not want to use the default

value, which is A

= If you use SMS to manage all datasets (you cannot provide unit and volume
information), the unit where SMS resides

Before starting the installation, make sure that you have the following permissions:

= Permission to define an APF-authorized library

= Permission to write to an active proclib (such as user.proclib)

= Permission to read the CICS EXCI library (when accessing IMS/DB data under

CICS)

= Permission to update the security manager (such as RACF)
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Note: Optionally, make sure that you have permission to specify
an output class for Oracle Connect for IMS/DB output. Assigning a
device which is set on HOLD prevents the loss of log information
when the Oracle Connect for IMS/DB started tasks finish.

Oracle Connect for IMS/DB software for the IBM OS/390 machine is contained in
the following datasets:

s OCL904.TRANSMIT.KIT
s OCL904.TRANSMIT.LOAD

These datasets are provided on a CD-ROM in the directory oracle_Connect\IMSDB_
Legacy_Adapter.

Installing the Kit on the Mainframe
1. On the mainframe, run the following command:

tso profile noprefix

2. The user name will not be used as part of the dataset name. On some systems
this is the default.

3. On the mainframe, allocate datasets with the following space for each of these
files:

m  OCL904.TRANSMIT.KIT = 130 tracks (3380 and 3390 disks)
s OCL904.TRANSMIT.LOAD = 420 tracks (3380 and 3390 disks)
For each dataset: RECFM=FB and LRECL=80. The block size is 3120.

4. Using FTP, copy OCL904 . TRANSMIT.KIT and OCL904 . TRANSMIT.LOAD in
binary mode from the installation CD to the mainframe. You can replace the
OCL904 high-level qualifier to any qualifier you want.

Installation Instructions
Complete the following steps to install Oracle Connect for IMS/DB:

1. From within TSO, run the following command at the TSO prompt:

RECEIVE INDSNAME ('nnn.TRANSMIT.KIT')
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where nnn represents the high-level qualifier you want to assign for the Oracle
Connect for IMS/DB installation. Assign the high-level qualifier you specified
in step 7 of the preinstallation. The default value is OCL904.

Note: You can use more than one high-level qualifier (such as
ACME.DEV.O0CL904) with the following conditions:

= The total length must be less than or equal to twenty characters

s The words "transmit" and "buildkit" cannot be used as
high-level qualifiers

2. Enter the following when prompted for the restore parameters:
da ('nnn.TRANSMIT.LIB') [UNIT(unit) VOLUME (volume)]
This extracts the nnn. TRANSMIT.LIB library from the nnn. TRANSMIT.KIT

kit to the specified unit and volume. If a unit and volume are not specified the
library is extracted to the current unit and volume.

3. Execute the PREPARE member of the nn. TRANSMIT.LIB library:

ex PREPARE

Follow the instructions in the Response column in Table 2—4 for each entry in
the Screen column.

Table 2-4 Installation Prepare Job Prompts and Responses

Screen Response

DO YOU WANT TO USE SMS MANAGED If you want to manage the storage using SMS, answer Y,
STORAGE FOR THIS INSTALLATION Y/N [N] : otherwise answer N.

ENTER THE STORCLASS FOR INSTALLATION  This prompt is displayed only if SMS is used to manage the
TEMP DATASETS [ ] : installation (you answered Y to the first prompt).

Enter the storage class

ENTER THE UNIT NAME FOR INSTALLATION If a storage class is not specified, enter the unit name for

TEMP DATASETS [3390] : temporary datasets used during the installation procedure
ENTER THE VOLUME NAME FOR This prompt is displayed only if SMS is not used to manage
INSTALLATION TEMP DATASETS : the installation (you answered N to the first prompt).

The volume name for temporary datasets used during the
installation procedure
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Table 2-4 (Cont.) Installation Prepare Job Prompts and Responses

Screen Response

ENTER THE OUTPUT CLASS FOR Enter the output class only if you do not want the default
INSTALLATION OUTPUT [A] : class used (the default is A)

DO YOU WANT TO USE THE DEFAULT JOB A job card is displayed. If you want to use a replacement
CARD Y/N [Y] card, it must be entered as it will appear in the job. You can

enter up to six lines. Enter a blank line to end input.

If you do not enter a card, the Oracle Connect for IMS/DB
default card is used.

DO YOU WANT TO PERFORM A MANUAL If you want to review the JCL used to install Oracle Connect
(M) OR AUTOMATIC (A) INSTALLATION [A] :  for IMS/DB, before it is submitted, respond M for a manual

installation.
PLEASE REVIEW AND SUBMIT FOR This prompt is displayed only if a manual installation is
EXECUTION THE requested (you answered M to the previous prompt).

HLQ.TRANSMIT.LIB(INSTJO)

The following libraries are generated:

nnn.BUILDKIT.LOAD
nnn.BUILDKIT.SRC
nnn.BUILDKIT.GENDEMO

Where nnn is the high-level qualifiers you assigned in step 1.
4. Inthe nnn.BUILDKIT. SRC library, execute the NAVINST member:

ex NAVINST

Follow the instructions in the Response column in Table 2-5 for each entry in
the Screen column.
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Table 2-5 Installation Prompts and Responses

Screen

Response

DO YOU WANT TO USE SMS MANAGED
STORAGE FOR THIS INSTALLATION Y/N [N] :

THE SOFTWARE WILL BE INSTALLED UNDER
THE HIGH LEVEL QUALIFIER THAT YOU
WILL CHOOSE.

ENTER THE HIGH LEVEL QUALIFIER
['QUALIFIER] :

ENTER THE STORCLASS FOR TEMP DATASETS
[STORCLASS'] :

ENTER THE UNIT NAME FOR INSTALLATION
TEMP DATASETS [3390] :

ENTER THE VOLUME NAME FOR
INSTALLATION TEMP DATASETS :

PLEASE CONFIRM (YES/NO/QUIT) [YES] :

ENTER THE OUTPUT CLASS FOR
INSTALLATION OUTPUT [A] :

If you want to manage the storage using SMS, answer Y,
otherwise answer N.

The high-level qualifier for the installation (referred to as
INSTROOT throughout this guide)

You can use more than one high-level qualifier (such as
ACME.DEV.VAL10). The total length must be less than or
equal to twenty characters. The qualifiers can be the same
as the ones used for the installation (step 1).

The words "transmit" and "buildkit" cannot be used as
high-level qualifiers.

This prompt is displayed only if SMS is used to manage the
installation (you answered Y to the first prompt).

Enter the storage class

The unit name for temporary datasets used during the
installation procedure.

This prompt is displayed only if SMS is not used to manage
the installation (you answered N to the first prompt).

The volume name for temporary datasets used during the
installation procedure

Confirm the entered details

Enter the output class for Oracle Connect for IMS/DB
output. Assigning a device which is set on HOLD prevents
the loss of log information when the Oracle Connect for
IMS/DB started tasks finish (the default is A).
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Table 2-5 (Cont.) Installation Prompts and Responses

Screen Response
DO YOU WANT TO USE THE DEFAULT JOB A job card is displayed. If you want to use a replacement
CARD Y/N [Y] card, it must be entered as it will appear in the job. You can

enter up to six lines. Enter a blank line to end input.

If you do not enter a card, the Oracle Connect for IMS/DB
default card is used.

ADDING AND UPDATING ORACLE In order to manage Oracle Connect on this machine from
CONNECT FOR IMS/DB CONFIGURATION ON  Oracle Studio, you need to enter a user account of a user
THIS MACHINE, FROM A REMOTE ORACLE who will have administrative authorization, or press Enter
ADMINISTRATION CONSOLE, CAN ONLY BE  to enable any user to administer Oracle Connect on this
DONE BY SOMEONE DEFINED AS AN machine. The administrative rights can be changed from
ADMINISTRATOR FOR ORACLE CONNECT within Oracle Studio after the installation.

ON THIS MACHINE.

ENTER A VALID USER NAME FOR AN
ORACLE CONNECT ADMINISTRATOR [ALL]:

PLEASE REVIEW AND SUBMIT FOR This prompt is displayed only if a manual installation is
EXECUTION THE DSN1 (INSTJBOR) requested (you answered M to the previous prompt).

DSNI1 is the dataset name where INSTJBOR is located.

5. Inthe nnn.BUILDKIT.SRC library, execute the IMSDB member:

ex IMSDB

Follow the instructions in the Response column in Table 26 for each entry in
the Screen column.

Table 2-6 IMS/DB Adapter-Specific Installation Prompts and Responses

Screen Response

ENTER DBD LIBRARY NAME [IMS.DBDLIB]:  The library where database definition (DBD) files are located

ENTER PSB LIBRARY NAME [IMS.PSBLIB] : The library where Program Specification Blocks (PSBs) are
located

ENTER YOUR PSB NAME [HOSPPSB] : The name of the PSB file to use

PLEASE CONFIRM (YES/NO/QUIT) [YES] : Confirm the entered details

DO YOU WANT ORACLE CONNECT FOR If you want to access IMS/DB data under CICS, using the

LEGACY ADAPTER TO WORK WITH IMS/DB  Oracle Application Server Integration Adapter for

UNDER CICS (YES/NO) [NOJ: IMS/DB, respond YES.
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Table 2-6 (Cont.) IMS/DB Adapter-Specific Installation Prompts and Responses

Screen Response

ENTER THE CICS EXCI LOAD LIBRARY NAME If you responded YES to working under CICS, enter the

[CICSTS13.CICS.SDFHEXCI] : CICS EXCI load library name only if you do not want the
default.

PLEASE CONFIRM (YES/NO/QUIT) [YES] : If you responded YES to working under CICS, confirm the
entered details

ENTER THE ISPF LOAD LIBRARY NAME Enter the high-level qualifier and name of the ISPF load

[ISP.SISPLOAD] : library

PLEASE CONFIRM (YES/NO/QUIT) [YES] : Confirm the entered details

ENTER THE OUTPUT CLASS FOR Enter the output class for Oracle Connect for IMS/DB

INSTALLATION OUTPUT [A] : output. Assigning a device which is set on HOLD prevents

the loss of log information when the Oracle Connect for
IMS/DB started tasks finish (the defaultis A).

DO YOU WANT TO USE THE DEFAULT JOB A job card is displayed. If you want to use a replacement
CARD Y/N [Y] card, it must be entered as it will appear in the job. You can
enter up to six lines. Enter a blank line to end input.

If you do not enter a card, the Oracle Connect for IMS/DB
default card is used.

The installation is completed. All JCL jobs and REXX procedures are written to the
INSTROOT.USERLIB library. INSTROOT is the high-level qualifier for the
installation.

Postinstallation Instructions

The following postinstallation tasks must be done to work with Oracle Connect for
IMS/DB:

= General Postinstallation Procedures

»  Starting the Daemon

= Setting Up Oracle Connect for IMS/DB for Reentrancy

= Setting Up Oracle Connect for IMS/DB to Work Under CICS

= Setting Up Oracle Connect for IMS/DB to Work Under IMS/TM
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General Postinstallation Procedures

Perform the following procedures after completing the installation, to configure
Oracle Connect for IMS/DB.

Allocate a dataset for INSTROOT . DEF . BRANDBIN, using 1 track and with
RECFM=VB and LRECL=256. The block size is 6233.

INSTROQT is the high-level qualifier where Oracle Connect for IMS/DB is
installed.

Using FTP, copy the BRANDBIN file, in binary mode, from the
Oracle Connect\IMSDB Legacy Adapter directory in the installation CD to the
mainframe, to INSTROOT.DEF . BRANDBIN.

Define the LoADAUT library as an APF-authorized library

Note: To define a DSN as APF-authorized, in the SDSF screen
enter the command:

"/setprog apf,add,dsn=INSTROOT.loadaut,volume=vol002"

where vol002 is the volume where you installed Oracle Connect for
IMS/DB and INSTROOT is the high-level qualifier where Oracle
Connect for IMS/DB is installed.

If the site uses SMS, when defining APF-authorization in the SDSF
screen enter the command:

"/setprog apf,add,dsn=INSTROOT.loadaut, SMS"

Make sure that the library is APF-authorized, even after an IPL
(reboot) of the machine.

Move the NSTROOT.USERLIB (ATTDAEMN) and
NSTROOT.USERLIB (ATTSRVR) members to any active proclib (such as
user.proclib). ATTDAEMN and ATTSRVR are run as started tasks.

If you decide to change the name of the ATTSRVR member when you move it to
a general high-level qualifier, change the name specified in the StartupScript
parameter in the daemon configuration to the new name:

= Run INSTROOT.USERLIB (NAVCMD) and enter EDIT DAEMON IRPCDINI
at the prompt.
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= Change the startupScript parameter from ATTSRVR to the new name for the
server:

<Workspace name="Navigator"
startupScript="NEW_NAME"
serverMode="reusable"
L />
» Exit and save the change.

= Change the following line in the ATTDAEMN script to include the IP address of
the OS/390 machine.

For example, before:

// PARM='-B START IRPCDINI'

After:

// PARM='-B -L ip_address:2252 START IRPCDINI'

where ip_address is ip address of the machine, 2552 is the default port for
starting the daemon and IRPCDINT is the default daemon configuration.

= In the security manager, define ATTDAEMN and ATTSRVR with a started task
class and a general profile that enables access to an Open OS/390 segment (that
defines access to TCP/IP OA sockets)

»  The installation includes a PS, INSTROOT . DEF . GBLPARMS, that contains global
environment information. This PS is read at startup and the correct software
version is used, based on the details provided in the startup task.

If you change the location of this member, you must also change the relevant
cards in the following jobs to the new locations:

= ATTSRVR - located in an active proclib (such as user . proclib)
= ATTDAEMN - located in an active proclib (such as user . proclib)
= NAVSQL - located in TNSTROOT.USERLIB

s The input during the installation procedure is written to
nnn.BUILDKIT.SRC (PARS). You can use this file to provide the same inputs
if you rerun the installation, where nnn is the high-level qualifier you assign for
the installation.
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»  For information about specifying Oracle Connect for IMS/DB as the service
using port 2552 in the TCP/IP network services file, consult TCP /1P
documentation.

Starting the Daemon

Activate INSTROOT.USERLIB (ATTDAEMN) as a started task to invoke the daemon.
For example, in the SDSF screen enter the following:

'/s ATTDAEMN'

INSTROQT is the high-level qualifier where Oracle Connect for IMS/DB is
installed.

To submit the daemon as a job, uncomment the first two lines of the ATTDAEMN JCL,
change the PARM line as described above, and run the job using the sub command.
The ATTDAEMN JCL is similar to the following:

//*ATTDAEMN JOB 'RR', 'TTT',MSGLEVEL=(1,1),CLASS=A,
//* MSGCLASS=A,NOTIFY=&SYSUID, REGION=8M

//STEP1 EXEC PGM=IRPCD,

// PARM='-B START IRPCDINI'

//* PARM='-B -L :8883 START'

//STEPLIB DD DSN=INSTROOT.LOADAUT, DISP=SHR
//SYSPRINT DD SYSOUT=A

//GBLPARMS DD DSN=INSTROOT.DEF .GBLPARMS, DISP=SHR

// EXEC PGM=IRPCD,COND=((1,EQ,STEP1), (2,EQ,STEP1)),
// PARM='-KATTDAEMN START ''INSTROOT.DEF.IRPCDINI'''
//STEPLIB DD DSN=INSTROOT.LOADAUT, DISP=SHR
//SYSPRINT DD SYSOUT=A

//GBLPARMS DD DSN=INSTROOT.DEF .GBLPARMS, DISP=SHR
//SYSDUMP DD DUMMY

Setting Up Oracle Connect for IMS/DB for Reentrancy

To set up Oracle Connect for IMS/DB to be reentrant, move INSTROOT. LOAD to the
Link Pack Area (LPA).

INSTROOTis the high-level qualifier where Oracle Connect for IMS/DB is installed.

Using the LPA reduces real storage usage (because everyone shares the LPA copy)
and fetch time.
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Note: If you intend using impersonation, so that you can run in a
security context that is different than the context of the process
that owns the server, do the following:

= Place the INSTROOT.LOAD (ATYSVCW) member in an
APF-authorized library outside the LPA.

= Change the ATTSRVR member (located in the active proclib),
by adding the following to the STEPLIB list:

// DD DSN=apf_ library,DISP=SHR

Where apf_ Iibrary isthe APF-authorized library outside the
LPA where the ATYSCVW member was moved.

Setting Up Oracle Connect for IMS/DB to Work Under CICS
In order to access IMS/DB data under CICS, do the following.

1. Copy the ATYDBCTL from INSTROOT.LOAD to a CICS DFHRPL library (such as
'CICS.USER.LOAD') and then define the ATYDBCTL program under CICS using
any available group such as ORA group:

CEDA DEF PROG (ATYDBCTL) G(ORA) LANG(C) DA(ANY) DE(ORA IMSDB CICS PROGRAM)
INSTROOT is the high-level qualifier where Oracle Connect for IMS/DB is
installed.

After defining the ATYDBCTL program to a group, install it as follows:

CEDA IN G(ORA)

2. Under CICS, run the CDBC transaction and choose the first option
(Connection). Provide the startup table suffix and DBCTL ID override value.

Setting Up Oracle Connect for IMS/DB to Work Under IMS/TM

In order to execute an IMS transaction, you need to set OTMA (Open Transaction
Manager Access), as follows.

1. Install OTMA with OTMA C/I where IMS resides, since OTMA is not
automatically installed using the IMS INSTALL/IVP Dialog.

2. During IMS system definition, set the startup parameter in the IMS procedure
to OTMA=Yes.
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In addition, set additional OTMA-related parameters such as GRNAME= for
the XCF group name and OTMANM= for the IMS member name in that XCF
group, as in the following example:

EDIT IMS.PROCLIB(DFSPBIV1) - 01.03
command ===>

000082 AOQIS =,

000083 GRNAME=IMSATTO1,

000084 OTMA=YES,

000085 MAXPST=

000086 OTMANM=

Start the OTMA Callable Interface (C/I).

Add an entry in the program properties table (PPT) for the OTMA C/I
initialization program as follows:

1. Edit the SCHEDxx member of the sys1.PARMLIB data set by adding the
following entry:

PPT PGMNAME (DFSYSVIO)/*PROGRAM NAME =DFSYSVIO */
CANCEL /*PROGRAM CAN BE CANCELED */

KEY (7) /*PROTECT KEY ASSIGNED IS 7 */

SWAP /*PROGRAM IS SWAPPABLE */

NOPRIV /*PROGRAM IS NOT PRIVILEGED */

DSI /*REQUIRES DATA SET INTEGRITY */

PASS /*CANNOT BYPASS PASSWORD PROTECTION */

SYST /*PROGRAM IS A SYSTEM TASK */

AFF (NONE) /*NO CPU AFFINITY */

NOPREF /*NO PREFERRED STORAGE FRAMES */

2. Do one of the following to make the SCHEDxx changes take effect:
—  Re-IPL the system
— Issue the SET scH= command

3. Edit and submit the following JCL procedure to run DFSYSVIO:

//OTMAINIT PROC RGN=3000K, SOUT=A,
/PARM1=

//*

//IEFPROC EXEC PGM=DFSYSVIO,

/ /REGION=&RGN

//*

//STEPLIB DD DISP=SHR,UNIT=SYSDA,
//DSN=IMSVS.RESLIB
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//*
//SYSPRINT DD SYSOUT=&SOUT
//SYSUDUMP DD SYSOUT=&SOUT
//*

4. Run DFSYSVIO after the IPL, to initialize the OTMA C/I.

5. Copy INSTROOT.LOAD (ATYDBDC) to an IMS/TM program library (such as
IMS.PGMLIB) with the name of the PSB name that you are using to access the
IMS/DB data.

6. Specify a transaction to point to this program. Oracle Connect for IMS/DB
assumes a default transaction called ATYIMSTM.

Use statements similar to the following statements to define to IMS a transaction
code supported by the sample program:

APPLCTN PSB=PSBNAME, SCHDTYP=PARALLEL
TRANSACT CODE=ATYIMSTM, PRTY=(7,10,2), INQUIRY=NO, MODE=SNGL, EDIT=ULC

Note that either upper or lower case is accepted, since the EDIT parameter is set to
ULC.

Updating Oracle Connect with IMS/DB

Verify that you have all the information detailed in the following installation
worksheets, so you can refer to it during the configuration process.

Table 2-7 Preinstallation Information

Topic Required Information Default Comment
CICS CICS EXCI load library name CICS.CICS.SDFHEXCL To access IMS/DB or VSAM data under
CICS

Table 2-8 Required Permissions

Permission

Permission to read the CICS EXCI library (when accessing IMS/DB or VSAM data under CICS)

In the nnn . BUILDKIT. SRC library, execute the CUSTOCL member:

ex CUSTOCL
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Follow the instructions in the Response column in Table 2-9 for each entry in the
Screen column.

Table 2-9 IMS/DB Adapter Installation Prompts and Responses

Screen Response

DO YOU WANT ORACLE CONNECT FOR Answer YES to this prompt
LEGACY ADAPTER TO WORK WITH IMS/DB
(YES/NO) [YES] :

ENTER DBD LIBRARY NAME [IMS.DBDLIB] :  Enter the library where database definition (DBD) files are

located

ENTER PSB LIBRARY NAME [IMS.PSBLIB] : Enter the library where Program Specification Blocks (PSBs)
are located

ENTER YOUR PSB NAME [HOSPPSB] : Enter the name of the PSB file to use

PLEASE CONFIRM (YES/NO/QUIT) [YES] : Confirm the entered details

DO YOU WANT ORACLE CONNECT FOR If you want to access IMS/DB data under CICS, using the

LEGACY ADAPTER TO WORK WITH IMS/DB  Oracle Application Server Integration Adapter for IMS/DB,

UNDER CICS (YES/NO) [NO]J : respond YES.

ENTER THE CICS EXCI LOAD LIBRARY NAME If you responded YES to working with IMS/DB under CICS,

[CICSTS13.CICS.SDFHEXCI] : enter the CICS EXCI load library name only if you do not
want the default.

PLEASE CONFIRM (YES/NO/QUIT) [YES] : If you responded YES to working with IMS/DB under CICS,
confirm the entered details.

DO YOU WANT ORACLE CONNECT FOR Answer YES to this prompt if you have Oracle Connect for

LEGACY ADAPTER TO WORK WITH CICS CICS already installed.
APP ADAPTER (YES/NO) [YES] :

ENTER THE CICS EXCI LOAD LIBRARY NAME If you responded YES to working with the CICS adapter,

[CICSTS13.CICS.SDFHEXCI] : enter the CICS EXCI load library name only if you do not
want the default.

PLEASE CONFIRM (YES/NO/QUIT) [YES] : If you responded YES to working with the CICS adapter,
confirm the entered details.

THE VSAM DRIVER IS INSTALLED Answer YES to this prompt if you have Oracle Connect for

AUTOMATICALLY. DO YOU ALSO WANT VSAM already installed and you want to access VSAM data

ORACLE CONNECT FOR LEGACY ADAPTER  under CICS.
TO WORK WITH VSAM UNDER CICS
(YES/NO)  [NOJ:

ENTER THE CICS EXCI LOAD LIBRARY NAME If you responded YES to working with VSAM under CICS,
[CICSTS13.CICS.SDFHEXCI] : enter the CICS EXCI load library name only if you do not
want the default.
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Table 2-9 (Cont.) IMS/DB Adapter Installation Prompts and Responses

Screen

Response

PLEASE CONFIRM (YES/NO/QUIT) [YES] :

ENTER THE ISPF LOAD LIBRARY NAME
[ISP.SISPLOAD] :

PLEASE CONFIRM (YES/NO/QUIT) [YES] :

ENTER THE OUTPUT CLASS FOR
INSTALLATION OUTPUT [A] :

DO YOU WANT TO USE THE DEFAULT JOB
CARD Y/N [Y]

If you responded YES to working with VSAM under CICS,
confirm the entered details.

Enter the ISPF load library name only if you do not want the
default.

Confirm the entered details

Enter the output class for Oracle Connect output. Assigning
a device which is set on HOLD prevents the loss of log
information when the Oracle Connect started tasks finish
(the defaultis A).

A job card is displayed. If you want to use a replacement
card, it must be entered as it will appear in the job. You can
enter up to six lines. Enter a blank line to end input.

If you do not enter a card, the Oracle Connect default card is
used.

The installation is completed. All JCL jobs and REXX procedures are written to the
INSTROOT.USERLIB library. INSTROOT is the high-level qualifier for the

installation.

After completing the installation, perform postinstallation tasks, as described in
"Postinstallation Instructions” on page 2-12, as required.

Installing Oracle Studio

Note: If you have Oracle Studio already installed because you are
also using another legacy adapter, you do not need to reinstall it.

The other legacy adapters are:

= Oracle Application Server Integration Adapter for CICS

= Oracle Application Server Integration Adapter for IMS/TM

= Oracle Application Server Integration Adapter for Tuxedo

»  Oracle Application Server Integration Adapter for VSAM
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This section explains how to install Oracle Studio software from the distribution
CD-ROM.

Installing Oracle Studio from the CD-ROM

Assuming that the CD-ROM drive is D:, the installation file is located in the
D:\Oracle_Studio directory. Install the software from the CD-ROM by running
the self-extracting executable installation file, 0SL904-win32 . exe, either using the
Run option in the Windows Start menu or through Windows Explorer.

Caution: If you are installing Oracle Studio on a Windows XP
machine, you cannot specify a logical drive as the Destination
folder for the installation.

Configuring Oracle Connect for IMS/DB

All modeling of the Oracle Connect for IMS/DB is performed using Oracle Studio.
To use Oracle Studio you first configure it to enable access to the IBM OS/390
machine.

Note: The following tasks assume you have permission to access
the IBM OS/390 machine where the IMS/DB data resides and that
the Oracle Connect for IMS/DB daemon is running on this
machine.

Check with the system administrator to ensure these requirements
are fulfilled.

Task: Setting Up the IBM 0S/390 Machine

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio. Oracle Studio opens, displaying
the Configuration perspective.
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IF-lgBal| ¢

ﬁ Configuration Explorer x

it
i -] Machines Welcome to Oracle Studio for Legacy Adapters

|»

Oracle Studio for Legacy Adapters is an integrated GUI-based environment
For managing Oracle Conmect For Legacy Adapters at a site.

Fram the Oracle Skudio for Legacy Adapters console you can set up and manage Oracle
Connect legacy adapters on any machine where Oracle Connect For Legacy Adapters is
installed.

@ Configuring Oracle Connect for Legacy Adapters
IManaging an Orache Connect for Legacy Adapkers machine is accomplished within
Cracle Studio For Legacy Adapters using perspectives, A perspective is a collection
of panes that present a specific view of Oracle Connect for Legacy Adapters resources
and the ability to edit these resources, & logical Flow between perspectives is
provided, For example: Adding an adapter {using the Configuration perspective) leads
directly to importing metadata {using the Import Metadata perspective).

@ Oracle Studio for Legacy Adapters
COracle Studio For Legacy Adapters opens with the Configuration perspective
displawed. Right-click the Machines node to add an Oracle Connect for Legacy Adapters
machine,

Once a machine has been defined to Oracle Studio for Legacy Adapters, you can
5] Properties = L % configure the Following, using the Configuration perspective:
=+

Propert | ‘alue Bindings - The NaY binding configuration includes information about the
adapters that can be accessed using Oracle Application Server 10g ProcessConneck,

Daemons - & daemon is responsible For cient/server communications, allocating
a server process for a client request,

Users - & user profile controls access to machines and applications
using user name and password pairs, instead of the user having to provide this
information when accessing the resource. ol

2. Right-click Machines in the Configuration Explorer and choose Add Machine
from the popup menu.

The Add Machine window appears.
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Add machine

Define new machine

—Machine

Physical address:

¥ Default port: |

[~ Marne: |

r—Connection

User name: |

Password: |

Confirm password: I

r Anonyrmaous conneckion

[~ Connect via MAT/FixedNAT

Einish I

Cancel I

In the Add Machine window, uncheck the Default port check box and enter

2552 as the port number.

Enter the name of the machine you want to connect to, or click Browse to
choose the machine from the list of machines that is displayed.

Specify the username and password of the user who was specified as the
administrator when Oracle Connect for IMS/DB was installed.

Note:

Checking the Anonymous connection checkbox enables

anyone having access to the machine to be an administrator, if this

was defined for the machine.

Click Finish. The machine is displayed in the Configuration Explorer.
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%‘Eonﬁguration - Oracle Studio for Legacy Adapters
File Edit Mavigate Search ‘Window Help

x welcome X l
Welcome to Oracle Studio for Legacy Adapters

|»

Oracle Studio for Legacy Adapters is an integrated GUI-based environment
For managing Oracle Conmect For Legacy Adapters at a site.

- Users

Fram the Oracle Skudio for Legacy Adapters console you can set up and manage Oracle
Connect legacy adapters on any machine where Oracle Connect For Legacy Adapters is
installed.

@ Configuring Oracle Connect for Legacy Adapters
IManaging an Orache Connect for Legacy Adapkers machine is accomplished within
Cracle Studio For Legacy Adapters using perspectives, A perspective is a collection
of panes that present a specific view of Oracle Connect for Legacy Adapters resources
and the ability to edit these resources, & logical Flow between perspectives is
provided, For example: Adding an adapter {using the Configuration perspective) leads
directly to importing metadata {using the Import Metadata perspective).

@ Oracle Studio for Legacy Adapters
COracle Studio For Legacy Adapters opens with the Configuration perspective
displawed. Right-click the Machines node to add an Oracle Connect for Legacy Adapters
machine,

Once a machine has been defined to Oracle Studio for Legacy Adapters, you can
5] Properties = o x configure the Following, using the Configuration perspective:
bl

Propert: | alue Bindings - The NaY binding configuration includes information about the
05390, acme. com: 255 adapters that can be accessed using Oracle Application Server 10g ProcessConneck,

Location

Marme 03320 Daemons - A daemon is responsible for cientfserver communications, allocating
Path Q5390 a server process For a client request,

Users - & user profile controls access to machines and applications
using user name and password pairs, instead of the user having to provide this
information when accessing the resource. S

Securing Access to Oracle Connect for IMS/DB

Oracle Studio includes mechanisms to secure access to Oracle Connect for IMS/DB
both during modeling and at runtime.

During modeling the following security mechanisms can be applied:
= Setting Password Access to Oracle Studio
=  Specifying Users with Administrative Rights to a Machine

At runtime client access to Oracle Connect for IMS/DB is provided by the user
profile:

= Setting Up Runtime User Access to the IBM OS/390 Machine
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Setting Password Access to Oracle Studio

Initially, any operation performed using Oracle Studio does not require a password.
You can set a password so that the first operation that involves accessing the server
from Oracle Studio requires a password to be entered.

Task: Setting Up a Master Password to Access Oracle Studio

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio. Oracle Studio opens.

2. Choose Window > Preferences from the menu bar. to open the Preferences
window.

3. Select the Studio node.

x|
Studio

Security |

[~ use encrypted communication

¥ | Save password

Change master password |
Restore Defaults | Apply |

ImMport, .. Export... oK I Cancel |

Note: The Save password checkbox is for future use.
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4. Click Change master password to open the Change master password window.

&, Change master pass : x|

Enter current master password:

Enter mew master password:

Confirm new master password:

oK I Cancel I

5. Leave the Enter current master password field empty and type a new master
password.

6. Confirm the password.

7. Click OK.

Specifying Users with Administrative Rights to a Machine

By default, only the user who was specified during the installation as an
administrator has the authorization to modify settings on that machine from Oracle
Studio. This user can then authorize other users to make changes or to view the
definitions for a selected machine. Adding a machine to Oracle Studio is described
in "Task: Setting Up the IBM OS/390 Machine" on page 2-21.

Note: The default during installation is to enable all users to be
administrators.

Task: Setting Administrative Rights to a Machine

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio. Oracle Studio opens, displaying
the Configuration perspective.

2. Right-click the machine in the Configuration Explorer and choose
Administration Authorization from the popup menu.

The Administration Authorization window opens.
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— Administrators

v Everyone
&dd|User |
Add Group |
Fename |
Remove |
—Desigrners
- Everyone
Add User |
Add Group |
Rename |
Remove |
—Users
r Everyone
Add User |
Add Group |
Renane |
Remove |
Identities |

The window has three sections:

Administrators - Administrators can view and modify all the definitions in
Oracle Studio for the selected machine. On initial entry to Oracle Studio, every
user is defined as a system administrator.

Designers - Designers can view all the definitions for the machine in Oracle
Studio and can modify any of the definitions under the Bindings and Users
nodes for the selected machine. For example, Oracle Studio database
administrator can add new data sources and adapters and can change metadata
definitions for a table in a data source.

Users - Users can view all the definitions for the machine in Oracle Studio for
the selected machine. Regular users cannot modify any of the definitions.

Add users or groups of users by clicking Add User or Add Group for the
relevant sections.

The user or group that is added must be recognized as a valid user or group for
the machine.

Once a name has been added to a section, only the user or group who logs on
with that user name has the relevant authorization.
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Setting Up Runtime User Access to the IBM 0S/390 Machine

At runtime, client access to Oracle Connect for IMS/DB is provided by the user
profile. A user profile contains name and password pairs that are used to access a
machine, data source or application at runtime, when anonymous access is not
allowed.

1. In the Configuration Explorer, click the + next to the machine node of the
machine for which you want to set the user name and password.

2. Click the + next to the Users node.
3. Right-click the NAV user profile and choose Edit User.

Caution: You must not delete the NAV user profile since it also
contains Oracle Connect for IMS/DB system settings.
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;ﬁ‘tonﬁguration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

|IF-lgBal| ¢

x| 1] welcome [f‘- maw X l

L]

= _
,E E||j Machines Resource
=@ os390

User

Add

Remove |
Edit |

[ Properties = x

Propert: | ‘alue
Marne MY
Path VOS5I usersiNA, ..
Filker
’]7 Datasource W Adapter W Remote machine W Encryprion key
| [ » nuthenticatorsISwrce

In the User editor, click Add to open the Add authenticator window.

4,
5. Select the Remote Machine resource type.
{5 add Authenticator x|
—Resource information
Resource bype: Remote machineg j

Diata source

Resource name:

‘Remote machine

Encryption ke

—Authentication infar

User name:

Password: I

Confirm password:

a4 I Cancel
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6. Enter the name of the IBM OS/390 machine defined in the previous task.

7. Enter the name and password used to access the machine and confirm the
password.

8. Click OK.
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3

Modeling Interactions for Oracle
Application Server Integration Adapter for
IMS/DB

Modeling interactions for Oracle Application Server Integration Adapter for
IMS/DB involves defining the data source and an Oracle Connect for IMS/DB
backend adapter using Oracle Studio. All the definitions specified in Oracle Studio
are written to the OS/390.

This chapter contains the following sections:

= Setting Up the IMS/DB Data Source

» Importing Metadata for the IMS/DB Data Source

= Setting Up the Oracle Connect for IMS/DB Backend Adapter
= Generating Outbound Interactions

= Generating Inbound Interactions
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Setting Up the IMS/DB Data Source

Oracle Connect for IMS/DB requires you to specify the IMS/DB data source as the
first step in setting up the adapter.

Task: Adding the IMS/DB Data Source Definition

1.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for IMS/DB" on page 2-21.

Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

Click the + next to the NAV binding node. The NAV binding configuration
includes branches for data sources and adapters that are located on the
machine.

Caution: You must not delete the NAV binding configuration
since it also contains Oracle Connect for IMS/DB system settings.

Right-click Data sources in the Configuration Explorer and choose New data
source from the popup menu, to open the New data source wizard.

In the New window, enter a name for the IMS/DB data source. The name can
contain letters and numbers and the underscore character only.

Change the Type field as follows:

= If you are accessing IMS/DB data directly, select IMS-DLI

= If you are accessing IMS/DB data under CICS, select IMS-DBCTL

= If you are accessing IMS/DB data under IMS/TM, select IMS-DBDC
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New data source
Creates New data source

Name: | IM3_DATA

Type: |IMS-DECTL |

= Back | Mext = | Finish I Cancel I

8. For IMS-DLI, click Finish. Otherwise, click Next.

9. Enter the Data source connect string. The connect string information is
dependent on whether the data source type is IMS-DBCTL or IMS-DBDC.

If you chose IMS-DBCTL, the following window opens:

Data source connect string ﬁ

PSE Mame: I

Target Syskem: I CICS

WTAM Methame: | ATYCLIEN

< Back i Mext = Finish Cancel
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where:

PSB Name - The name of the PSB file that contains details of all the
IMS/DB databases that you want to access.

Target System - The VTAM applid of the CICS target system. You can
determine this value by activating the CEMT transaction on the target CICS
system. On the bottom right corner of the screen appears the legend
APPLID=target_system. The default value is CICS.

VTAM NetName - The VTAM netname of the specific connection being used
by EXCI (and MRO) to relay the program call to the CICS target system. For
example, if you issue to CEMT the following command:

CEMT INQ CONN

you see on the display screen that the netname is BATCHCLI (this is the
default connection supplied by IBM upon the installation of CICS). The
default value is ATYCLIEN.

If you chose IMS-DBDC, the following window opens:

Data source connect string ﬁ

ACF group: I

KCF server: I

TRipe prefix: I ATTU

User name: I

Group name: I

........ <§ack ......... . | IEmTI pem—

where:

XCF group - The Cross System Coupling Facility collection of XCF
members the connection belongs to. A group may consist of up to eight
characters, and may span between multiple systems.
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XCEF server - The Cross System Coupling Facility group member.

TPipe prefix - The transaction pipe prefix used to associate between the
transaction and the transaction pipe it is using. The default is ATTU.

User name - The security facility user identification (for example, the RACF
user identification).

Group name - The security facility group identification (for example, the
RACEF group identification).

10. Click Finish.

The data source you just defined now appears in the Configuration Explorer list.

Importing Metadata for the IMS/DB Data Source

Oracle Connect for IMS/DB requires metadata describing the IMS/DB data source
records and the fields in these records.

Use the Import Metadata perspective in Oracle Studio to import metadata for the
IMS/DB data source from COBOL copybooks, which describe the data. To import
the metadata involves the following tasks:

»  Task 1: Defining an Import Procedure

»  Task 2: Generating Metadata for the IMS/DB Data

Task 1: Defining an Import Procedure

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for IMS/DB" on page 2-21.

3. Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

4. Click the + next to the NAV binding node.
5. Click the + next to the Data sources node.

6. Right-click the IMS/DB data source defined in "Setting Up the IMS/DB Data
Source" on page 3-2.
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Choose Import from the popup menu, to open the Metadata Import

perspective, with the IMS/DB data source displayed under the data sources list
in the Metadata Import Explorer.

underscore character only.

Right-click the IMS/DB data source and choose New Import from the popup
menu, to open the New Metadata Import wizard.

Enter a name for the import. The name can contain letters and numbers and the

Note:

The New import window is the same for all the IMS/DB

imports (IMS/DB under IMS/TM (IMS_DBDC), under CICS
(IMS-DBCTL) and direct (IMS-DLI)), with the exception of the

Import Type value.

10. Click Finish. The metadata import wizard opens in Oracle Studio.

;;;:Ti:l:onfiguration - Oracle Studio for Legacy Adapters

File Edit MNavigake Search Window Help

|I¥-B8a]| ¢
= A Metadata Import Explorer X x
il O] Adapters
=] Data saurces 5
i | B[ ms_pata Get Input Files Step 1 of9
=R -4 IMS_DATA_IMPORT
—|| “I27] Events Select IMS database definition (DBD) files:
add... |
Removel
Select COBOL copybook files:
Add... |
Removel
Select IMS Program Specification Block (PSE) file (optional):
P3B File: Erowse, .. |
=] Properties iic— 2 B
Propett: | Walue
Mame IM3_DATA_IMPORT
Path \5390\bindingsiMA. ..
| << Back| |Next S | |Finish |
Main | Source
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Task 2: Generating Metadata for the IMS/DB Data

After defining an import as described in the preceding task, the metadata import
wizard opens in Oracle Studio. DBD files and COBOL copybooks are used to create
the metadata. Optionally, a PSB file can also be specified.

Note: The import procedure described here is the same from a
users perspective for all three of the IMS/DB data source types
(IMS-DBDC, IMS-DBCTL and IMS-DLI).

1. Click Add to add DBD files.

A Select window opens. This window lists any files selected.

=10l x|

2. Click Add.

The Add Resource window opens, which provides the option to select files
from the local machine or FIP the files from another machine.
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Add Resource

Resource Source
Select resource source D

£~ Import resource From remote machine

= Back I Mext = I Eiristy | Cancel I

3. If the files are on another machine, select the Import resource from remote
machine option to start a file transfer process from the machine.

4. Click Next to open the File Transfer wizard.

3-8 Oracle Application Server Integration Adapter for IMS/DB Installation and User’'s Guide



Importing Metadata for the IMS/DB Data Source

File Transfer D '-1

Connection data:

FTP Server: | (05390, acme, com

Lsernarme: |

Password: |

I Anonyrous cannection

< Back | Text = | Eimish I Cancel I

5. Enter the server name where the DBD files, COBOL copybooks or PSB file
reside and, if not using anonymous access, enter a username and password to
access the machine.

6. Click Next. The machine is accessed and the directory structure displayed,
enabling you to browse to the files to be transferred.
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File Transfer

File Transfer D '-1
Files to retriesve:
=l 'TEST.AC4000." ACCLICED N
-0 ButLDiaT AcaICEN
"'D FIALIE ACCLICER
B[] INCLUDEH ACCLICT
=] LoAD ]
-] LOADAUT
-] MATAGENT ACTCE]
: ACTCI
-0 LS BCICS3GL
B[] SAMPLES BLOODEC
-2 5YSDEFSD BLDPROC
o CBCCL —
0 usERL CICSDEMO
CICS36L
COBDEMO
i |
Directory name: | 'TEST.AC4000, SAMPLES' Chg Raot Dir |
File name: | ACDOCPY; ACPOCPY; COBCPL

Transfer mode: ¢ Text

< Back I Mext = I Eimish | Cancel I

You access the OS/390 machine at the high-level qualifier for the user name. To
change the high-level qualifier, enter the name of the high-level qualifier in the
Directory name field and click the Chg Root Dir button.

7. Navigate to the location where the files reside and select the files to be
transferred and the transfer method (Text or Binary).

You can select the DBD files, COBOL copybooks and PSB file to be transferred
together.

8. Click Next. A summary screen is displayed with details of what is going to be
transferred.

9. Click Finish to start the transfer. The Select window is redisplayed with the list
of transferred files.
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Si

1o x|

elect IM5 database definition (DED) files:

=% M5_DATA_IMPORT
~[1 customers.cob

add... | 0] 4 I Cancel |

10.
11.

12.
13.

14.

Select the DBD files for the files you want to use in the import and click OK.

Click Add to add COBOL copybooks. The same Select window is displayed,
with all the available files.

Select the COBOL copybooks you want to use in the import and click OK.

Optionally, click Add to add a PSB file. The same Select window is displayed,
with all the available files.

Select the PSB file you want to use in the import and click OK.

Note: You can import the metadata from one DBD file or COBOL
copybook and later add to this metadata by redoing the import
using different DBD files or COBOL copybooks.

The format of the DBD files and COBOL copybooks must be the
same. That is, you cannot import a DBD file or COBOL copybook
that uses the first six columns with a DBD file or COBOL copybook
that ignores the first six columns. In this case, you must do separate
imports.
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onfiguration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

[[=34]
=g x || %5 *IMs_DaTa_IMPORT X
ﬁ 7 Data sources 3
E EIB VS, DATA Get Input Files Step 1 of 9
E---g IMS_DATA_IMPORT
e - Select IMS database definition {DBDY) files:
[ rustomers,cob dbd.txt el I
Remove |

Select COBOL copybook files:

customers, cob

add.., |
orders.cob
Removel
Select IMS Program Specification Block (PSE) file {optional):
PSE File: Erowse, .. |
[ Properties == B ox
Propert | it alue
Mame IMS_DATA
Path {05390\bindingsiMA, ..
Read-orl false
¥ | < Back| |Next #F | |Finish |
Main | Source

The files selected are displayed in the wizard. In the Metadata Import Explorer

the files used for the input and created for the output can be seen under the
Input and Output nodes respectively.

15. When you have completed adding the list of DBD files, COBOL copybooks and,
optionally, a PSB file, click Next.
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‘ Apply Filters Step 2 of 9 |

‘ Click Mext ta analvze and corvert the source files. You may alsa change warious Filker options. ‘

Propert | Walue |
[= cabolFilker
ignoreFirska False
ignioreFrom? 2 Erue
prefixMestedColumns False
B torpiate N
ignoreCase Erue

replace
search

[=] dbdFilter
ignoreFirska False
ignioreFrom? 2 Erue
ignoreLabels true
= psbFilter
ignoreFirska False
ignioreFrom? 2 Erue

| < Back| |Next > | |Finish |

Main J Source

16.

17.

18.

Apply filters to the COBOL copybooks.

The following filters are available:

ignoreFirst6 - Ignore the first six columns in the COBOL copybook.
ignoreFrom72 - Ignore columns 73 to 80 in the COBOL copybook.

prefixNestedColumns - Prefix all nested columns with the previous level
heading.

In addition, for the COBOL copybooks, you can specify a search string and the
string that will replace this search string in the generated metadata, and
whether the replacement is dependent on the case of the found string.

Apply filters to the DBD files.

The following filters are available:

ignoreFirst6 - Ignore the first six columns in the file.
ignoreFrom72 - Ignore columns 73 to 80 in the file.
ignoreLabels - Ignore labels in the file.

Apply filters to the PSB files.
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The following filters are available:

ignoreFirst6 - Ignore the first six columns in the file.

ignoreFrom?72 - Ignore columns 73 to 80 in the file.
19. Click Next to apply the filter settings.

20. The records that are identified in DBD file are displayed. You can select the
records you want to import.

Select Tables Step 3 of 9

Select tables to import:

Source and Table Name | Dataset I Parent
T
CLSTOMERS o
ORDERS i
Select Al | Unselect Al |

| LS4 Back| |Next E | |Finish |

Main J SOuUrce

21. Click Next.

22. Match each table selected from the DBD file with the COBOL copybook that
contains the relevant table structure. Select the files and tables from the
drop-down lists for each DBD entry.
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Match DBD to COBOL Step 4 of 9
Makch DED kables to Cobol tables
DED Tables | Cobal Files | Cobol Tables |
[l dbd. bt
CUSTCMERS customers, cob CUSTOMERS ;I
ORDERS Select file From the lisk Select Table from the lisk

CLISTOMERS

| LS4 Back| |Next BE | |Finish |

Main J SOuUrce

23. Click Next.

The import manager identifies the names of the records in the COBOL
copybooks that will be imported as tables.
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25. Click Next.

26. Click Next.
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27. Click Next to generate the metadata.
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‘ Import Metadata Step 9 of 9 |

‘ Click Finish ko end the import process, ‘

Deploy Metadata:
Do wou want ko transfer the metadaka to the server?

* No
 Yes

| <= Back| |Next S | |Finish |

28. Specify that you want to transfer the metadata from the Windows machine to
the OS/390 machine and click Finish.

The metadata is imported based on the options specified and it is stored on the
0S5/390 machine with the data source. An XML representation of the metadata is
generated, together with a PSB file and JCL to allocate a dataset for the PSB file.
These files can be viewed by expanding the Output node.

2771 Daka sources
=-[0 ms_pata
B9 IMS_DATA_IMPORT
S Input
[ Copy of customer:
[ customers.cob

(. [ arders.cob
E|Q Qukput

[ out.psb
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After performing the import, you can view the metadata in the Metadata
perspective in Oracle Studio. You can also make any fine adjustments to the
metadata and maintain it, as necessary.

See Also: "Metadata for the IMS/DB Data Source" on page A-2
for details about the data source metadata

Setting Up the Oracle Connect for IMS/DB Backend Adapter

To work with the Oracle Connect for IMS/DB, you need to set up a Database
adapter definition on the OS/390 machine to handle the interactions to and from
IMS/DB. You use Oracle Studio to specify these definitions.

Task: Setting Up the Adapter

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for IMS/DB" on page 2-21.

3. Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

4. Click the + next to the NAV binding node. The NAV binding configuration
includes branches for data sources and adapters that are located on the
machine.

5. Right-click Adapters and choose New Adapter from the popup menu, to open
the New Adapter wizard.

6. Inthe New window, enter a name for the adapter.

Note: The name specified for the adapter is also the name
specified setting up the delivery channel in Oracle Application
Server ProcessConnect. For details see, "Defining the Delivery
Channel" on page 4-2.

Note: The word event is a reserved word and cannot be used
when naming an adapter.
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7. Select the Database adapter type from the Type drop-down list:

New adapter
Creates New adapter %
Name: | IMIDB_ADAPTER

Type: IDatabase j

EVEHM
’]- IS T
]

Finish I Cancel I

8. Check the Create event queue for the adapter checkbox.

Note: Checking this box enables you to generate inbound
interactions, as described in Generating Inbound Interactions on
page 3-31.

9. Click Finish. The Adapter is added to the tree and the definition opened for
editing.

10. Select the Properties tab.

Modeling Interactions for Oracle Application Server Integration Adapter for IMS/DB  3-21



Generating Outbound Interactions

Adapter properties:

Propert | Walue |
iconnectString i
defaultDatasource
rultipleR esults true

General lProperties J

11. Set the following properties for the adapter:

Property Value Description
connectString - For internal use only
defaultDatasource ds_name The name of a data source in the

binding configuration defined in
For example, IMS_DATA "Setting Up the IMS/DB Data Source"

on page 3-2

multipleResults  true For internal use only

Note: You must specify the IMS/DB data source name for the
defaultDatasoure property.

Generating Outbound Interactions

Oracle Connect for IMS/DB requires metadata describing the adapter interactions,
including the structures used to pass information to and from the adapter.
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Use the Metadata perspective in Oracle Studio to generate interaction metadata for
the adapter.

Task 1: Setting Up the Metadata Perspective
Task 2: Generating Outbound Interactions

Task 3: Modifying the Generated Outbound Interactions

Task 1: Setting Up the Metadata Perspective

1.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for IMS/DB" on page 2-21.

Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

Click the + next to the NAV binding node.
Click the + next to the Adapters node.

Right-click the Oracle Connect for IMS/DB backend adapter defined in "Setting
Up the Oracle Connect for IMS/DB Backend Adapter" on page 3-20.

Choose Edit metadata from the popup menu, to open the Metadata perspective,
with the IMS/DB adapter displayed under the adapters list:

Task 2: Generating Outbound Interactions

1.

In the Metadata perspective, right-click the Interactions node and choose New
from the popup menu, to open the New Interaction wizard.

The New Interaction wizard opens with two options displayed, to create
interactions:

= Automatic - Four interactions are generated enabling the following SQL to
be executed:

SELECT
INSERT
UPDATE
DELETE
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= Manual - One interaction is generated, based on the type of SQL selected:
Database Query (a SELECT statement) or Database Modification (an
INSERT, UPDATE or DELETE statement).

Note: IMS/DB does not support the stored procedure option.

It is recommended that you choose the automatic mode to create interactions.

New Interactions and Records

Creation Mode

[l

Select creation mode

% Automatic (table-based interactions)

' Manual {select interackion type below):
% Dakabase Query

{* Database Modification
! Stored Procedure Call

= Back I Mext = I Eimisti | Cancel I

2. Click Next. The Select Tables screen opens, enabling you to add tables from the
IMS/DB data source that you want to access with the interaction.
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New Interactions and Records

Select Tables

Select tables f ink ki ;
elect tables for news interactions . .
—Tables
DataSource |Table | add |
Removel

........ <§ack ......... | . | IEmTI pem—

3. Click Add to add tables.

The data sources that have been defined and all the tables, for each data source,
that have had metadata defined for them are displayed.

Select the tables that you want to access with the interaction and click the right
arrow to move these tables into the right pane.
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Add Tables

Select
Select tables to add

-] DBCICS -] DOCTOR
B DECICS PATIEMT
3 ms
@ ms_cics
B ims_cics_gui

iLL

<

TREATMNT
[ WARD
i [ MS_DATA_
B[ IM5_IMSTM d|

Finish I Cancel I

4. Click Finish. The selected tables are displayed.

New Interactions and Records

Select Tables .
Select tables for new interactions . o
—Tables

DakaSource | Table | add |
IMS_DATA DO CTOR
IMS_DATA PATIENT Remove |

Hext = | Finish I Cancel
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Click Finish. Four interactions are generated for each table selected, together
with the record structures to support the interactions and the responses from

the IMS/DB data source.

5.

New Interactions and Records

Select Tables
Select tables for new interactions

L

@nutomatic generation results

Automatic generation completed sucessfully,
S interactions and 20 records were generated.
Continue updating adapter definition?

Mo

= Back | [ext = | Finish I Cancel I

6. Click Yes to complete the task. The interactions and the record structures that
relate to the interactions are displayed in the Metadata list.
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delete_IM5_DATA_DOCTOR
delete_IMS_DATA_DOCTOR
delete_IM5_DATA_PATIENT
delete_IM5_DATA_PATIENTI
insert_IMS_DATA_DOCTOR
insert_IMS_DATA_DOCTORF
insert_IMS_DATA_PATIEMT
insert_IMS_DATA_PATIENTR
recordset
select_IMS_DATA_DOCTOR,
select_IMS_DATA_DOCTORE
select_IMS_DATA_DOCTORF
select_IMS_DATA_PATIENT
select_IMS_DATA_PATIENTF
select_IMS_DATA_PATIEMTF
skatus
update_IM5_DATA_DOCTOF
update_IMS_DATA_DOCTOF
update_IMS_DATA_PATIENT
= update_IM5_DATA_PATIENT_|
27 Interactions

----- =% delete_IMS_DATA_DOCTOR
----- =% delete_IMS_DATA_PATIENT
----- % insert_IMS_DATA_DOCTOR

----- % insert_IMS_DATA_PATIENT
..... b colack TMS MATH FOeTOD
T

1

The SQL used in the interactions can be modified to the exact application
requirements using the Metadata perspective, as described in "Task 3: Modifying
the Generated Outbound Interactions" on page 3-28.

Task 3: Modifying the Generated Outbound Interactions

You can modify the interaction definitions to the exact requirements of the
application in the Metadata perspective. The following example uses the DELETE
interaction generated in the previous task to describe how the interactions can be
modified.

1. In the Metadata perspective, right-click the interaction to modify and choose
Edit Interaction from the popup menu.
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x

select_IMS_DATA_PATIENT -
select_IMS_DATA_PATIEMTRespol
select_IMS_DATA_PATIEMTROwW
status

update_IMS_DATA_DOCTOR
update_IMS_DATA_DOCTORResp
update_IM5_DaTaA_PATIENT

H update_IMS_DATA_PATIENTREsp
£ Inkeractions

=% delete_IMS_DATA_DOCTOR
= hl= T84 PATIENT
; insert 1l = Edit interaction
----- — insert_Il

= select I e

L select I 3 Delete

= update_

----- = update_ Test

----- EI Data sources

----- [:l Events

Refresh

The adapter metadata editor opens, displaying the Interaction General tab.

—Details

Interaction narme: I delete_IMS_DATA_PATIENT

Description: L
A

Mode: Isync-send-receive

—Inputfoutput Definitions

Input record: Idelete_IMS_DATA_PF\TIENT

Qutput record: Idelete_IMS_DP.TP._PP.TIENTResponse

General lInteraction General ] Interaction Advanced |Schema General | Schema Record | Source

The Interaction General tab displays general information about the way the
interaction is executed. You can add a description of the interaction and define
the mode of operation for the interaction. The following modes are available:
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= sync-send-receive - The interaction sends a request and expects to receive a
response.

= sync-send - The interaction sends a request and does not expect to receive a
response.

= sync-receive - The interaction expects to receive a response.

The information for a request is passed in the input record. The information for
the response from the IMS/DB data source is passed in the output record.

2. Click the Interaction Advanced tab to display specific information about the
interaction.

Interaction Type:  Database Modification

—S0L Skakement:

DELETE PATIEMT WHERE HOSPNAME = :HOSPMNAME
AND WARDNO = "WARDNO AND BEDIDENT = :BEDIDENT

Lt

[~ Pass Through

g o
_add |

—Parameters
ame | Type | Mullable | Default |
HOSPMAME skring False
WARDNO string False Delete |
BEDIDEMT skring False

General | Interaction General lInteraction Advanced JSchema General |Schema Recard | Source

As, required, change the SQL and the parameters associated with the SQL.

Parameters are specified in a SET clause or in a WHERE clause with the
following format:

:parameter_name

3. Dependent on the changes made to the SQL, when you close the editor, or click
the Save button, the Context Selection window opens.
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Context Selection

Choose adapter

Choose adapter this definition is used with

Il

W Update interaction-related records

Adapter; |IMSDE_ADAPTER (NAY)

Finish I Cancel I

Specify the adapter from the list and check the Update interaction-related
records checkbox. Any changes that need making to the record structures in the
schema part of the metadata are done automatically.

Note: The interaction records are built based on all the fields in
the table and cannot be changed manually, even if you change the
SQL so that less fields are involved.

Note: Modifying interactions is the same as described above,
which uses a DELETE SQL statement, for all types of SQL
statements (INSERT, UPDATE, etc.).

See Also: "Interaction Metadata for the Adapter” on page A-13 for
details about the adapter metadata

Generating Inbound Interactions

Inbound interactions are defined as events in Oracle Studio. When you defined the
Oracle Connect for IMS/DB backend adapter with the Create event queue for the
adapter box checked, as described in "Task: Setting Up the Adapter" on page 3-20,
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an event adapter was defined automatically. The event adapter is defined with the
same name as the backend adapter with the word event appended to it. The
backend adapter and the event adapter are linked by Oracle Studio. You can jump
from one adapter definition to the other by right-clicking the adapter or event in the
Configuration Explorer list and choosing the Linked Event or Linked Adapter
option respectively.

The event adapter requires metadata describing the inbound interactions, including
the structures used to pass information to and from the adapter.

Use the Import Metadata perspective in Oracle Studio to generate interaction
metadata for the adapter.

s Task 1: Defining an Import Procedure

s Task 2: Generating Inbound Interactions

Task 1: Defining an Import Procedure

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for IMS/DB" on page 2-21.

3. Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

4. Click the + next to the NAV binding node.
5. Click the + next to the Adapters node.

6. Right-click the IMS/DB adapter defined in "Setting Up the Oracle Connect for
IMS/DB Backend Adapter" on page 3-20.

7. Choose Linked Event from the popup menu, to jump to the event adapter.
8. Right-click the event adapter and choose Edit Event from the popup menu.

9. Select the Properties tab to add the names of Oracle Application Server
ProcessConnect users who can retrieve inbound interactions and OS/390 users
who can send inbound interactions.

10. To add Oracle Application Server ProcessConnect users, click the + next to the
routers node and right click the users property to add the user.
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Adapter properties:

Propert | Walue |

[Slrauters

[=] senders

Add Tkem
users [0] - Rigl A= Ta [u =T

3y item

General lProperties J

11.

12.

13.

14.

15.

16.

17.

18.

Enter the name of the Oracle Application Server ProcessConnect user in the
Value column for the item added.

To add OS/390 users, click the + next to the senders node and right click the
users property to add the user.

Enter the name of the OS/390 user in the Value column for the item added.
Click the Save Editor Contents button to save the changes.

Right-click the event adapter in the Configuration Explorer and choose Import
from the popup menu, to open the Metadata Import perspective, with the event
adapter displayed under the Events list.

Right-click the event adapter and choose New Import from the popup menu, to
open the New Metadata Import wizard.

Enter a name for the import. The name can contain letters and numbers and the
underscore character only.

Select Event Queue Import Manager Using Cobol COPYBOOK Input Files for
the Import Type.
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Metadata Import 1.,
Create new Metadata Import

Adapter: | IMSDE_ADAPTEREvent

Irnpork Marne: I INBOUMD _IMPORT

Impork Type: IEvent Queue Import Manager Using Cobol COPYBOOK Files j

Finish I Cancel I

19. Click Finish. The metadata import wizard opens in Oracle Studio.
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;,‘gl:onﬁguration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

|x-E28&]| ¢
ﬁ E Metadata Import Explorer * ot
| [ Adapters Get Input Files Step 1 of 5 ‘

----- D [iaka sources

B[] Events ;

g a IMSDE_ADAPTEREvent Seleck COBOL copybook files:
95 INBOUND_IMPORT add...
Removel

= Properties =l i

Propert: I Walue
Marne INBOUND_TMPORT
Path \5390\bindingsiMA. .
| << Back| |Next > | |Finish |
4 | | k| | Main | Source

Task 2: Generating Inbound Interactions

After defining an import as described in the preceding task, the metadata import
wizard opens in Oracle Studio. COBOL copybooks are used to create the metadata.

The import wizard generates record structures, which are used for the record
structures for inbound interactions.

Note: The generation of inbound interactions involves similar

steps to the steps described in "Task 2: Generating Metadata for the
IMS/DB Data" on page 3-7.

1. Click Add to add COBOL copybooks.

A Select window opens. This window lists any files selected.
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2. Click Add.

The Add Resource window opens, which provides the option to select files
from the local machine or FIP the files from another machine.

3. If the files are on another machine, select the Import resource from remote
machine option to start a file transfer process from the machine.

4. Click Next to open the File Transfer wizard.

5. Enter the server name where the COBOL copybooks reside and, if not using
anonymous access, enter a username and password to access the machine.

6. Click Next. The machine is accessed and the directory structure displayed,
enabling you to browse to the files to be transferred.

You access the OS/390 machine at the high-level qualifier for the user name. To
change the high-level qualifier, enter the name of the high-level qualifier in the
Directory name field and click the arrow button.

7. Navigate to the location where the files reside and select the files to be
transferred and the transfer method (Text or Binary).

8. Click Next. A summary screen is displayed with details of what is going to be
transferred.

9. Click Finish to start the transfer. The Select window is redisplayed with the list
of transferred files.

10. Select the files you want to use in the import and click OK.

Note: You can import the metadata from one COBOL copybook
and later add to this metadata by redoing the import using different
COBOL copybooks.

The format of the COBOL copybooks must be the same. That is,
you cannot import a COBOL copybook that uses the first six
columns with a COBOL copybook that ignores the first six
columns. In this case, you must do separate imports.
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@Metadata Import - Dracle Studio for Legacy adapters

1Ol x|
File Edit Mavigate Search ‘Window Help
Is-lBRalv]lB
ﬁ ﬁ Metadata Import Explorer * ot
5 [ Adapters ‘ Get Input Files Step 1 of 5 ‘
— | i D [iaka sources
B[] Events ;
Ela IMSDE_ADAPTEREvent Seleck COBOL copybook files:
95 INBOUND_IMPORT customers.cob Add...
Removel
= Properties B B x
Propert: I Walue
Marne INBOUND_TMPORT
Path \5390\bindingsiMA. .
| << Back| |Next > | |Finish |
4| | k| | Main | Source

11. In the metadata import wizard, click Next after you have completed adding the
list of copybooks.
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‘ Apply Filters Step 2 of 5 ‘

‘ Click Mext ta analvze and convert the source files. You may alsa change warious Filker optians, ‘

Property | Yalue |
cobolFiler e
ignoreFirska false
ignoreFrom?2 krue
prefixMestedColumns false
[= template
ignoreCase krue

replace
search

|<< Backl |Next > | |Finish |

Main J Source

12. Apply filters to the copybooks.
The following filters are available:
ignoreFirst6 - Ignore the first six columns in the COBOL copybook.
ignoreFrom72 - Ignore columns 73 to 80 in the COBOL copybook.

prefixNestedColumns - Prefix all nested columns with the previous level
heading.

In addition, you can specify a search string and the string that will replace this
search string in the generated metadata, and whether the replacement is
dependent on the case of the found string.

13. Click Next to apply the filter settings. The Add Events window opens.
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Add Events Step 3 of 5 |

Add Events:
[ arne | Mode | Inpuk | Cukpuk | Description | add
Remo\rel

| < Back| |Next E>3 | |Finish |

Main J Source

14. Click Add to add an interaction for the IMS/DB adapter.

15.

Interaction name - The name of the interaction.
Mode - The interaction mode:

async-send - The inbound interaction sends a request and does not expect
to receive a response.

Input - Identifies an input record. The input record is the data structure for the
inbound interaction. The records generated from the COBOL programs
specified at the beginning of the procedure are listed in a drop-down list. Select
the relevant record for the interaction.

Note: You must specify an input record for each interaction before
you can click Next.

Output - For internal use. You cannot specify in value in this field.
Description - Free text describing the interaction.

Add as many interactions as necessary and then click Next.
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16. Click Next to generate the metadata definitions for the adapter.
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‘ Import Metadata Step 5of 5 |

‘ Click Finish ko end the import process, ‘

Deploy Metadata:
Do wou want ko transfer the metadaka to the server?

* No
 Yes

| <= Back| |Next S | |Finish |

17. Specify that you want to transfer the metadata from the Windows machine to
the OS/390 machine and click Finish.

The metadata is imported based on the options specified and it is stored on the
0S/390 machine. An XML representation of the metadata is generated. This XML
file can be viewed by expanding the Output node.

After performing the import, you can view the metadata in the Metadata
perspective in Oracle Studio. You can also make any fine adjustments to the
metadata and maintain it, as necessary.

See Also: "Interaction Metadata for the Adapter” on page A-13 for
details about the adapter metadata
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Using Interactions in a Business Process

After the IMS/DB data source and the Oracle Connect for IMS/DB backend adapter
have been modeled as described in Chapter 3, "Modeling Interactions for Oracle
Application Server Integration Adapter for IMS/DB", the interactions can be used
in a business process in Oracle Application Server ProcessConnect. You define a
delivery channel for the IMS/DB adapter part of the Oracle Application Server
Integration Adapter for IMS/DB. This delivery channel is used during the modeling
in Oracle Application Server ProcessConnect with the interactions defined for the
adapter in Oracle Studio in a business process.

This chapter contains the following sections:

= Adding the IMS/DB Adapter in Oracle Application Server ProcessConnect
= Defining the Delivery Channel

= Modifying an Adapter in Oracle Studio

s Comparing a ProcessConnect XSD to an Oracle Connect Record Schema
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Adding the IMS/DB Adapter in Oracle Application Server
ProcessConnect
When adding the adapter type during the application definition, specify IMS/DB
Adapter.

See Also: Oracle Application Server ProcessConnect User’s Guide for
details of setting up applications in Oracle Application Server
ProcessConnect

Defining the Delivery Channel

Part of the application definition includes adding a delivery channel for the Oracle
Application Server Integration Adapter for IMS/DB.

The delivery channel identifies where the OS/390 database adapter is located and
the necessary security and encryption requirements to access the adapter.

Task: Setting Up the Delivery Channel

1. In the Create Delivery Channel page for the adapter, add the following
information to create a delivery channel.

Field Description

Name A name for this delivery channel

You must provide a value for this field

The Adapter Name The name of the Oracle Connect for IMS/DB backend
adapter to use, as defined in Oracle Studio. You can
check the name specified for the adapter in Oracle Studio

You must provide a value for this field

The Workspace to use The name of a server workspace to use. Leave blank to
use the default workspace. If you used another
workspace when modeling the adapter in Oracle Studio,
you can check the workspace name in the Configuration
perspective in Oracle Studio

If you are accessing IMS/DB directly (using the IMS-DLI
driver, as described in "Task: Adding the IMS/DB Data
Source Definition" on page 3-2), the workspace specified
here must be NVIMSSRV
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Field

Description

The Remote machine Name

The Port to connect

Protocol Name

Timeout via Connect
Encryption protocol name

Encryption key name
Encryption key value

The User Name
The User Password

Directory to store rejected
inbound interactions

The server machine TCP/IP host name. The host name is
the name of the machine where the Oracle Connect for
IMS/DB backend adapter was defined using Oracle
Studio

You must provide a value for this field

The TCP/IP port where the daemon is running on the
server. The default port is 2552. If you specified another
port when modeling the adapter in Oracle Studio, you
can check the port specified by right-clicking on the
machine in Oracle Studio and checking the port number
displayed

The firewall protocol used: either none or fixedNat (the
Nat protocol using a fixed address for the daemon). The
default is none

Connection timeout in seconds. The default is 0, meaning
that there is no connection timeout

Name of encryption protocol to use. The default is null.
The RC4 protocol is supported

Name of the symmetric encryption key to use
Value of the symmetric encryption key to use

The back-end user name for authentication. Leave blank
if anonymous access is allowed.

The back-end user password for authentication. Leave
blank if anonymous access is allowed

The directory where files with information about rejected
inbound interactions are stored. Each rejected inbound
interaction is stored in a file whose name consists of a
timestamp and the interaction name.

Click Apply.

The delivery channel is defined for the application and the Delivery Channels
Details page for the added delivery channel is displayed.

You can now select any of the interactions defined for the adapter.
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Note: You cannot add, modify or delete interactions for the
adapter from Oracle Application Server ProcessConnect. Any
changes to the interactions must be done in Oracle Studio.

Modifying an Adapter in Oracle Studio

The procedure for making changes in Oracle Studio to an interaction or to the
interaction input and output records and having the change reflected in Oracle
Application Server ProcessConnect depends on whether the configuration was
deployed or not.

Before the configuration has been deployed, delete the interaction from the
application (and all relevant items that reference the interaction) and after making
the change in Oracle Studio, add the changed interaction to the application.

After the configuration has been deployed, you cannot change the interaction until
you have performed the following procedure:

1. Stop both the adapter framework and integration manager processes.

2. Delete the interaction from the application (and all relevant items that reference
the interaction).

Make the changes to the interaction in Oracle Studio.
In the same application, add the changed interaction.

Redeploy the configuration.

o o & W

Start both the adapter framework and integration manager processes.

Comparing a ProcessConnect XSD to an Oracle Connect Record
Schema

The interaction that is modeled in Oracle Studio is automatically translated to an
xsd presentation in Oracle Application Server ProcessConnect. The xsd can be
viewed by displaying the record in the Native Dataypes window (under Modeling
> Datatypes).

The following example shows the Oracle Application Server ProcessConnect xsd for
an input record.

<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns="noNamespace://05390/Navigator/CustAccount#findCustAccountInput"
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targetNamespace="noNamespace://05S390/Navigator/CustAccount#findCustAccountInput"
elementFormDefault="qualified">
<xsd:element name="findCustAccountInput" type="findCustAccountInput"/>
<xsd:complexType name="findCustAccountInput">
<xsd:attribute default="ATCLIENT" name="EYE-CATCH" type="xsd:string"/>
<xsd:attribute name="ACCT-NUM" type="xsd:string"/>
</xsd:complexType>
</xsd:schema>

The Oracle Connect metadata for the input record, which was the source for the
above xsd, is part of the metadata definition:

<record name="findCustAccountInput">
<field name="EYE-CATCH" type="string" default="ATCLIENT"
size="8" nativeType="string"/>
<field name="ACCT-NUM" type="string" size="9" nativeType="numstr_u"/>
</record>

The Oracle Connect metadata definition can be viewed in Oracle Studio as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

Click the + next to the Bindings node.
Click the + next to the NAV binding node.
Click the + next to the Adapters node to display the adapters.

o o & v

Right-click the CICS adapter in the Configuration Explorer and choose Edit
Metadata to open the Metadata perspective.

7. Right-click the adapter in the Metadata Explorer and choose Edit definition.
8. Choose the Source tab to review the metadata definition.

The metadata definition includes the following parts:

= General information about the adapter

» Information about each interaction, including the names of the input and
output record

s The record schemas used to support the interactions, including input and
output (response) record schemas
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The following example shows the Oracle Application Server ProcessConnect xsd for
an output record.

<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns="noNamespace://03390/Navigator/CustAccount#findCustAccountResponse"
targetNamespace="noNamespace://05390/Navigator/CustAccount#findCustAccountRespon
se" elementFormDefault="qualified">
<xsd:element name="findCustAccountResponse" type="findCustAccountResponse"/>
<xsd:complexType name="findCustAccountResponse">
<xsd:attribute name="RET-CODE" type="xsd:string"/>
<xsd:attribute name="ACCT-ID" type="xsd:string"/>
<xsd:attribute name="ACCT-FIRST-NAME" type="xsd:string"/>
<xsd:attribute name="ACCT-LAST-NAME" type="xsd:string"/>
<xsd:attribute name="ACCT-BIRTH-DATE" type="xsd:string"/>
<xsd:attribute name="ACCT-MARRIED" type="xsd:int"/>
<xsd:attribute name="ACCT-CHILDREN" type="xsd:int"/>
<xsd:attribute name="ACCT-TOTAL-ASSETS" type="xsd:int"/>
<xsd:attribute name="ACCT-EMPLOYED" type="xsd:int"/>
<xsd:attribute name="ACCT-OVERTIME-HOURS" type="xsd:int"/>
<xsd:attribute name="ACCT-COMMISSION" type="xsd:float"/>
<xsd:attribute name="ACCT-SALARY" type="xsd:double"/>
<xsd:attribute name="ACCT-BALANCE" type="xsd:decimal"/>
<xsd:attribute name="ACCT-VACATION-DAYS" type="xsd:string"/>
</xsd:complexType>
</xsd:schema>

The Oracle Connect metadata for the output record has the following structure:

<record name="findCustAccountResponse">
<field name="RET-CODE" type="string" nativeType="intd"/>
<field name="ACCT-ID" type="string" size="9" nativeType="numstr_u"/>
<field name="ACCT-FIRST-NAME" type="string" size="20" nativeType="string"/>
<field name="ACCT-LAST-NAME" type="string" size="20" nativeType="string"/>
<field name="ACCT-BIRTH-DATE" type="string" size="8" nativeType="numstr_u"/>
<field name="ACCT-MARRIED" type="int" nativeType="int2"/>
<field name="ACCT-CHILDREN" type="int" nativeType="intd"/>
<field name="ACCT-TOTAL-ASSETS" type="int" nativeType="int8"/>
<field name="ACCT-EMPLOYED" type="int" nativeType="int2"/>
<field name="ACCT-OVERTIME-HOURS" type="int" nativeType="int4"/>
<field name="ACCT-COMMISSION" type="float" nativeType="single"/>
<field name="ACCT-SALARY" type="double" nativeType="dfloat"/>
<field name="ACCT-BALANCE" type="numeric" size="9"
scale="-2" nativeType="decimal"/>
<field name="ACCT-VACATION-DAYS" type="string" size="3"
nativeType="numstr_s"/>
</record>

4-6 Oracle Application Server Integration Adapter for IMS/DB Installation and User’'s Guide



O

Oracle Application Server Integration
Adapter for IMS/DB Features and
Restrictions

After the Oracle Application Server Integration Adapter for IMS/DB is installed
and the modeling described in Chapter 3, "Modeling Interactions for Oracle
Application Server Integration Adapter for IMS/DB" and Chapter 4, "Using
Interactions in a Business Process" completed, you can use the Oracle Application
Server Integration Adapter for IMS/DB to invoke interactions that access IMS/DB
data.

This chapter contains the following sections:

= Accessing IMS/DB Using SQL

= Sending Inbound Interactions Using a CICS Transaction

= Sending Inbound Interactions Using an IMS/TM Transaction
»  High Availability with Oracle Connect

s Known Restrictions

Note: When accessing IMS/DB directly, you model inbound
interactions using API functions in COBOL, as described in
Appendix E, "COBOL APIs to Applications".
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Accessing IMS/DB Using SQL

IMS/DB does not include a native SQL-based interface. The Oracle Application
Server Integration Adapter for IMS/DB provides support for standard ANSI '92
SQL to select, insert, update and delete IMS/DB records within the adapter
interactions. Additionally, you can incorporate enhancements into the SQL specified
in an interaction to handle hierarchical data in IMS/DB.

A hierarchical query is a query whose result is a hierarchy of rowsets reflecting
parent-child relationships.

Rowsets with arrays of structures as columns are modeled such that the rows of an
array constitute the children of a column in the containing parent row.

Hierarchical queries enable you to do the following:

= Arrange rowsets resulting from a query in a hierarchy, reflecting a parent-child
relationship

= Manipulate data that is stored hierarchically

You can handle this type of data in the following ways:

» By including the hierarchical data as a parent-child relationship
= By flattening the hierarchical data

= By using virtual tables to represent the data

See Also: Appendix C, "Supported SQL Syntax and SQL
Enhancements" on page C-1 for details

Generating Hierarchical Results

A hierarchical query nests a SELECT statement as one of the columns of the rowset
retrieved by a nested SELECT statement. You use braces ({}) to delimit the nesting.
This type of query generates a child rowset, which enables you to incorporate
drill-down operations in the application.

Example

The following hierarchical query, when specified in an interaction, produces a child
rowset:

SELECT C_name,
{SELECT O_orderkey,
{SELECT L_partkey, L_linenumber
FROM lineitem
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WHERE L_orderkey = O_orderkey} AS items
FROM torder WHERE O_custkey=C_custkey} AS orders
FROM customer

The result has a three-tier hierarchical structure. The main ("root") rowset has two
columns. The second column includes another ("child") rowset. This child rowset
includes items, a column that includes another child rowset.

Accessing Hierarchical Data Using SQL

Data stored hierarchically in a IMS/DB data source can be referenced by using a
hyphen followed by a right arrow (->) to denote the parent child relationship in the
source.

Example
The following query, when specified in an interaction, accesses a child rowset:

select name from employees->hchild

This example assumes hierarchical data with a parent rowset called employees.
This rowset has ordinary columns plus a column called hchild (one row for each
of the children of this employee). The query lists all of the children of all of the
employees.

Flattening Hierarchical Data Using SQL

You can produce a flattened view of hierarchical data by embedding a SELECT
statement inside the list of columns to be retrieved by another SELECT statement.
You use parentheses to delimit the nesting. This is equivalent to specifying a left
outer join between the parent rowset and a child rowset, and the resulting rowset
reproduces each row of the parent, combining it with one row for each of its
children.

The nested SELECT statement can reference a child rowset (using the parent->child
syntax) only in its FROM clause.

The examples that follow, when specified in interactions, assume hierarchical data
with a parent rowset called employees. This rowset has ordinary columns plus a
column called hchild (one row for each of the children of this employee).

Compare the following queries:

SELECT emp_id, (select name
from employees->hchild) from employees
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And

SELECT emp_id, (select name
from e->hchild)from employees e

The first query, without an alias, lists for each employee all of the children of all of
the employees. The second query uses an alias and produces a list containing the
children stored in an array called hchild belonging to each employee.

The following query retrieves the number of children that study in each city for
every city where the company has employees.

SELECT city, (SELECT COUNT (*)
FROM employees->hchild->hschool A
WHERE A.city = B.city)
FROM cities B

Sending Inbound Interactions Using a CICS Transaction

The Oracle Application Server Integration Adapter for IMS/DB includes a set of
APIs that enable sending a native event as an inbound interaction from a COBOL
program, using a CICS transaction.

See Also: Appendix E, "COBOL APIs to Applications" for details
of APIs that can be used when not working under CICS

To send an inbound interaction, perform the following tasks:

s Task 1: Setting Up the IBM OS/390 Machine

s Task 2: Setting Up a Call to the CICS Transaction

Task 1: Setting Up the IBM 0S/390 Machine

Before you can use the CICS transaction, set it up using the following procedure:
1. Copy INSTROOT.LOAD (ATTCICSD) to a CICS DFHRPL library.
2. Copy INSTROOT.LOAD (TRANS3GL) to a CICS DFHRPL library.
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Note: Make sure that the CICS Socket Interface is enabled. You
can enable this interface by issuing the following CICS command:

EZAO START CICS

Refer to the TCP/IP V3R2 For MV'S: CICS Sockets Interface Guide. 1f
you are not sure if the system is configured with the Socket
Interface, try running the EZAC transaction. If the transaction
produces a screen, you should be able to run the EZAO startup
transaction. If not, see if the transaction has been defined in a group
that has not been installed, for example: CEDC V TRANS (EZAC)
G(*).

If it is defined in a group, install that group and try running EZAO
again. If not, you have to configure CICS as outlined in the TCP/IP
V3R2 For MVS: CICS Sockets Interface Guide.

Set up CICS resource definitions for the COBOL program from which you want
to send a native event as an inbound interaction.

The following JCL can be used as a template:

//ATTCSD JOB 'ORACLE', 'CSD',MSGLEVEL=1,NOTIFY=&SYSUID
//STEP1 EXEC PGM=DFHCSDUP,REGION=512K,

// PARM="'CSD (READWRITE) , PAGESIZE (60) , NOCOMPAT'
//STEPLIB DD DSN=<HLQ1>.SDFHLOAD, DISP=SHR

//DFHCSD DD UNIT=SYSDA,DISP=SHR,DSN=<HLQ2>.CSD
//OUTDD DD SYSOUT=*

//SYSPRINT DD SYSOUT=*

//SYSIN DD *

*/********************************************************************/

*/* ORACLE CICS Definitions */
*/* */
*/********************************************************************/
K e e e *
* Note: Install GROUP(ORA) - CEDA IN G(ORA) *
* If you are rerunning this, uncomment the DELETE command. *
e *

* Start ORACLE RESOURCES:
* DELETE GROUP (ORA)

DEFINE PROGRAM (ATTCICSD) GROUP(ORA) LANGUAGE (C) DATALOCATION (ANY)
DE(Oracle DLL)
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DEFINE PROGRAM (TRANS3GL) GROUP(ORA) LANGUAGE (C) DATALOCATION (ANY)
DE (Oracle DLL)
DEFINE PROGRAM (<PROG>) GROUP(ORA) LANGUAGE (<LANG>) DATALOCATION (ANY)
DE (Oracle)
DEFINE TRANSACTION (<ORATRAN>) GROUP(ORA) PROGRAM (<PROG>)
TASKDATAL (ANY)
DE (Oracle TRAN ID)
LIST GROUP (ORA)

*

* End ORACLE RESOURCES

/%
/1
Make the following changes before running the JCL:
1. Modify the JCL, as follows:
— Change the JOB card to suit the site.
- Change <HLQ1> to point to the CICS SDFHLOAD library.
- Change <HLQ2> to point to the CICS CSD dataset.
- Change <LANG> to the LE370 for COBOL.
- Change <PROG> to the COBOL program name.

- If you are calling the COBOL program from a CICS transaction, change
<ORATRAN> to the CICS transaction name that calls the COBOL
program.

2. From CICS, install the ORA group, by issuing the following command:

CEDA IN G(ORA)

Task 2: Setting Up a Call to the CICS Transaction

5-6

The COBOL program sets up a buffer in the CICS COMMAREA that contains the
information needed for the inbound interaction and then calls the TRANS3GL
transaction to send the interaction.

The buffer is formatted as follows:

Parameter Size Description

Version 4 The version of the APIs used. The expected value is 1
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Parameter Size Description

ServersUrl 256 The URL of the OS/390 machine and the port number where
the Oracle Connect for IMS/DB backend adapter runs. For
example, IP1:2552, where IP1 is the URL and 2552 is the port

Username 64 A valid username to access the OS/390 machine
Password 64 A valid password for the user name

Workspace 64 A daemon workspace. The default is Navigator
AdapterName 64 The name of the adapter defined in Oracle Studio
SchemaFileName 256  For future use. Leave blank

EncKeyName 64 For future use. Leave blank

EncKeyValue 256  For future use. Leave blank

InteractionName 64 The name of the interaction as defined in Oracle Studio
Flags 4 The following flags are available:

= 1- A trace of the XML is performed
= 2 - A trace of the communication calls is performed
s 3 -Both the XML and communication calls are traced

= 4-The NAT firewall protocol is used, with a fixed address
for the daemon

= 5- Atrace of the XML is performed and the NAT firewall
protocol is used, with a fixed address for the daemon

= 6- A trace of the communication calls is performed and
the NAT firewall protocol is used, with a fixed address for
the daemon

s 7 -Both the XML and communication calls are traced and
the NAT firewall protocol is used, with a fixed address for
the daemon

Input format 4 The following formats are available:
= 0-Inputis provided as XML

= 1-Inputis provided using parameters

Oracle Application Server Integration Adapter for IMS/DB Features and Restrictions 5-7



Sending Inbound Interactions Using a CICS Transaction

Parameter Size Description

Input - The size of the input depends on the value specified in the
Input size parameter

If the Input format is set to 0 (XML), the input is formatted as
follows:

= The first four bytes specify the size of the input XML string

= The next 64 bytes specifies the name of the record used for
the output (the inbound interaction)

= The next bytes (to the exact length specified in the first
four bytes) specify the input XML string. For example:
<findorder ORDER_NO='17’ /> where findorder is
the inbound interaction name

If the Input format is set to 1 (the input is done using
parameters), the input is formatted as follows:

= The first four bytes specify the number of parameters

= The next 4 bytes specify the maximum size of any
parameter value

= The next 64 bytes specify the name of the record used for
the output (the inbound interaction)

= The next 32 bytes specify the name of the parameter

= The next bytes (to the exact length specified in the first
four bytes) specify the input parameter

= The following bytes repeat the last two entries until all the
parameters are specified

The buffer is defined as follows:

*

* COBOL COPY OF DATA BUFFER

*

01 COMM-DATA-BUFF PIC X(5000).

01 COMM-DATA-BUFF-ERROR REDEFINES COMM-DATA-BUFF.
05 COMM-ERROR-STATUS PIC S9(8) COMP SYNC.
05 COMM-ERROR-MSG PIC X(256).

01 COMM-DATA-BUFF-INPUT REDEFINES COMM-DATA-BUFF.
05 INPUT-COMMAREA-3GL.

10 INCOM-VERSION PIC S9(8) COMP SYNC.
10 INCOM-SERVERS-URLS PIC X(256).

5-8 Oracle Application Server Integration Adapter for IMS/DB Installation and User’'s Guide



Sending Inbound Interactions Using a CICS Transaction

* /* IP1:PORT[,IP2:PORT] [,...] */

10  INCOM-USER-NAME PIC X(64).

10  INCOM-PASSWORD PIC X(64).

10  INCOM-WORKSPACE PIC X(64).

10  INCOM-ADAPTER-NAME PIC X(64).

10  INCOM-SCHEMA-FILE-NAME PIC X(256).

10  INCOM-ENC-KEY-NAME PIC X(64).

10  INCOM-ENC-KEY-VALUE PIC X(256).

10  INCOM-INTERACTION-NAME PIC X(64).

10  INCOM-DW-FLAGS PIC S9(8) COMP SYNC.
10  INCOM-INP-FORMAT PIC S9(8) COMP SYNC.

10 INCOM-EXEC-INPUT.
15 INCOM-XML-BUFF.

20
20

* ====>>> CHANGE
20

INCOM-XML-ILEN PIC S9(8) COMP SYNC.
INCOM-XML-INTER-OUTREC-NAME

PIC X(64).
??? TO LEN SPECIFIED IN INCOM-XML-ILEN
INCOM-XML-INPUT PIC X(???).

15 INCOM-PARAM-BUFF REDEFINES INCOM-XML-BUFF.

20
20
20
* ====>>> CHANGE
20

* ====>>> CHANGE

INCOM-PARAM-COUNT PIC S9(8) COMP SYNC.
INCOM-PARAM-VALUE-LEN PIC S9(8) COMP SYNC.
INCOM-PARAM-INT-OUTREC-NAME PIC X(64).
?? TO COUNT SPECIFIED IN INCOM-PARAM-COUNT
INCOM-PARAM-NAME-VALUE OCCURS ?? TIMES.

25 INCOM-PARAM-NAME PIC X(32).

?? TO LEN SPECIFIED IN INCOM-PARAM-VALUE-LEN
25 INCOM-PARAM-VALUE PIC X(??).

01 COMM-DATA-BUFF-OUTPUT REDEFINES COMM-DATA-BUFF.

05 COMM-OUT-STATUS PIC S9(8) COMP SYNC.
05 COMM-OUT-LENGTH  PIC S9(8) COMP SYNC.

05 COMM-OUT-DATA

PIC X(4992)

The TRAN3GL transaction is called as follows:

EXEC CICS LINK PROGRAM/("TRANS3GL")

COMMAREA

(commDataBuff)

LENGTH (iCommSize) ;

where:

commDataBuff - The buffer with the interaction details, used in the COMMAREA.
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iCommSize - The size of the buffer. This value is also used to determine the size of
the output string. Thus make sure the value is big enough for the expected output.

After defining the COMMAREA and calling the TRAN3GL transaction in the
COBOL program, compile and move the COBOL program to a CICS DFHRPL
(LOAD,) library.

The output includes a 4 byte success flag: Zero for success, otherwise failure. The
output overrides the input. If the result is failure, an error message with a length of
256 bytes is returned.

If XML was specified for the input and the result is success, the output is formatted
as XML, as follows:

= The first four bytes specify the size of the output
= The following bytes make up the XML output

If parameters were specified for the input and the result is success, the output is
formatted as follows:

= The first four bytes specify the size of the output
= The next 32 bytes specify the name of the output attribute

= The next bytes (to the exact length specified for the input string in the) specify
the output value

= The following bytes repeat the last two entries until all the output is specified

Sending Inbound Interactions Using an IMS/TM Transaction

The Oracle Application Server Integration Adapter for IMS/TM includes a set of
APIs that enable sending a native event as an inbound interaction from a COBOL
program, using an IMS/TM transaction.

See Also: Appendix E, "COBOL APIs to Applications" for details
of APIs that can be used when not working under IMS/TM

To send an inbound interaction, perform the following tasks:
»  Task 1: Setting Up the IBM OS/390 Machine
»  Task 2: Setting Up a Call to the CICS Transaction
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Task 1: Setting Up the IBM 0S/390 Machine

Before you can use the IMS/TM transaction, set it up using the following
procedure:

1. Copy INSTROOT.LOAD (BASE) to an IMS/TM program library (such as
IMS.PGMLIB).

2. Copy INSTROOT.LOAD (ATYDC3GL) to the same IMS/TM program library (such
as IMS.PGMLIB).

Task 2: Setting Up a Call to the IMS/TM Transaction

The COBOL program sets up a buffer that contains the information needed for the
inbound interaction and then calls the ATYDC3GL program to send the interaction.

The buffer is formatted as follows:

Parameter Size Description
Version 4 The version of the APIs used. The expected value is 1
ServersUrl 256 The URL of the OS/390 machine and the port number where

the Oracle Connect for IMS/DB backend adapter runs. For
example, IP1:2552, where IP1 is the URL and 2552 is the port

Username 64 A valid username to access the OS/390 machine
Password 64 A valid password for the user name

Workspace 64 A daemon workspace. The default is Navigator
AdapterName 64 The name of the adapter defined in Oracle Studio

SchemaFileName 256 For future use. Leave blank

EncKeyName 64 For future use. Leave blank
EncKeyValue 256  For future use. Leave blank
InteractionName 64 The name of the interaction as defined in Oracle Studio
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Parameter Size Description

Flags 4 The following flags are available:

1 - A trace of the XML is performed
2 - A trace of the communication calls is performed
3 - Both the XML and communication calls are traced

4 - The NAT firewall protocol is used, with a fixed address
for the daemon

5 - A trace of the XML is performed and the NAT firewall
protocol is used, with a fixed address for the daemon

6 - A trace of the communication calls is performed and
the NAT firewall protocol is used, with a fixed address for
the daemon

7 - Both the XML and communication calls are traced and
the NAT firewall protocol is used, with a fixed address for
the daemon

Input format 4 The following formats are available:

0 - Input is provided as XML

1 - Input is provided using parameters
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Parameter Size Description

Input - The size of the input depends on the value specified in the

Input size parameter

If the Input format is set to 0 (XML), the input is formatted as
follows:

= The first four bytes specify the size of the input XML
string.

= The next 64 bytes specifies the name of the record used for
the output (the inbound interaction)

= The next bytes (to the exact length specified in the first
four bytes) specify the input XML string. For example:
<findorder ORDER_NO='17’ /> where findorder is
the inbound interaction name

If the Input format is set to 1 (the input is done using
parameters), the input is formatted as follows:

s The first four bytes specify the number of parameters

= The next 4 bytes specify the maximum size of any
parameter value

= The next 64 bytes specify the name of the record used for
the output (the inbound interaction)

= The next 32 bytes specify the name of the parameter

= The next bytes (to the exact length specified in the first
four bytes) specify the input parameter

= The following bytes repeat the last two entries until all the
parameters are specified

The ATYDC3GL transaction is called as follows:

1.

Write the following lines of code:

* COBOL COPY OF DATA BUFFER

*

01 COMM-DATA-BUFF PIC X(5000).

01 COMM-DATA-BUFF-ERROR REDEFINES COMM-DATA-BUFF.
05 COMM-ERROR-STATUS PIC S9(8) COMP SYNC.
05 COMM-ERROR-MSG PIC X(256).

01 COMM-DATA-BUFF-INPUT REDEFINES COMM-DATA-BUFF.
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05 INPUT-COMMAREA-3GL.

10 INCOM-VERSION PIC S9(8) COMP SYNC.
10 INCOM-SERVERS-URLS PIC X(256).
* /* IP1:PORT[,IP2:PORT] [,...] */
10 INCOM-USER-NAME PIC X(64)
10 INCOM-PASSWORD PIC X(64)
10 INCOM-WORKSPACE PIC X(64).
10 INCOM-ADAPTER-NAME PIC X(64).
10 INCOM-SCHEMA-FILE-NAME PIC X(256).
10 INCOM-ENC-KEY-NAME PIC X(64)
10 INCOM-ENC-KEY-VALUE PIC X(256).
10 INCOM-INTERACTION-NAME PIC X(64).
10 INCOM-DW-FLAGS PIC S9(8) COMP SYNC.
10 INCOM-INP-FORMAT PIC S9(8) COMP SYNC.

10 INCOM-EXEC-INPUT.
15 INCOM-XML-BUFF.
20 INCOM-XML-ILEN PIC S9(8) COMP SYNC.
20 INCOM-XML-INTER-OUTREC-NAME
PIC X(64).
* ====>>> CHANGE ??? TO LEN SPECIFIED IN INCOM-XML-ILEN
20 INCOM-XML-INPUT PIC X(??7?).
15 INCOM-PARAM-BUFF REDEFINES INCOM-XML-BUFF.
20 INCOM-PARAM-COUNT PIC S9(8) COMP SYNC.
20 INCOM-PARAM-VALUE-LEN PIC S9(8) COMP SYNC.
20 INCOM-PARAM-INT-OUTREC-NAME PIC X(64).
* ==>>> CHANGE ?? TO COUNT SPECIFIED IN INCOM-PARAM-COUNT
20 INCOM-PARAM-NAME-VALUE OCCURS ?? TIMES.
25 INCOM-PARAM-NAME PIC X(32).
* ====>>> CHANGE ?? TO LEN SPECIFIED IN INCOM-PARAM-VALUE-LEN
25 INCOM-PARAM-VALUE PIC X(?7?).

01 COMM-DATA-BUFF-OUTPUT REDEFINES COMM-DATA-BUFF.

05 COMM-OUT-STATUS PIC S9(8) COMP SYNC.
05 COMM-OUT-LENGTH PIC S9(8) COMP SYNC.

05 COMM-OUT-DATA PIC X(4992)

77 COMLEN PIC S9(4) COMP SYNC VALUE +5000.
77 API-INTERFACE PIC X(8) VALUE 'ATYDC3GL'.

CALL API-INTERFACE USING COMM-DATA-BUFF COMLEN.

where:
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COMM-DATA-BUFF - The buffer with the interaction details.

COMLEN - The size of the buffer. This value is also used to determine the size
of the output string. Thus make sure the value is big enough for the expected
output.

The first time the CALL is performed, it will do a one-time fetch and a call.
Thereafter, it will do only a call.

2. To release the module just before termination of the calling program, write the
following line of code:

CANCEL API-INTERFACE.
After defining the buffer and calling the ATYDC3GL transaction in the COBOL

program, compile and move the COBOL program to the IMS/TM program library
(such as IMS.PGMLIB).

The output includes a 4 byte success flag: Zero for success, otherwise failure. The
output overrides the input. If the result is failure, an error message with a length of
256 bytes is returned.

If XML was specified for the input and the result is success, the output is formatted
as XML, as follows:

»  The first four bytes specify the size of the output
= The following bytes make up the XML output

If parameters were specified for the input and the result is success, the output is
formatted as follows:

»  The first four bytes specify the size of the output
= The next 32 bytes specify the name of the output attribute

= The next bytes (to the exact length specified for the input string in the) specify
the output value

= The following bytes repeat the last two entries until all the output is specified
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High Availability with Oracle Connect
You can configure a pool of server processes so that a server process is always

available for a client request.

See Also: "Configuring the Daemon for High Availability” on
page 7-2 for details about high availability

Known Restrictions

If you encounter incompatibility problems not listed in this section, please contact
Oracle Support Services. The following section describes the known restrictions and
includes suggestions for dealing with them when possible:

s IMS/DB Data Source Restrictions

Note: If you have any questions or concerns about the restrictions,
contact Oracle Support Services.

IMS/DB Data Source Restrictions
When accessing IMS/DB data, the following restriction applies:

= Transactions are not supported when accessing IMS/DB directly. When
accessing IMS/DB under CICS or under IMS/TM, one-phase commit
transactions are supported.
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Troubleshooting the Oracle Application
Server Integration Adapter for IMS/DB

Troubleshooting Oracle Application Server Integration Adapter for IMS/DB can
involve checking both Oracle Application Server ProcessConnect and Oracle
Connect for IMS/DB.

This chapter contains the following sections:
= Design-Time Troubleshooting

= Troubleshooting the Daemon
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Design-Time Troubleshooting

The most common cause of errors when defining the Oracle Application Server
Integration Adapter for IMS/DB is incorrect definitions in the delivery channel. If
you encounter problems during the modeling phase, check the delivery channel

definitions.

See Also: Task: Setting Up the Delivery Channel on page 4-2 for
details of setting up the delivery channel

The following errors occur during the modeling of interactions, when using a
delivery channel that was defined incorrectly.

Specifying the Wrong Adapter Name

The following error occurs when the wrong adapter name is specified in the
delivery channel:

@ Error

An error occurred while attempting to log in with the selected delivery channel.

javax.resource. ResourceException : Error in Connecting to server © javax.resource.spi. CommEsxception: [J036] = client. noSuchResource
(acx.connect): [¥020] Requested resource, ‘wrong_adapter_name', is not available on this server

Add Interaction: Login

Flease enter the login information and select Apply. Information entered will be saved for the delivery channel and a login will be attempted.

Name Itest
The Adapter Name@dapt@
The Waorkspace to use I
The Remate machine name |1931.9E|.22 83
The Port to connect |2551

Check that the name specified for the adapter is the same as the name specified in

the delivery channel.

Specifying the Wrong Workspace Name

The following error occurs when the wrong workspace name is specified in the

delivery channel:
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@ Error

An error occurred while attermnpting to log in with the selected delivery channel.

Javax. resource. ResourceException © Error in Connecting to server : javax.resource. spi. CommException: [JO36] = client.requestErrar
(daemaon.connect): Warkspace wrang_workspace’ not found

Add Interaction: Login

Please enter the login information and select Apply. Information entered will be saved for the delivery channel and a login will be attempted.

Marme |test

The Adapter Mame |accoum
The Workspace to use@wor@
The Rernote machine name |194.90.22.BB
The Port to connect |2551

Check that the name specified for the adapter is the same as the name specified in
the delivery channel.

Specifying the Wrong Machine

The following error occurs when the remote machine is specified incorrectly:

@ Error

An error occurred while attempting to log in with the selected delivery channel.

javax.resource. ResourceException : Emor in Connecting 1o server © javax. resource.spi. CommEsxception: [J036] = client. noSuchResource
[acx.connect): [¥020] Requested resource, ‘account’, is not available on this serer

Add Interaction: Login

Pleage enter the login information and select Apply. Information enterad will be saved for the delivery channel and a login will be attempted.

Mame Itest

The Adapter Mame Iaccnum

The Warkspace to use I

The Remate machine name< |D 0.00 >

The Paort to connect |2551

Dvatnralblama |

Check the definition of the remote machine in the delivery channel definition.

Specifying the Wrong Port Number

The following error occurs when the port number to connect to is specified
incorrectly:
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@ Error

MNarme

The Adapter Name

The Waorkspace to use

The Remaote machine name

The Port to connect

ProtocolMarme

An error occurred while attempting to log in with the selected delivery channel.
Javax.resource. ResourceException : Error in Connecting to server : Javax.resource.spl. CommException: Connection refused
Add Interaction: Login

Please enter the login information and select Apply. Information entered will be saved for the delivery channel and a login will be attempted.

|test

|accuunt

|194.50.22 88

[

Check the port number defined in the delivery channel. The default port number is
2552.

When the Connection with the 0S/390 Machine Is Down

If the delivery channel definitions are correct, the problem is probably with the
connection with the OS/390 machine itself. In this case, check that you have a
connection to the OS/390 machine in Oracle Studio.

For example you receive a connection timeout error when the daemon is not
running on the mainframe:

(}‘z) Errar

A6 Amor Beoiumsd whil

Jae reRnynce Fe s

Troubleshoo

ke altectin g 10 100 i with 9 2alechad dalkarg chanmsl

rcaEsceptan | S in Coneacling 10 Sedesr | R reaounce g CommEcerdnn Connecton dmad aul

ting the Daemon

A daemon runs on the OS/390 machine. The daemon is responsible for allocating a
server process for a client. The daemon resides in a single address space and is
executed as a started task.

The daemon authenticates clients, authorizes requests for a server process within a
certain server workspace and provides the clients with the required servers. When a
client requests a connection, the daemon allocates a server process to handle this
connection, and refers the client to the allocated process. This may be a new process
(dedicated to this client) or an already-started process. Further communication
between the client session and the server process is direct and does not involve the
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daemon. The daemon is notified when the connection ends and the process is either
killed or remains for use by another client

The daemon supports multiple server configurations called workspaces. Each
workspace defines accessible data sources, applications, environment settings,
security requirements and server allocation rules. The allocation of servers by the
daemon is based on the workspace that the client uses to access the data source.
Thus, a client can access a data source using one workspace, where a server process
is allocated from an existing pool of servers, or the client can access a data source
using a different workspace, where a new server process is allocated for each client
request.

The daemon loads configuration settings such as various operational parameters as
well as the list of workspaces accessible through the daemon.

See Also: Appendix D, "Daemon Configuration Settings" for
details about the configuration settings

Troubleshooting the daemon and the communication between Oracle Application
Server ProcessConnect and Oracle Connect for IMS/DB is performed using Oracle
Studio to monitor the daemon and server activity and control what happens to the
daemon and server processes.

This section contains the following sections:

= Starting the Daemon

= Shutting Down the Daemon

= Monitoring the Daemon During Runtime
= Daemon Logs

= Resolving Communication Errors

Starting the Daemon

If for any reason you shut down the daemon, as described in "Shutting Down the
Daemon" on page 6-6, you can restart the daemon as described in the following
task.

Note: The daemon is started on the OS/390 machine only. It
cannot be started remotely using Oracle Studio.
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Task: Starting the Daemon

Activate INSTROOT.USERLIB (ATTDAEMN) as a started task to invoke the daemon.
For example, in the SDSF screen enter the following:

'/s ATTDAEMN'

INSTROOT is the high-level qualifier where Oracle Connect for IMS/DB is
installed.

See Also: "Starting the Daemon" on page 2-15 for details about
the ATTDAEMN JCL

Shutting Down the Daemon

If you need to shut down the daemon for any reason (for example, you want to
re-IPL the system), use Oracle Studio.

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

3. Right-click the machine defined in "Configuring Oracle Connect for IMS/DB"
on page 2-21 in the Configuration Explorer and choose Open Runtime
Perspective from the popup menu.

4. In the Runtime Explorer, right-click the machine and choose Shutdown
Daemon from the popup menu.

Monitoring the Daemon During Runtime

Use Oracle Studio to monitor the daemon during runtime.

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Right-click the machine defined in "Configuring Oracle Connect for IMS/DB"
on page 2-21 in the Configuration Explorer and choose Open Runtime
Perspective from the popup menu.

You can manage the daemon by right-clicking the relevant node: daemon,
workspace or server process.
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Daemon (Machine) Options

Right-click the daemon to display the options available for it, including the ability
to display the daemon log.

The following options are available at the machine level:

Status - Checks the status of the daemon. The information about the daemon
includes the name of the daemon configuration used, the active client sessions
and logging information.

Reload Configuration - Reloads the configuration after any changes. Any
servers currently started are not effected by the changed configuration.

See Also: Appendix D, "Daemon Configuration Settings" for

details about the configuration settings
View Log - View the daemon log. For details see Daemon Logs on page 6-9.
View Events - For future use.

Daemon Properties - Displays information about the machine where the
daemon is running, such as the physical address and any username and
password needed to access the machine.

Shutdown Daemon - Shuts down the daemon on the machine.

Rename - Enables changing the name of the daemon displayed in the tree.
Remove - Removes the machine from the perspective tree.

Edit Daemon Configuration - Open the daemon editor to enable you to

reconfigure the daemon.

See Also: Appendix D, "Daemon Configuration Settings" for
details about the configuration settings

Refresh - Refreshes the display.

Workspace Options

Right-click a workspace to display the options available for the workspace,
including the ability to display the workspace log.

The following options are available at the workspace level:

Status - Checks the status of the workspace, whether it is available or not.
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Reload Configuration - Reloads the configuration of the workspace after any
changes. Any servers currently started are not effected by the changed
configuration.

View Log - View the log for all servers for the workspace. For details see
Daemon Logs on page 6-9.

View Events - For future use.

End Unused Servers - Ends all server processes for the workspace that are not
active. All available and unconnected servers are terminated and any connected
servers are marked and terminated on release.

Use this option when changes to the daemon configuration were made after
servers were started up. On the next operation, servers are restarted, based on
the new settings.

End All Servers - Ends all the active server processes for the specified
workspace, regardless of whether the server has an active client.

Edit Workspace Configuration - Open the daemon editor to enable you to
reconfigure the workspace.

See Also: Appendix D, "Daemon Configuration Settings" for
details about the configuration settings

Refresh - Refreshes the display.

Server Options

Right-click a server to display the options available for the server, including the
ability to display the server log.

The following options are available at the server level:

Status - Checks the status of the server. The information about the server
includes the server mode and the number of active client sessions for the server.

View Log - View the server log. For details see Daemon Logs on page 6-9.
View Events - For future use.
End - Ends the server process.

Refresh - Refreshes the display.
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Daemon Logs

Oracle Connect for IMS/DB produces a number of logs that you can use to
troubleshoot problems. The daemon manages the following logs:

s The daemon log
= The workspace log
= The server process log

The Runtime Manager perspective of Oracle Studio provides a monitor for these
logs.

Display the required log by right-clicking the level you want (daemon, workspace
or server) and choosing the View Log option.

The Daemon Log Monitor

The daemon log displays activity between clients and the daemon, including clients
logging in and logging out from the daemon.
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You can change the level of logging by clicking the Update Monitor button on the
toolbar. The following levels of logging are available:

none - The log displays who has logged in and out from the daemon.

error - The log displays who has logged in and out from the daemon and any errors

that have been generated.

debug - The log displays who has logged in and out from the daemon, any errors
that have been generated and any tracing that has been specified in the daemon

configuration.

See Also:

"Daemon Logging" on page D-4 for details
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The Workspace Log Monitor

The workspace log displays information about the workspace being used by the
client.

You can change the level of logging by clicking the Update Monitor button on the
toolbar. The following levels of logging are available:

none - The log displays who has connected and disconnected from the server
process.

error - The log displays who has connected and disconnected from the server
process and any errors that have been generated.

debug - The log displays who has connected and disconnected from the server
process, any errors that have been generated and any tracing that has been specified
in the daemon configuration.

See Also: "WS Logging" on page D-16 for details
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The Server Log Monitor

The server log displays activity between clients and the server process used by that
client to handle the client request.
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You can change the level of logging by clicking the Update Monitor button on the
toolbar. The following levels of logging are available:

none - The log displays who has connected and disconnected from the server
process.

error - The log displays who has connected and disconnected from the server
process and any errors that have been generated.

debug - The log displays who has connected and disconnected from the server

process, any errors that have been generated and any tracing that has been specified
in the daemon configuration.
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See Also: "WS Logging" on page D-16 for details

The following table describes the log monitor toolbar buttons and their
functionality.

Table 6-1 Log Monitor Toolbar Buttons

Button Name Function
Resume Resumes monitoring the machine after the monitor has been
= suspended.

This button toggles with the suspend button.

Suspend Suspends the monitor.

1l

This button toggles with the resume button.

Update Monitor Updates the information being monitored.

Save as Enables specifying a name and location for saving the log.

: Clear view Clears the monitor view.
¥ |

Menu Displays a menu with the options available using the buttons.

Resolving Communication Errors

When Oracle Studio disconnects from the OS/390 machine, the machine is
displayed in Oracle Studio with an X in a red circle. If this situation occurs, try to
access the machine later.

The following table describes the various scenarios that may exist when Oracle
Application Server ProcessConnect disconnects from the OS/390 machine.
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Table 6-2 Scenarios When a Client Is Disconnected

Idle (Not Processing a Client

Scenario Request) Processing a Client Request
Explicit Disconnect The server is immediately notified of ~The server does not know that the client has
. .. the disconnect and either becomes disconnected and continues processing. When
(client explicitly . . . )
. available for use by another client or ~ processing completes, the server tries to reply to
closes connection . AP . . ’
terminates (if it is not reusable). the client and immediately gets an error that the

or client program . .
prog connection was lost. The server either becomes

terminates) available for use by another client or terminates (if
it is not reusable).
Abrupt Disconnect The server does not know that the The server does not know that the client has
. client has disconnected and remains  disconnected and continues processing. When
(client closed . . . .
in the idle state. processing completes, the server tries to reply to

without proper

shutdown or client After timing out based on whichever the client. After an interval (typically several

minutes, depending on the TCP/IP configuration),

e ot doemn warkansce | during which the TCP/IP subsystem refries
communication parameter or the TCP/IP KEEPALIVE Zi?g;;legs tt}}l1ea?:}e‘lsesil%sggi;hgeialcliegf{;?eoiiefrize’serthe
disconnected) parameter, the server is notified of the .

server that the connection has been closed. The

disconnect and either becomes
available for use by another client or
terminates (if it is not reusable).

server either becomes available for use by another
client or terminates (if it is not reusable).

To troubleshoot client/server communication problems, you need to be familiar
with the following;:

= The daemon configuration settings
= Oracle Connect for IMS/DB security.

s The TCP/IP subsystem. Oracle Application Server Integration Adapter for
IMS/DB uses TPC/IP for internal intermachine communications.

= System details, such as the account name and password of the administrator
account, the IP address of the machines involved and whether a portmapper is
being used.

Resolving Specific Errors
The following error messages relate to errors received from Oracle Connect.

C007: Server initialization failed.
Cause: The daemon failed to start its network service.

6-14 Oracle Application Server Integration Adapter for IMS/DB Installation and User’s Guide



Troubleshooting the Daemon

Action: Check the processes being run on the system to see whether another
daemon or program is using the port specified in the delivery channel for the
adapter.

Action: Check the TCP/IP subsystem on the current machine by trying to ping
it or run ftp or telnet to or from it.

Action: Check whether the daemon has privileges to use the TCP/IP services
on the current machine with the port specified in the delivery channel for the
adapter.

C008: Setting server event handler failed.
Cause: Internal error.

Action: Contact Oracle Support Services.

C009: IRPCD process has been terminated by user request.

Cause: This message is informational only. The daemon successfully shut
down.

Action: No action required.

CO00A: Application %s not found.
Cause: The requested workspace does not exist.

Action: Check that the workspace defined in the delivery channel is also
defined in the daemon configuration on the OS/390 machine. Use the Status
option in the Runtime Manager perspective.

CO00B: Invalid IRPCD client context.

Cause: A non-Oracle Connect legacy adapter program is trying to connect to
the daemon.

Action: Check the processes and kill the relevant process with a system
command.

C00C: Daemon request requires a server login.

Cause: A non-Oracle Connect legacy adapter server or program was trying to
use a daemon service reserved for Oracle Connect legacy adapter servers.

Action: Check the processes and kill the relevant process with a system
command.

C00D: Daemon request requires a client login.
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Cause: The requested daemon requires a valid client login, which was not
supplied.

Action: Reissue the command and specify a username/password.

Action: Edit the user profile in Oracle Studio to specify a valid username and
password for the OS/390 machine.

See Also: "Setting Up Runtime User Access to the IBM OS/390
Machine" on page 2-28 for details

CO0E: Daemon request requires an administrator login.
Cause: The requested daemon service requires an administrative login.

Action: Edit the daemon security in Oracle Studio to specify a valid
administrator username and password.

See Also: "Daemon Security" on page D-7 for details

COOF: Anonymous client logins are not allowed.
Cause: The daemon is configured to require a valid username and password,
which were not supplied.

Action: Enable anonymous client access in daemon security in Oracle Studio.
See Also: "Daemon Security" on page D-7 for details

Action: Edit the user profile in Oracle Studio to specify a valid username and
password for the OS/390 machine.

See Also: "Setting Up Runtime User Access to the IBM OS/390
Machine" on page 2-28 for details

C010: Anonymous server logins are not allowed.
Cause: Internal error.

Action: Contact Oracle Support Services.

C011: Client has already timed out.
Cause: A server process was started on behalf of a client and the client has
timed out before the server completed its startup.

Action: Increase the Connect timeout value for the server workspace in the WS
Info. section of the daemon configuration.
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See Also: "WS Info." on page D-10 for details

C012: Invalid username/password.
Cause: Invalid username/password supplied when logging on to the daemon.

Action: See the daemon log file for the reason that the username/password
were not accepted.

Action: Edit the user profile in Oracle Studio to specify a valid username and
password for the OS/390 machine.

See Also: "Setting Up Runtime User Access to the IBM OS/390
Machine" on page 2-28 for details

Action: Make sure the daemon is started from an APF-authorized account that
is allowed to check for system usernames and passwords.

C014: Client connection limit reached - try later.
Cause: The maximum number of server processes for the workspace has been
reached, and none of the active servers could accept the client connection.

Action: Increase the number of sub-tasks per address space in the WS Server
section of the daemon configuration.

See Also: "WS Server" on page D-12 for details

Action: Try running the command later.

CO015: Failed to start server process.

Cause: The Oracle Connect for IMS/DB daemon failed to start a server process
or the started server failed upon starting up.

Action: See the daemon and server log files for the reason the server did not
start. For example, you might receive an message with a reason specified in the
log file similar to the following: [C015] Failed to start NAVIGATOR
server process: No server account name defined for
anonymous client; code: -1601: SQL code: 0

Action: If you use impersonation, check the user profile on the client. Also see
C069.
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To set impersonation: APF authorize all the steplibs in the server
script on OS/390 machine. For example:

setprog... ada622-volume adavol
CICS.CICS.SDFHEXCI - p390dx
INSTROOT.load - 111111
INSTROOT.loadaut - 111111

INSTROOT is the high level qualifier where Oracle Connect for
IMS/DB is installed.

In the WS Security tab of the Navigator workspace under the
daemon node in the Configuration perspective, check Use
specific workspace account the and clear the Workspace
account field of all values.

C016: Unexpected server state.
Cause: Internal error.

Action: Contact Oracle Support Services.

C017: Active daemon clients exist. Shutdown canceled.
Cause: One or more clients are still connected to the daemon.

Action: Wait until all the clients log off the daemon and then retry the
shutdown operation.

C019: Request is not granted because someone else is locking it.

Cause: A request to lock a resource managed by the daemon was denied
because another user has locked the resource.

Action: Wait for the other user to release the resource.

C01A: Lock %s not found.

Cause: A request to free a resource was denied because the caller did not lock
that resource (for example, another user shut down the daemon you are
working with).

Action: Contact Oracle Support Services.

C01B: Unexpected error in %s.
Cause: Internal error.

Action: Contact Oracle Support Services.
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C01C: Cannot update configuration without _APPLICATIONS lock.
Action: Contact Oracle Support Services.

C01D: Need to lock the application first.
Cause: Internal error.

Action: Contact Oracle Support Services.

CO1F: Cannot set configuration of a deleted application.
Cause: Internal error.

Action: Contact Oracle Support Services.

C020: Failed in looking up host name (gethostname())
Cause: Cannot connect to the remote machine.

Action: Check that the name specified for the machine in the delivery channel
is correct.

Action: Check that a domain name server (DNS) is available to look up the host
name.

Action: Check the TCP/IP subsystem on the machine by trying to ping it or
run ftp or telnet to or from it.

C021: Required variable %s not found
Cause: An environment variable required by the Oracle Connect for IMS/DB
server was not defined when the server started up.

Action: Check whether the startup script makes any changes to the
environment variables used by Oracle Connect for IMS/DB.

Action: Check whether the system-defined environment size is sufficiently
large for Oracle Connect for IMS/DB.

C022: Server failed to connect and register with the daemon.

Cause: An Oracle Connect for IMS/DB server started by the daemon was not
able to connect or register back with the daemon.

Action: Try to connect again.

Action: Increase the Connect timeout value for the server workspace in the WS
Info. section of the daemon configuration.

See Also: "WS Info." on page D-10 for details
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Action: Check that the startup script for the workspace launches the correct
version of Oracle Connect for IMS/DB.

Action: Increase the number of sub-tasks per address space in the WS Server
section of the daemon configuration.

See Also: "WS Server" on page D-12 for details

C023: Call made to unregistered module %d.
Cause: Internal error.

Action: Contact Oracle Support Services.

C024: Failed to create a socket.
Cause: An error occurred within the TCP/IP subsystem.

Action: Check whether you have sufficient system privileges.

Action: Check the TCP/IP subsystem on the machine by trying to ping it or
run ftp or telnet to or from it.

C025: Failed to set socket option %s
Cause: An error occurred within the TCP/IP subsystem.

Action: Check whether you have sufficient system privileges.

Action: Check the TCP/IP subsystem on the machine by trying to ping it or
run ftp or telnet to or from it.

C026: Failed to bind server to port %s
Cause: An Oracle Connect for IMS/DB server or daemon was not able to bind
to the specified port.

Action: Check whether another program is holding the port that was specified
in port specified in the delivery channel for the adapter.

Action: Check whether you have sufficient system privileges.

C027: Cannot create TCP service for %s
Cause: An error occurred within the TCP/IP subsystem

Action: Check the TCP/IP subsystem on the machine by trying to ping it or
run ftp or telnet to or from it.

C028: Unable to register (%s, %d, tcp)

6-20 Oracle Application Server Integration Adapter for IMS/DB Installation and User’s Guide



Troubleshooting the Daemon

Cause: This error may happen when a portmapper is used (host:a) but the
portmapper is not available.

Action: Enable the portmapper.

Action: Avoid using the portmapper (by not using “:a” when starting the
daemon).

C029: Failed to create a server thread
Cause: Internal error.

Action: Contact Oracle Support Services.

CO02A: Server thread failed to start
Cause: Internal error.

Action: Contact Oracle Support Services.

C02B: Stopping the %s server - no client

Cause: A server that was started by the Oracle Connect for IMS/DB daemon to
service a client did not get a client connection request within one minute. The
server terminates.

Action: In most cases, the client was terminated by a user request, so no
specific action is required.

Action: If no client can connect to the server, it may be that the server has
multiple network cards and the Oracle Connect for IMS/DB daemon is not
aware of this. In this case, start the daemon with an IP address.

C02C: Unexpected event - a termination signal intercepted
Cause: Internal error.

Action: Contact Oracle Support Services.

C02D: Modified transport, context unknown/lost
Cause: Internal error.

Action: Contact Oracle Support Services.

CO02E: Call made to non-existing procedure %d

Cause: This error typically is caused by a client of a newer version calling an
old server.

Action: Verify that the client and server are using the same version of Oracle
Connect for IMS/DB.
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CO2F: Corrupted arguments passed to procedure
Cause: Internal error.

Action: Contact Oracle Support Services.

C030: Unable to free arguments for %s() of %s
Cause: Internal error.

Action: Contact Oracle Support Services.

C031: Cannot register a non-module RPC %s
Cause: Internal error.

Action: Contact Oracle Support Services.

C032: An IRPCD program is required
Cause: Internal error.

Action: Contact Oracle Support Services.

C033: An IRPCD super-server is required for module events
Cause: Internal error.

Action: Contact Oracle Support Services.

C034: An invalid super-server module ID was specified, %d
Cause: Internal error.

Action: Contact Oracle Support Services.

C035: Out of memory
Cause: Not enough memory to service a client request.

Action: Increase process memory quota and/or add memory to the system.

C036: Failed to register RPC procedure module %s
Cause: Internal error.

Action: Contact Oracle Support Services.

C037: Failed to register an invalid RPC procedure number %x
Cause: Internal error.

Action: Contact Oracle Support Services.

C038: Cannot re-register RPC procedure number %x
Cause: Internal error.
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Action: Contact Oracle Support Services.

C042: Remote call to %s failed; %s
Cause: Remote call to API failed.

Action: Check the daemon log file.

Action: If necessary, change the level of detail written to the log file to help
resolve the problem.

See Also: "Daemon Logging" on page D-4 for details

C043: Failed to connect to host %s;%s
Cause: The remote host is not correctly defined to Oracle Connect for IMS/DB
or is not working.

Action: Check the remote machine definition in the delivery channel for the
adapter.

Action: Check the daemon is up on the OS/390 machine. Use the Status option
in the Runtime Manager perspective.

Action: Check the network connection by trying to ping the host machine or
run ftp or telnet to or from it.

C045: Failed to create a service thread
Cause: The server failed to create a thread to service a client request.

Action: A system or process quota limit has been exceeded. Either increase the
quota or lower the Clients per server limit in the WS Info. section of the daemon
configuration.

See Also: "WS Info." on page D-10 for details

C047: %s out of memory

Cause: Not enough memory was available to Oracle Connect for IMS/DB to
complete a requested operation.

Action: Kill unnecessary processes running on the server.
Action: Add more memory to the system.

Action: Allow the process to use more memory.
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Action: Limit the number of processes the daemon may start. If the demand for
servers exceeds the number of available servers, clients get a message telling
them the maximum number of servers has been reached and asking them to try
again later.

C066: Communication error with the server%s
Cause: Connection to the Oracle Connect for IMS/DB daemon or server failed,
or an established session with a server has failed.

Action: Check the remote machine definition in the delivery channel.

Action: Check the daemon is up on the OS/390 machine. Use the Status option
in the Runtime Manager perspective.

Action: In case of a network problem, check the network connection by trying
to ping the host machine or run ftp or telnet to or from: it.

C067: Unexpected error occurred in server function %s
Cause: One of the server functions has exited with an exception (such as an
abend, or an Invalid Instruction).

Action: Contact Oracle Support Services.

C068: Fail to login daemon
Cause: The daemon is not running on the server machine.

Action: Use the Status in Oracle Studio Runtime Manager perspective to check
whether a daemon is running on the server

Action: Have the system administrator re-install Oracle Connect for IMS/DB
on the server.

C069: Fail to get server
Cause: The Oracle Connect for IMS/DB daemon on the server machine could
not start a server process to serve the client. A separate message provides more
detail on why the server process could not start.

Action: There are many possible causes of this error. If the cause is not clear
from the related message, see the Oracle Connect for IMS/DB daemon log file
on the server

Action: The resolution to this error is highly dependent on the particular cause.
The following are some typical causes and resolutions.
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Action: Some process creation quota was exceeded. Either try again later or
increase the quota or the other relevant system resources.

Action: The server startup script failed.

Action: The username given is not allowed to use the requested server. Use an
authorized username.

Action: A limit on concurrent clients for a server has been reached. Try again
later.

Action: If you use impersonation, check the user profile on the client. Also see
C015, above.

CO06A: Failed to connect to server

Cause: The server assigned to the client did not accept the client connection. A
separate message provides more detail about why the server process did not
accept the connection.

Action: See the daemon and server log files for the reason that the server was
not available to accept its assigned client.

Action: If a multi-threaded server is used and many clients are trying to
connect to it at the same time, some may get a Connection Refused error if the
TCP/1IP request queue fills up.

C06B: Disconnecting from server

Cause: A network failure, or a server machine failure or a server program
failure caused the connection to abort. The currently active transaction is
aborted as well.

Action: Oracle Connect for IMS/DB automatically tries to re-establish a
connection with a server upon the next SQL command issued against the server.
Once the network or machine failure is corrected, the connection to the daemon
is re-established automatically.

C070: Server failed to send reply to the client
Cause: Server terminated unexpectedly.

Action: Unless the client was intentionally stopped (for example, using
Control-C), contact Oracle Support Services.

C071: Connection to server %s was disconnected. Cursors state was lost.
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Cause: Either a network failure, a server machine failure or a server program
failure caused the connection to abort. The currently active transaction is
aborted as well.

Action: Normally, Oracle Connect for IMS/DB automatically tries to create a
new session with the server upon the next attempt to access the server. If the
network and server are accessible, the next operation should succeed.
Otherwise, the network and/or server machine should be fixed before
connection can be resumed.

Action: In case of a server crash not related to callable user code, contact Oracle
support.

C072: Reconnect to server %s
Cause: This is an informational message only. The client has reestablished its
connection with the server.

Action: No action is required.

C073: The parameters passed to the admin server are invalid: %s
Cause: Internal error.

Action: Contact Oracle Support Services.

C074: No authorization to perform the requested operation (%s)
Cause: User/account has insufficient privileges.
Action: Grant administrative privileges to the user/account via the

Administrator parameter of the Daemon Security or WS Security sections in the
daemon configuration.

See Also: "Daemon Security” on page D-7 or "WS Security" on
page D-18 for details

C075: Failed to register daemon in the TCP/IP service table
Cause: Registration of the daemon in the TCP/IP services file has failed.

Action: Check that the account running the daemon has the permissions to
update the TCP/IP services file.

E001: Failed in lock/release operation

Cause: A lock or release operation of a global resource has failed. A separate
message provides more details. The separate message specifies the cause of this
error.
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Action: There are various causes for this error, including lack of sufficient
privileges or a system resource shortage.
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7

Configuring the 0S/390 Working
Environment

Oracle Connect for IMS/DB includes a number of tuning parameters that can
improve performance. Specifically, the daemon can be configured to optimize
communication between the OS/390 machine and the client machine and the
binding environment can be tuned to optimize the way actual requests are handled.

This chapter contains the following sections:
= Configuring the Daemon for High Availability

s Configuring a Binding Environment
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Configuring the Daemon for High Availability

The daemon workspace is responsible for allocating server processes to clients. You
can configure a workspace to use a pool of server processes so that a server process
is always available for a client request. Use Oracle Studio to maintain daemon and
daemon workspace parameters to control the allocation of server processes and
their management in a pool.

You can also have a number of daemon workspace configurations. Thus, you can
tailor individual workspaces for use with different adapters.

The workspace that will be used is specified in the delivery channel, as described in
Defining the Delivery Channel on page 4-2.

Task: Adding a New Daemon Workspace Configuration

Use Oracle Studio to add a new daemon configuration. You can set up different
daemon configurations for different situations.

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for IMS/DB" on page 2-21.

3. Click the + next to the Daemons node. The daemon configurations available on
this machine are listed.

4. Right-click IRPCD and select New Workspace from the popup menu.

5. In the New daemon workspace window, specify a name the new workspace
and optionally a description.

6. Specify whether you want it to have default settings or to copy the properties of
an existing workspace.

To copy the properties of an existing workspace, click the ellipsis button and
select the workspace from which you want to copy the properties.

Once the workspace is defined the daemon editor is displayed, showing the WS
Info tab.

Task: Editing the Workspace

You edit a workspace using the following tabs:
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= WS Info - Specifies general information including the server type, the
command procedure used to start the workspace, the binding configuration
associated with this workspace and the timeout parameters.

= WS Server Mode - Specifies workspace server information including features
that control the operation of the servers started up by the workspace and
allocated to clients.

= WS Logging - Specifies parameters for logging and the format to use for a log
file.

= WS Security - Specifies administration privileges, user access, ports available to
access the workspace and workspace account specifications.

= WS Governing - Specifies information used to govern how a IMS/DB query is
executed.

Task: Configuring the Server Mode

The server mode dictates how the daemon starts up new processes. The daemon
supports the following server modes:

Single Client - Each client receives a dedicated server process. The account in
which a server process runs is determined either by the client login information or
by the specific server workspace.

This mode enables servers to run under a particular user account and isolates
clients from each other (since each receives its own process). However, this server
mode incurs a high overhead due to process startup times and may use a lot of
server resources (since it requires as many server processes as concurrent clients).

Multi-Client - Clients share a server process and are processed serially.

This mode has low overhead since the server processes are already initialized.
However, because clients share the same process, they may impact one another,
especially if they issue lengthy queries.

The number of clients that share a process is determined by the Clients per
server limit (the maximum number of concurrent clients a server process for
the current workspace accepts).

Reusable - This is an extension of the single client mode. Once the client processing
finishes, the server process does not die and can be used by another client, reducing
startup times and application startup overhead.
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This mode does not have the high overhead of single client mode since the servers
are already initialized. However, this server mode may use a lot of server resources
(since it requires as many server processes as concurrent clients).

The other modes can be set so that the server processes are reusable by setting the
number of times a process can be reused with the Reuse 1limit value (the
maximum number of times a particular server process can be reused or how many
clients it can serve before it is retired). Reuse of servers enhances performance since
it eliminates the need to repeat initializations. However, reuse runs a risk of higher
memory leakage over time. The default for the Reuse 1limit field value is None,
indicating that no reuse limit is enforced.

Set the server mode in the WS Server tab of the daemon editor:

Workspace server mode

—Reuse limit Clients per server limit
7 Mane ¢ Mone
% Maimum: IZD ﬁ  Maimum: ID ﬁ

—Server availability

Initial number of servers: I 1 ﬂ Minimum number of available servers: I 0 ﬂ
[~ et maximum rumber of servers: ID :I

—Resource limitations

Mumber of sub-tasks {05390 specific): I o i’
I Limit number of active servers: I a i’

—Server priority

% Use default priority

" Use priority specified: ID :I

Diaemaon Conkrol |Daem0n Logging |Daem0n Security |WS Infa. IWS Server ]WS Logging |WS Security |WS Governing |Source

When using any of the server modes you can specify a pool of server processes.
These server processes are started when the daemon starts and are maintained in a
pool. The server processes are available for use by new client requests from the
pool, saving initialization time. Instead of starting a new server process each time
one is requested by a client, the client receives a process immediately from the pool
of available processes. When the client finishes processing, this server process either
dies, or if reusable servers have been specified, it is returned to the pool.
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You set up a pool of server processes by specifying the following parameters in the
WS Server tab.

Initial number of servers - The number of server processes that are prestarted for
this workspace when the daemon starts up. These are available for use by new
client processes with minimal initialization time. Instead of starting a new server
process each time one is requested by a client, the daemon immediately allocates (to
the client) a server from a pool of available servers. When the number of available
server processes drops below the value specified in the Minimum number of
available servers field, the daemon again starts server processes until the
specified number of available servers is reached. The default for this parameter is 0,
meaning that no servers are prestarted for this workspace.

Minimum number of available servers - The minimum number of server processes
in the prestarted server's pool before the Oracle Connect daemon resumes creating
new server processes (up to the number specified in the Initial number of
servers field value, described above). If this parameter is set to a value greater
than that of the Initial number of servers field value, the daemon considers
the value to be the same as the value specified in the Initial number of
servers field. In this case, a new server process is started and added to the pool
each time a server process is removed from the pool and allocated to a client). The
default for this parameter is 0, meaning that new servers are created only when
there are no other available servers.

Set maximum number of servers - The maximum number of available server
processes pooled for this workspace. If the server is reusable, once a client
disconnects from the server, the daemon returns the server to the pool of available
servers. If the limit is reached, excess server processes are discarded.

Number of sub-tasks - The number of sub-tasks for a server that are prestarted for
this workspace when the daemon starts up. In addition to setting up a pool of
server processes as described above, you can set additional server processes as
sub-tasks by specifying this parameter. Thus, setting 10 servers and 10 prestarted
sub-tasks results in 100 tasks started (10 sub-tasks for each process).

Configuring a Binding Environment
Each binding configuration includes the following;:

=  Environment settings, which are used to configure the environment used by
any of the IMS/DB data sources and database adapters defined in the binding

s IMS/DB data sources on the current machine
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= Application adapters on the current machine

= Inbound queues for adapters on the OS/390 workstation machine. (Inbound
queues are referred to as events in Oracle Studio)

Configuring data sources, adapters and inbound queues are described in Chapter 3,
"Modeling Interactions for Oracle Application Server Integration Adapter for
IMS/DB". The following section describes the environment settings.

Task: Setting a Binding Environment

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for IMS/DB" on page 2-21.

3. Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

4. Right-click NAV and select Edit Binding.
5. In the Properties tab edit the environment settings as needed.

To edit an environment setting, expand the property category and click the value to
edit. The binding environment is divided into the following categories:

= comm Category

= debug Category

= miscellaneous Category
= odbc Category

= oledb Category

= optimizer Category

= queryProcessor Category
= transactions Category

= tuning Category

comm Category
The following parameters define communication buffers:
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comCacheBufferSize - The size of a memory buffer on a client, which is used by the
Oracle Connect client/server to store read-ahead data. The default is 200000 bytes.

comMaxSocketSize - The maximum bytes that can be written in one chunk on a
socket. The default is -1 (no limitation).

comMaxXmlInMemory - The maximum size of an XML document held in memory.
The default is 65535 bytes.

comMaxXmlSize - The maximum size of an XML document passed to another
machine. The default is 65535 bytes.

debug Category

The following parameters define debugging and logging operations.

acxTrace - When set to "true", the input xml sent to the backend adapter and the
output xml returned by the backend adapter, are written to the log.

analyzerQueryPlan - For internal use.
gdbTrace - For internal use.

generalTrace - When set to "true", logs general trace information. The default writes
only error messages to the log.

logFile - The high-level qualifier of the log file for messages. The following types of
message are written to the log:

= Error messages

s Trace information and information about the query optimization strategy if
generalTrace is set to "true"

oledbTrace - For internal use.

optimizerTrace - When set to "true”, trace information and information about the
Query Optimizer strategy is written to the log.

queryWarnings - When set to "true", generates a log of Query Processor warnings.

traceDir - For internal use.
miscellaneous Category

The following parameters define miscellaneous operations, including national
language support (NLS) and the directory where temporary files are written.
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codepage - For use with National Language Support (NLS) to identify the codepage
for the workspace.

See Also: Appendix F, "National Language Settings"

cvtSeverityLevel - The data type conversion policy when a conversion error occurs:
s 0 (Default) - The data in the output column will be a null or empty value.

s 1-The data in the output column will be a null or empty value and the
error is reported to the log.

= 2-Anerror is reported and processing stops.
edit - For internal use.

language - Identifies the application language. A default codepage is selected based
om the value specified for this parameter.

See Also: Appendix F, "National Language Settings"

nisString - Specifies the codepage used by a field whose data type is defined as
"nlsString". You use this for a field whose codepage is other than that of the
machine’s codepage. This parameter includes the following values:

= The name of the codepage.

= Whether the character set reads from right to left (as in middle eastern
character sets). The default is "false".

tempDir - The directory where temporary files are written, including the temporary
files created for use by hash joins and for sorting files. The default is the current
high-level qualifier.

year2000Policy - Determines the way 2-digit years are converted into 4-digit years.
When the parameter year2000Policy is not set, or when it is set to a value outside
the range of values defined for the policy, as described below, a default value of 5
and the Sliding Base Year policy is used. Two policies are provided:

Fixed Base Year - year2000Policy is set to a value greater than, or equal to 1900.
In this case, the value of year2000Policy is the first 4-digit year after 1900 that
can be represented by a 2-digit year. For example, if year2000Policy is set to
1905, the years 2000->2004 will be represented by 00->04. All other 2 digits will
map to 19xx.

This solution is most appropriate if there is live data at the low end (close to the
year 1900), which the user wants to keep with the current 2-digit format.
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The user will probably change the base date only after ensuring that these old
dates have been deleted from the data source.

Sliding Base Year - year2000Policy is set to a positive value less than 100. In this
case, the value of year2000Policy represents the number of years ahead of the
current year that can be represented by a 2-digit number. With each passing
year the earliest year that can be represented by a 2-digit number changes to a
year later.

odbc Category

The odbc parameters are for internal use.

oledb Category

The oledb parameters are for internal use.

optimizer Category
The following parameters enable you to customize the performance.

goal - The optimization policy, which can be specified as one of the following:
= none (default) - All row optimization is used.

= first - First row optimization is performed based on the assumption that the
results produced by the query are used as the rows are retrieved. The query
optimizer uses a strategy that retrieves the first rows as fast as possible,
which might result in a slower overall time to retrieve all the rows.

= all - Optimization is performed based on the assumption that the results
produced by the query are used after all the rows have been retrieved. The
query optimizer uses a strategy that retrieves all the rows as fast as
possible, which might result in a slower time to retrieve the first few rows.

Aggregate queries automatically use all row optimization, regardless of the
value of this parameter.

noHash]Join - When set to "true", disables hash join optimization. When hash joins
are enabled, a significant amount of disk space is required. Therefore, if the system
does not have much available disk space, disable hash join optimization.

noSemiJoin - For internal use.
preferredSite - For internal use.

semiJoinInValuesFactor - For internal use.
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queryProcessor Category
The following parameters enable you to fine tune how queries are processed.

compileAfterLoad - For internal use.
dsoThreadingBoth - For internal use.
emptyStringIsNull - When set to "true", all empty strings are reported as "NULL".

firstTreeExtensions - The maximum size allowed for an SQL query after
compilation. The default value is 150 KB.

forceQualifiedNames - For internal use.
ignoreSegmentBindFailure - For internal use.

maxColumnsInParsing - The maximum number of columns that a query
references. The default is 500 columns.

maxSqlCache - The maximum number of SQL queries stored in cache memory. The
default value is 3.

noCommandReuse - When set to "true", sets Query Processor not to cache for reuse
the executed state of a query.

noCompilationCache - When set to "true", sets Query Processor not to save a
successfully compiled statement in the cache.

noDSPropertyCache - For internal use.

nolnsertParameterization - When set to "true", sets Query Processor not to
parameterize constants in INSERT statements.

noMarkRowFailedFetch - When set to "true”, enables Query Processor to continue
fetching data after a failure in retrieving a row.

noMetadataCaching - When set to "true", Query Processor does not take object
metadata from the cache but directly from IMS/DB.

noParallelExecution - For internal use.

noQueryParametrization - When set to "true”, sets Query Processor not to convert
constants into parameters when accessing IMS/DB.

noQueryReadAhead - For internal use.
noSessionPooling - For internal use.
noSQSCache - For internal use.

noThreadedReadAhead - For internal use.
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noThreads - For internal use.
noTreeAutoExtend - For internal use.

optimisticForUpdate - When set to "true", optimistic locking becomes the default
for locking behavior.

parserDepth - The maximum depth of the expression tree.
proceduresCacheSize - For internal use.
promptDbUserPassword - For internal use.

tokenSize — The maximum length of a string in an SQL query. The minimum value
is 64. The default value is 350.

useAlternateQualifier - For internal use.

useTableFilterExpressions — When set to "true”, enables the use of tables that have
filter expressions specified in their metadata.

transactions Category
The transactions parameters are for internal use.

tuning Category

The following parameters define tuning.

dsmMaxBufferSize - The maximum size of a cache memory. This cache is used
when memory is required on a temporary basis (as when Oracle Connect sorts data
for a query output, for a subquery, or for aggregate queries). This cache size is not
used for hash joins and lookup joins (see the hashBufferSize parameter, below). The
default is 1000000 bytes.

dsmMaxSortBufferSize - The maximum size of the sort buffers. Use this parameter
instead of dsmMaxBufferSize for sorts only. The default is 1000000 bytes.

dsmMidBufferSize - The maximum size of the index cache. This cache is not used
for hash joins and lookup joins. The default is 100000 bytes.

hashBufferSize - The amount of cache memory that is available for each hash join
or lookup join. The default is 1000000 bytes.

hashEnableParallelism - Both sides of a hash join are read concurrently. The default
is "true".

hashMaxDiskSpace - The maximum amount of disk space (in MBs) that a query
can use for hash joins. The default is unlimited (all the free space on the allocated
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disk). If a query requires more space than allocated via this parameter, the query
execution will stop. The minimum value for this parameter is 20 MB.

Temporary files are written per query. Therefore, if several users can execute queries
at the same time, adjust the amount of space available, so that the total that can be
allocated at any one time does not exceed the available space.

hashMaxOpenFiles - The maximum number of files that a query can open at one
time for use when performing hash joins. The number assigned to this parameter
must not exceed the system maximum. The default is 90 files.
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The Oracle Connect for IMS/DB Metadata
Definitions

Oracle Studio includes an import utility to generate metadata for the IMS/DB data
source, using DBD files, COBOL copybooks and optionally, a PSB file. Once
imported, the metadata is maintained in the Metadata perspective of Oracle Studio.

Oracle Studio also includes a wizard to help define the adapter inbound and
outbound interactions and input and output structures used for these interactions.
The interactions and input and output structures are maintained as metadata in the
Metadata perspective of Oracle Studio.

This appendix contains the following sections:

m  Metadata for the IMS/DB Data Source

Note: The Oracle Application Server Integration Adapter for
IMS/DB provides a relational model for the IMS/DB data. Thus,
relational terminology is used. For example, the metadata for a
IMS/DB record is referred to as table metadata.

= Interaction Metadata for the Adapter
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Metadata for the IMS/DB Data Source

Use Oracle Studio to maintain the metadata for the IMS/DB data source.

1.  On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

Click the + next to the Bindings node.
Click the + next to the NAV binding node.

Click the + next to the Data sources node to display the data sources.

o o & W

Right-click the IMS/DB data source in the Configuration Explorer and choose
Edit Metadata to open the Metadata perspective.

_;.f;}l:onfiguration - Oracle Studio for Legacy Adapters

File Edit Mavigake Search Window Help

|- EB8a]| ¢
=1 ' x || @oocTor X ]
ﬁ i 27 adapters
|_:_|D Diata sources Table narne: I DOCTOR
e E"" M3 Comment: LI
=77 Tables

SHMPTOM

; TREATMMT
WARD

----- D Events

o il

Qrganization
’7(: Index ( Sequential ‘

—Record length

Maxirurm record length: I 0 DE Command |

—Filter expression

=] Properties ,E e X

Propert [ value ™ Set fiker expression
Marne DOCTOR, =
Path 405390 bindingsih ILl _'lj
< | b | | General ]Columns |Indexes | Statistics | Source
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General Tab

7. Right-click the table in the Metadata Explorer you want to view and choose
Edit.

The metadata editor opens, displaying the General tab, with general table details.
The following tabs are used to edit the metadata:

= General Tab

s Columns Tab

= Indexes Tab

= Statistics Tab

The following tab provides an XML representation of the data source metadata:

s Source Tab

Use the General tab to maintain information about the whole table, such as the
table name and the way the table is organized.
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Tahble name: I DOCTOR
Commenk: ;I

" o

—rganization
' Index  Sequential

—Record lenagth

Mazimurn record length: I 1] DB Command |

—Filter expression

[~ set filker expression

I;I =

General ICDIumns |Indexes | Statistics | Source

The General tab has the following fields:

Table name - The name of the table.

Comment - An optional description of the table.

Data File - The location of the file containing the table.

Organization - How the record represented by the table is organized. The options
that are displayed depend on the record. The following options are available:

s Index
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= Sequential
Maximum record length - How the record represented by the table is formatted:

Filter Expression - A WHERE clause. This clause is added to every query accessed
using this metadata. The filter is specified without the WHERE keyword. Specify a
filter when more than one logical table is stored in the same physical file.

IMS/DB specific commands are displayed in the DB Command window, which you
open by clicking DB Command.

E@DB Command

L |

ktableSpec parent="PATIENT level="3" root="HOSPITAL'>
=pcblist =0<fpchlist =
=/tableSpec=

" il

Ok I Cancel |

The information displayed is generated automatically when the metadata is
generated and should not be modified.

Columns Tab

Use the Columns tab to specify metadata describing the columns of the table.
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Caolurnn name | Data bvpe | Size | Scale | Cffset | Insett I
HOSPRAME skring 20 ]
L
WARDNO string 5 0 _w |
BEDIDEMT skring 4 ] Diovwn I
DOCTMAME skring 20 ]
DOCT_ADDRESS skring a0 ] Rename I
DOCT_PHOME skring 10 ]
— Delete
SPECIALT skring 20 ] —I
Find I
Calc offset |
—Column properties
Property | Walue
iBlias
Array dimension
Caomment ™ mullable
Onit ¥ Updateatbls
Empky walie
Pl v alue [ Explicit select
DB Command <columnSpec figldType="ancestorKey' ancestorh. .. [~ Auto increment
™ Hidden
| | ]

General lCDIumns IIndexes | Statistics | Source

The Columns tab has the following fields:
Column name - The name of the column.

Data type - The datatype of the data the column contains. Selecting this field
displays a list of the possible datatypes.

See Also: "IMS/DB Data Source Metadata Datatypes" on
page B-6 for details about the available datatypes

Size - The size allocated for the column.
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Scale - The definition depends on the datatype. For decimal datatypes this value is
the number of digits to the right of the decimal place. This number must not be
greater than the number of digits. The default value is 0. For scaled datatypes this
value is the total number of digits. The number must be negative.

Offset - An absolute offset for the field in a record.
The Column Properties relate to the selected column.

Alias - A name used to replace the default virtual table name for an array. Virtual
table names are generated by appending the array name to the record name. Thus,
when an array includes another array the name of the nested array is the name of
the record and the parent array and the nested array. When the default generated
virtual table name is too long to be usable, specify an Alias to replace the long
name.

Array dimension - The maximum number of occurrences of the group of columns
that make up the array.

Comment - A comment about the specific column.
OnBit - The position of the bit in a BIT field and the starting bit in a BITS field.

Empty value - The value for the field during an insert operation, when a value is
not specified

Null value - The null value for the field during an insert operation, when a value is
not specified.

DB Command - IMS/DB-specific commands for the column. The information
displayed is generated automatically when the metadata is generated and should
not be modified.

Nullable - The current field can contain NULL values.
Updateable - The current field can be updated.

Explicit select - The current field is not returned when you execute a SELECT *
FROM. . . statement. To return this field, you must explicitly ask for it (in a query
such as SELECT NATION_ID, SYSKEY FROM NATION where SYSKEY is a field
defined with Explicit Select).
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Note: You cannot include the asterisk (*) in a query where you
want to retrieve a field defined with Explicit Select. That is, a
statement such as SELECT *, SYSKEY FROM NATION will not
return SYSKEY.

You can disable this attribute by specifying the disableExplicitSelect
attribute in Oracle Studio, in the properties for the data source.

Auto increment - The current field is updated automatically by the data source
during an INSERT statement and should not be explicitly specified in the INSERT
statement. The INSERT statement should include an explicit list of values. This
attribute is used for fields such as an order number field whose value is
incremented each time a new order is entered to the data source.

Hidden - The current field is hidden from users.

Indexes Tab
Use the Indexes tab to specify metadata describing the indices of a table.

Note: The Indexes tab contains information only if the
Organization field in the Table tab is set to Index.
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Marne | Order | DB Cornrnand |
S} | Ascending I
HOSPMAME  Ascending
W AR DN Ascending
BECIDEMT Ascending

Inzert

Rename inde:x

il

Delete

Details of index

Carmrmenk: I

Tvpe
’]_ Unique | Clustered [ Hierarchical [~ Hashed

General |C|:|Iumns lIndexes JStatistiu:s | Source

The Indexes tab has the following fields:
Name - The names of existing indexes for the current table.
Order - The ordering of the rows retrieved by the index.

DB Command - IMS/DB-specific commands for the index. The information
displayed is generated automatically when the metadata is generated and should
not be modified.

The following index details can be specified:

Comment - An optional comment on the selected index.
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Type - Indicates the type of the index:
Unique - Indicates that the current index is unique.
Clustered - Indicates that the current index is clustered.
Hierarchical - Indicates that the current index is hierarchical.

Hashed - Indicates that the current index is hashed.

Statistics Tab
Use the Statistics tab to update statistics for a table.

Mo, of rows: IEI Mo, of blocks: IEI
|pdate |
— Caolumns
Colurmn name | Cardinality |
HOSPINAME 0
WARDNO 0
EEDIDEMT 0
DOCTMAME 0
DOCT_ADDRESS 0
DOCT _PHOME 0
SPECIALT 0
—Indexes
Indexes and segments | Cardinality: |
= [
HOSPRAME ]
HOSPMAME - WaRDNO ]
HOSPMAME - WaRDNO - BEDIDEMT ]

General |C|:|Iumns |Indexes lStatistics ISDurce
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The Statistics tab has the following fields:

No. of rows - The approximate number of rows in the table. If the value is -1, the
number of rows in the table is unknown (a value was not supplied and the update
statistics utility was not run to update the value). A value of 0 indicates that this
table is empty.

No. of blocks - The approximate number of blocks in the table.

Warning: If neither the number of rows nor the number of
blocks is specified for a table, queries over the table might be
executed in a nonoptimal manner.

Use the Columns group box to specify cardinality for each of the columns in the
table:

Column name - The columns in the table.

Cardinality - The number of distinct values for the column. If the value is -1, the
number of distinct values for the column is unknown (a value was not supplied and
the update statistics utility was not run to update the value). A value of 0 indicates
that there are no distinct values for the column.

Use the Indexes group box to specify cardinality for the columns in each of the
indexes in the table:

Indexes and segments - The indexes and segments in the table.

Cardinality - The number of distinct key values in the index. If the value is -1, the
number of distinct key values in the index is unknown (a value was not supplied
and the update statistics utility was not run to update the value). A value of 0
indicates that there are no distinct key values in the index.

Generating Statistics

Click the Update button in the Statistics tab to generate updated statistics for the
table.
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@Update statistics : x|

— Tvpe

{* Eskimated
™ Estimated with rows:
i~ Exact

—Resalution

™ all columns and indexes

™ Select columns and indexes

[T select Columns [T select indexes

BECIDEMT e
DT _ADDRESS
DT _PHCOME
DO THAME
HOSPRAME
SPECIALT
WARDND

| Ik I Zancel

The following fields are used to update statistics:
Use the Type group box to specify the following:
Estimated - An estimation of the amount of statistical information returned.

Estimated with rows - An estimation of the amount of statistical information
returned. The estimate includes an estimation of the number of rows in the table.
Specify the number in the text box. This number is used to shorten the time to
produce the statistics, assuming that the value specified here is the correct value, or
close to the correct value.

Use the Resolution group box to specify the following:

Exact - The exact statistical information returned. Note that this can be a lengthy
task and can lead to disk space problems with large tables.

A-12 Oracle Application Server Integration Adapter for IMS/DB Installation and User’s Guide



Interaction Metadata for the Adapter

Source Tab

Default - Only information about the table and indexes is collected. Information for
partial indexes and columns is not collected.

All columns and indexes - Information about the table, indexes, partial indexes and
columns is collected.

Select columns and indexes - Enables you to select the columns and indexes for
which you want to collect statistics. In the enabled list of columns or indices left
click those columns you want included (you can use shift-click and control-click to
select a number of columns or indices).

The Source tab displays the XML representation of the metadata.

Interaction Metadata for the Adapter

Use Oracle Studio to maintain the metadata for the IMS/DB adapter.

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

3. Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

4. Click the + next to the NAV binding node to display the adapters.

5. Right-click the IMS/DB adapter in the Configuration Explorer and choose Edit
Metadata to open the Metadata perspective.

6. Right-click the adapter in the Metadata Explorer and choose Edit definition.

The metadata editor opens, displaying the General tab, with general table details.
The following tabs are used to edit the metadata:

»  General Tab

= Interaction General Tab

» Interaction Advanced Tab
= Schema General Tab

s Schema Record Tab
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The following tab provides an XML representation of the metadata:

s Source Tab

General Tab

Use the General tab to maintain information generally describing the adapter and
the connection to it.

—Dekails
Adapter Definition Mame: I IMSDE_ADAFTER
Descripkion: ;I

-,
4 2

Yersion: I

Yendor: I

— Conneckion

Bukhenticakion Mechanism: I j Max Request Size: I

Max Active Conneckions: I Max Idle Timeouk; I

—Adapter Specifications

Properky I Walue |

General | Interaction General | Interaction Advanced |Schema General |Schema Recard |Source

The General tab has the following fields:

Adapter definition name - The name of the adapter definition.
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Description - An identifying description of the adapter.
Version - The adapter version.
Vendor - The vendor which the adapter came from.

Authentication mechanism - The authentication to access the adapter. The
available mechanisms are:

= Kkerbvb
= none
= basic-password

Max request size - The maximum size in bytes for an XML request or reply.
Larger messages are rejected with an error.

Max active connections - The maximum number of simultaneous connections
for an adapter (per process).

Max idle timeout - The maximum time, in seconds, that an active connection
can stay idle. After that time, the connection is closed.

Adapter Specifications - Adapter-specific properties.

Interaction General Tab

Use the Interaction General tab to define the general details of the interaction in
addition to its input and output definitions.
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—Details
Interaction Marme:
Description: ;I
.
1 3
fode: I j
— Input/Qutput Definitions
Input Record: I j Edif: ... |
Cukput Record; I j Edit: ... |

General | Inkeraction General | Interackion Advanced |5chema General |5chema Record | Source

The Interaction General tab has the following fields:
Interaction name - The name of the interaction.
Description - A descriptive identifier for the interaction.
Mode - The interaction mode:

= sync-send-receive - The outbound interaction sends a request and expects
to receive a response.

= sync-send - The outbound interaction sends a request and does not expect
to receive a response.
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= sync-receive - The outbound interaction expects to receive a response.

= async-send - The inbound interaction sends a request and does not expect
to receive a response.

Input record - Identifies an input record.

Output record - Identifies an output record for the results from an outbound
interaction.

Interaction Advanced Tab

Use the Interaction Advanced tab to define specific interaction properties.

Interaction Tvpe:  Database Modification

— 5L Skakernenk:

Gl

Kl

B

—Parameters

Mame | Type | rullable | Default dd

[

Delete

1| | o]

General | Interaction General | Interaction Advanced | Schema General |Schema Recard | Source
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The Interaction Advanced tab has the following fields:

SQL Statement - The SQL statement that is executed on the IMS/DB data
source by the interaction. Parameters are specified in the SQL, in a SET clause or
in a WHERE clause, with the following format:

:parameter_name

Pass Through - For internal use.

Parameters - Defines the property and value of parameters specific to the
interaction.

Name - The name of the parameter.
Type - The type of the parameter (such as number or string).
Nullable - Whether the value can be null or not.

Default - A default value for the parameter.

Schema General Tab

Use the Schema General tab to define the general details of the input and output
record structures for the interaction.
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—Dekails

Schema Mame: I

Version: I

Header: I

General | Inkeraction General | Inkeraction advanced | Schema General | Schema Record | Source

The Schema General tab has the following fields:
Schema name - The name of the adapter.
Version - The schema version.

Header - A C header, file to map between the data structure and the adapter.

Schema Record Tab

Use the Schema Record tab to define the input and output record structures for the
interaction.
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—Fields List

Marne | Type | Length I Mew Fieldl

—Specifications

Properky | Walue |

General | Inkeraction General | Inkeraction Advanced |5chema General | Schema Record | Source

The Schema Record tab has the following fields:
The Fields List defines single data items within a record.
Name - The name of the field.
Type - The datatype of the field. The following are valid datatypes:
Binary
Boolean

Byte
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Date
Double
Enum
Float

Int

Long
Numeric[(pl[,s])]
Short
String
Time
Timestamp

Length - The size of the field including a null terminator, when the
datatype supports null termination (such as the cstring data type).

Use the Specifications box to specify field properties.

Source Tab
The Source tab displays the XML representation of the adapter metadata.
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Datatype Support

The Oracle Application Server Integration Adapter for IMS/DB supports a number
of datatypes that are used when defining metadata for both the IMS/DB data
source and IMS/DB backend adapter in Oracle Studio. The datatypes are mapped
from the COBOL datatypes during the import procedure.

Note: The mapping of datatypes between Oracle Application
Server Integration Adapter for IMS/DB and Oracle Application
Server ProcessConnect is performed internally by Oracle Connect
for IMS/DB.

This appendix contains the following sections:

= Datatype Mapping for the IMS/DB Data Source

= IMS/DB Data Source Metadata Datatypes

= Datatype Mapping for the Oracle Connect for IMS/DB
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Datatype Mapping for the IMS/DB Data Source

The following table shows the mapping performed to generate metadata for a
IMS/DB data source from COBOL copybooks.

The COBOL datatype COMDP, in the table is an abbreviation for, and synonymous
with, COMPUTATIONAL. Square brackets ([ ]) denote optional qualifiers for some
COBOL compilers, which may not be allowed for other COBOL compilers.

Table B-1 Datatype Mapping: COBOL and IMS/DB Data Source

Oracle Connect
COBOL Datatype Datatype Details

BINARY (3 <= size < 5 with fractional data) scaled_int2 Signed word integer

Size = 2 bytes
Range: -32768 to +32767

BINARY (3 <= size < 5 without fractional data)  int2 Signed word integer
Size = 2 bytes
BINARY (5 <= size < 10 with fractional data) scaled_int4 Signed longword

Size = 4 bytes
Range: -2147483648 to +2147483647

BINARY (5 <= size < 10 without fractional data) int4 Signed longword
Size = 4 bytes
BINARY (size < 3 with fractional data) scaled_int1l Signed byte integer
Size =1 byte
Range: -128 to +127
BINARY (size < 3 without fractional data) intl Signed byte integer
Size =1 byte
BINARY (size >= 10 with fractional data) scaled_int8 Signed quadword

Size = 8 bytes
Range: -9,223,372,036,854,775,808 to
+9,223,372,036,854,775,807

BINARY (size >= 10 without fractional data) int8 Signed quadword
Size = 8 bytes
COMP (3 <= size < 5 with fractional data) scaled_int2 Signed word integer

Size = 2 bytes
Range: -32768 to +32767
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Table B-1 (Cont.) Datatype Mapping: COBOL and IMS/DB Data Source

COBOL Datatype

Oracle Connect

Datatype

Details

COMP (3 <= size < 5 without fractional data)

COMP (5 <= size < 10 with fractional data)

COMP (5 <= size < 10 without fractional data)

COMP (size < 3 with fractional data)

COMP (size < 3 without fractional data)

COMP-2

COMP-3

COMP-4 (5 <= size < 10 with fractional data)

COMP-4 (5 <= size < 10 without fractional data)

COMP-4 (size < 5 with fractional data)

COMP-4 (size < 5 without fractional data)

int2

scaled_int4

int4

scaled_intl

intl

dfloat

decimal

scaled_int4

int4

scaled_int2

int2

Signed word integer
Size = 2 bytes
Signed longword

Size = 4 bytes
Range: -2147483648 to +2147483647

Signed longword
Size = 4 bytes
Signed byte integer

Size = 1 byte
Range: -128 to +127

Signed byte integer
Size = 1 byte
Double floating point number

Size = 8 bytes
Range: 0.29E-38 to 1.7E38
Precision: 16 digits

Packed decimal

Maximum number of digits = 31
Maximum fractions = 11
Length = int (number of digits/2) + 1 bytes

Signed longword

Size = 4 bytes
Range: -2147483648 to +2147483647

Signed longword
Size = 4 bytes
Signed word integer

Size = 2 bytes
Range: -32768 to +32767

Signed word integer

Size = 2 bytes
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Table B-1 (Cont.) Datatype Mapping: COBOL and IMS/DB Data Source

Oracle Connect
COBOL Datatype Datatype Details

COMP-4 (size >= 10 with fractional data) scaled_int8 Signed quadword

Size = 8 bytes
Range: -9,223,372,036,854,775,808 to
+9,223,372,036,854,775,807

COMP-4 (size >= 10 without fractional data) int8 Signed quadword
Size = 8 bytes
COMP-5 (5 <= size < 10 with fractional data) scaled_int4 Signed long integer

Size = 4 bytes
Range: 2147483648 to +2147483647

COMP-5 (5 <= size < 10 without fractional data) int4 Signed long integer
Size = 4 bytes
COMP-5 (size < 5 with fractional data) scaled_int2 Signed word integer

Size = 2 bytes
Range: -32768 to +32767

COMP-5 (size < 5 without fractional data) int2 Signed word integer
Size = 2 bytes
COMP-5 (size >= 10 with fractional data) scaled_int8 Signed quadword

Size = 8 bytes
Range: -9,223,372,036,854,775,808 to
+9,223,372,036,854,775,807

COMP-5 (size >= 10 without fractional data) int8 Signed quadword
Size = 8 bytes
COMP-X (3 <= size < 5 with fractional data) scaled_int2 Signed word integer

Size = 2 bytes
Range: -32768 to +32767

COMP-X (3 <= size < 5 without fractional data) int2 Signed word integer
Size = 2 bytes
COMP-X (5 <= size < 10 with fractional data) scaled_int4 Signed long integer

Size = 4 bytes
Range: 2147483648 to +2147483647
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Table B-1 (Cont.) Datatype Mapping: COBOL and IMS/DB Data Source

Oracle Connect

COBOL Datatype Datatype Details

COMP-X (5 <= size < 10 without fractional data) int4 Signed long integer
Size = 4 bytes

COMP-X (size < 3 with fractional data) scaled_int1l Signed byte integer
Size =1 byte
Range: -128 to +127

COMP-X (size < 3 without fractional data) intl Signed byte integer
Size =1 byte

COMP-X (size >= 10 with fractional data) scaled_int8 Signed quadword

Size = 8 bytes
Range: -9,223,372,036,854,775,808 to
+9,223,372,036,854,775,807

COMP-X (size >= 10 without fractional data) int8 Signed quadword
Size = 8 bytes

INDEX int4 Signed long integer
Size = 4 bytes

[SIGN [IS]] LEADING numstr_nl Signed numeric string. Sign is the first
character of the string

Maximum number of digits = 31
Maximum fractions = 11

[SIGN [IS]] LEADING SEPARATE numstr_nl Signed numeric string. Sign is the first
[CHARACTER] character of the string

Maximum number of digits = 31
Maximum fractions = 11

NATIVE-2 int2 Signed word integer
Size = 2 bytes

NATIVE-4 int4 Signed long integer
Size = 4 bytes

NATIVE-8 scaled_int8 Signed quadword

Size = 8 bytes
Range: -9,223,372,036,854,775,808 to
+9,223,372,036,854,775,807
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Table B-1 (Cont.) Datatype Mapping: COBOL and IMS/DB Data Source

Oracle Connect
COBOL Datatype Datatype Details

PACKED-DECIMAL decimal Packed decimal
Maximum number of digits = 31
Maximum fractions = 11
Length = int (number of digits/2) + 1 bytes
POINTER int4 Signed long integer
Size = 4 bytes
[SIGN [IS]] TRAILING numstr_nr Signed numeric string. Sign is the last
character of the string.

Maximum number of digits = 31
Maximum fractions = 11

[SIGN [IS]] TRAILING SEPARATE numstr_nr Signed numeric string. Sign is the last
[CHARACTER] character of the string

Maximum number of digits = 31
Maximum fractions = 11

IMS/DB Data Source Metadata Datatypes

The following table shows all the valid datatypes that can be used to describe the
metadata for a IMS/DB data source.

Note: This section is for reference only. The only datatypes that
should be used are those generated for the COBOL copybook, as
described in "Datatype Mapping for the IMS/DB Data Source" on
page B-2.

Table B-2 IMS/DB Metadata Datatypes

Oracle Connect

Datatype Details
bit Single bit within a byte
Size = 1 byte

Format: <field name="name" datatype="bits" onBit="n"
/>, where n specifies the bit (within a byte) the field uses
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Table B-2 (Cont.) IMS/DB Metadata Datatypes

Oracle Connect

Datatype Details
bits A signed number of bits within a byte
Size = 1 bit to 1 byte
Format: <field name="name" datatype="bits" onBit="n"
size="m"... />, where n specifies the bit (within a byte) to start
from and m is the number of bits. If  is not specified then n defaults to
1 for the first occurrence of the field and is contiguous thereafter.
The maximum number of bits you can map is 32
cstring Null-terminated string of alphanumeric characters; maximum length
must be specified. An extra byte is required for the null flag
date6 Date in a string having the form YYMMDD
date8 Date in a string having the form YYYYMMDD
decimal Packed decimal
Maximum number of digits = 31
Maximum fractions = 11
Length = int (number of digits/2) + 1 bytes
dfloat Double floating point number
Size = 8 bytes
Range: 0.29E-38 to 1.7E38
Precision: 16 digits
double Double floating number
Size = 8 bytes
Range: 0.56E-308 to 0.90E308
Precision: 15 digits
filler Allocation for future use, string type; length must be specified
image Image data (Binary large object)
int_date Date in a four byte integer having the form YYMMDD or YYYYMMDD
Example, 23-Jul-1998 has the form: 980723 or 19980723
intl Signed byte integer
Size = 1 byte
int2 Signed word integer

Size = 2 bytes
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Table B-2 (Cont.) IMS/DB Metadata Datatypes

Oracle Connect

Datatype Details
int3 Signed integer
Size = 3 bytes
int4 Signed longword
Size = 4 bytes
int6 Signed integer
Size = 6 bytes
int8 Signed quadword
Size = 8 bytes
jdate Julian date
Size = 2 bytes
Bits 0-6: (non-century) year
Bits 7-15: day of the year
logical Signed long integer

numstr_bdn

numstr_nl

numstr_nlo

numstr_nr

numstr_s

Values: 1 for true, 0 for false.

Signed numeric string. Sign is the first character of the string.

Maximum number of digits = 31
Maximum fractions = 11

Note: the number of fractions includes the decimal point
Signed numeric string. Sign is the first character of the string

Maximum number of digits = 31
Maximum fractions = 11

Signed numeric string. A left overpunched sign is implemented.

Maximum number of digits = 31
Maximum fractions = 11

Signed numeric string. Sign is the last character of the string.

Maximum number of digits = 31
Maximum fractions = 11

Signed numeric string. A right overpunched sign is implemented

Maximum number of digits = 31
Maximum fractions = 11
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Table B-2 (Cont.) IMS/DB Metadata Datatypes

Oracle Connect
Datatype Details

numstr_u Unsigned numeric string

Maximum number of digits = 31
Maximum fractions = 11

numstr_zoned Signed numeric string

Maximum number of digits = 31
Maximum fractions = 11

phdate Size = 2 bytes
Bits 0-6: (non-century) year
Bits 7-10: number of month
Bits 11-15: day of month

scaled_intl Signed byte integer

Size = 1 byte
Range: -128 to +127

scaled_int2 Signed word integer

Size = 2 bytes
Range: -32768 to +32767

scaled_int3 Signed integer
Size = 3 bytes
scaled_int4 Signed long integer

Size = 4 bytes
Range: 2147483648 to +2147483647

scaled_int6 Signed integer
Size = 6 bytes
scaled_int8 Signed quadword

Size = 8 bytes
Range: -9,223,372,036,854,775,808 to +9,223,372,036,854,775,807

scaled_uint1l Unsigned byte integer

Size = 1 byte
Range: 0 to 254

scaled_uint2 Unsigned word integer

Size = 2 bytes
Range: 0 to 65534
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Table B-2 (Cont.) IMS/DB Metadata Datatypes

Oracle Connect
Datatype Details

scaled_uint4 Unsigned long integer

Size = 4 bytes
Range: 0 to +4,294,967,294.

scaled_uint4 Unsigned long integer

Size = 4 bytes
Range: 0 to 4294967294

str_date Atomic date string

Size = 10 characters
Format = YYYY-MM-DD

str_time Atomic date string

Size = 8 characters
Format = HH:MM.:SS

string String of alphanumeric characters; length must be specified
text Text data (Binary large object)
ubits An unsigned number of bits within a byte

Size = 1 bit to 1 byte

Format: <field name="name" datatype="bits" onBit="n"
size="m" ... />, wheren specifies the bit (within a byte) to start
from and m is the number of bits. If # is not specified then n defaults to
1 for the first occurrence of the field and is contiguous thereafter

The maximum number of bits you can map is 31

uint2 Unsigned word integer

Size = 2 bytes
Range: 0 to +65534.

uint6 Unsigned integer

Size = 6 bytes

unicode Null-terminated alphanumeric unicode string; maximum length must
be specified

unspecified Unknown datatype, string type, length must be specified

varstring 16 bit count, followed by a string

varstring4 32 bit count, followed by a string
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Datatype Mapping for the Oracle Connect for IMS/DB

The following table shows the mapping performed to generate metadata for the
IMS/DB backend adapter from COBOL copybooks.

The COBOL datatype COMDP, in the table is an abbreviation for, and synonymous
with, COMPUTATIONAL. Square brackets ([ ]) denote optional qualifiers for some
COBOL compilers, which may not be allowed for other COBOL compilers.

Table B-3 Datatype Mapping: COBOL and Oracle Connect for IMS/DB

COBOL Datatype Xsd Datatype
BINARY (with fractional data) string
BINARY (without fractional data) int
COMP (with fractional data) string
COMP (without fractional data) int
COMP-2 double
COMP-3 string
COMP-4 (with fractional data) string
COMP-4 (without fractional data) int
COMP-5 (with fractional data) string
COMP-5 (without fractional data) int
COMP-X (with fractional data) string
COMP-X (without fractional data) int
INDEX int
[SIGN [IS]] LEADING string
[SIGN [IS]] LEADING SEPARATE [CHARACTER] string
NATIVE-2 int
NATIVE-4 int
NATIVE-8 string
PACKED-DECIMAL string
POINTER int
[SIGN [IS]] TRAILING string
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Table B-3 (Cont.) Datatype Mapping: COBOL and Oracle Connect for IMS/DB
COBOL Datatype Xsd Datatype
[SIGN [IS]] TRAILING SEPARATE [CHARACTER] string
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Supported SQL Syntax and SQL
Enhancements

The Oracle Application Server Integration Adapter for IMS/DB provides basic
support for standard ANSI '92 SQL along with a number of enhancements, all of

which can be used when specifying adapter interactions. This appendix contains the
following sections:

= Supported SQL Statements
= Supported Operators
= Supported Functions

s SQL Enhancements
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Supported SQL Statements

The Oracle Application Server Integration Adapter for IMS/DB provides full
support for SELECT, DELETE, INSERT, and UPDATE statements, when specified in
interactions.

Supported Operators

The Oracle Application Server Integration Adapter for IMS/DB enables the use of
the following operators in SQL statements:

= Arithmetic Operators

= Comparison Operators

Table C-1  Arithmetic Operators

Operator

+

*

/

Table C-2 Comparison Operators

Operator

>

<

>=

<=

<>, 1=, A=
ISNOT NULL
ISNULL
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Supported Functions

The Oracle Application Server Integration Adapter for IMS/DB enables the use of
the following functions in SQL statements:

= String Functions

= Group Functions

" Mathematical Functions

Table C-3 String Functions

Oracle Oracle Connect

Function Function Usage Comment

[ [ strl | | str2 Returns a string consisting of str1 concatenated with str2

Ascii Ascii Ascii(c) Returns the ASCII value of ¢

Chr Chr Chr(ascii) Returns the character corresponding to the given ASCII value

Instr Position Position(str2, strl) Returns an index in str2 to the first occurrence of str1 in str2

Length Length Length(str) Returns the number of bytes of str

Lower Lower Lower(str) Returns str in lowercase

Lpad Lpad Lpad(str, n) Returns str with n leading blanks

Ltrim Ltrim Ltrim(str) Returns str with leading blanks removed

Rpad Rpad Rpad(str, n) Returns str with n trailing blanks

Rtrim Rtrim Rtrim(str) Returns str with trailing blanks removed

Substr Substr Substr(str, n [, m]) Returns a substring of str, starting with the nth character and
m characters in length, or until the end of the string if m is not
supplied

Upper Upper Upper(str) Returns str in uppercase

Table C-4 Group Functions

Oracle Oracle Connect

Function Function Usage Comment

Avg Avg Avg(exp) Returns the average value of the expression exp

Count Count Count(exp) Returns the count of the expression exp
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Table C-4 (Cont.) Group Functions

Oracle Oracle Connect

Function Function Usage Comment

Max Max Max(exp) Returns the maximum value of the expression exp
Min Min Min(exp) Returns the minimum value of the expression exp
Sum Sum Sum(exp) Returns the summation of the expression exp

Table C-5 Mathematical Functions

Oracle Oracle Connect

Function Function Usage Comment

Abs Abs Abs(n) Returns the absolute value of n

Ceil Ceil Ceil(n) Returns n rounded up to the closest integer
Cos Cos Cos(n) Returns the cosine value of n

Exp Exp Exp(n) Returns the exponential value of n

Floor Floor Floor(n) Returns n rounded down to the closest integer
Ln Ln Ln(n) Returns the natural log value of n

Log Log Log(n) Returns the log value of n

Mod Mod Mod(n, m) Returns the integer value after dividing n by m
Nvl Nvl Nvl(exp1, exp2) Returns exp2 when exp1 is null

Power Power Power(n, m) Returns 1 to the power of m

Round Round Round(n, m) Returns n with the fractional part rounded to m digits
Sin Sin Sin(n) Returns the sine value of

Sqrt Sqrt Sqrt(n) Returns the square root of n

Tan Tan Tan(n) Returns the tangent value of n

Trunc Trunc Trunc(n, m) Returns the absolute value of n

SQL Enhancements

You can incorporate the following SQL enhancements into the adapter interactions
to handle hierarchical data in IMS/DB.

= Generating Hierarchical Results
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»  Accessing Hierarchical Data Using SQL
»  Flattening Hierarchical Data Using SQL

Generating Hierarchical Results

A hierarchical query nests a SELECT statement as one of the columns of the rowset
retrieved by a nested SELECT statement.

Use braces ({}) to delimit the nesting.

Accessing Hierarchical Data Using SQL

Data stored hierarchically in a IMS/DB data source can be referenced by using a
hyphen followed by a right arrow (->) to denote the parent child relationship in the
source:

FROM ... parent_name->child1->child2... [alias]
Or, using an alias for the parent table:

FROM ... parent_alias->child1->child2... [alias]

Flattening Hierarchical Data Using SQL

You can produce a flattened view of hierarchical data by embedding a SELECT
statement inside the list of columns to be retrieved by another SELECT statement.
You use parentheses to delimit the nesting. The nested SELECT statement can
reference a child rowset (using the parent->child syntax) only in its FROM clause.

Using an Alias

To list the hierarchical data with the parent data only, you must use an alias for the
child data.

Note: Without an alias the query lists, for each parent row, all of
the children of all of the parent rows.
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Daemon Configuration Settings

The daemon runs on the OS/390 machine and is responsible for allocating a server
process for a client. The daemon resides in a single address space and is executed as
a started task. When started, the daemon loads configuration settings such as
various operational parameters as well as the list of workspaces accessible through
the daemon.

The daemon configuration is managed using Oracle Studio. Daemon configuration
is divided into the following groups:

This appendix contains the following sections:
= Daemon Control

= Daemon Logging

= Daemon Security

= Workspaces
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Daemon Control

The Daemon Control section specifies various control options.

The Daemon Control section is accessed as follows:

1.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

Right-click the machine and choose Open Runtime Perspective.

Right-click the daemon in the Runtime Explorer and choose Edit Daemon
Configuration. The Daemon Control tab opens.

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change daemon settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Right-click the daemon and
choose Edit Daemon.

Changes made to the daemon configuration are only implemented
after the configuration is reloaded using the Reload Configuration
option in the Runtime Manager.
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—General

[~ Automatically recaver from Failure  Maximurn %ML request size: I 65654 ﬁ

Maimum XML in memory: |65654 :I Default language: I 'l

r—Timeout parameters

Call tirmeout: |6U :I Conneck bimeout: ISU :I Clignt idle timeout: IU :I

r—Manikoring
Iaximumm number of blocks: I 100 :I Maximum number of messages stored in a single block: | 100 :I

Daemon Conkrol ]Daemon Logging |Daemon Security |Source

The following fields are displayed:

Automatically recover from failure - The daemon restarts automatically if it fails
for any reason (any error that causes the daemon process to terminate, such as
network process lost or the CPU running the daemon crashes and the backup
daemon is defined on another CPU). All available and unconnected servers are
terminated and any connected servers are marked and terminated on release. Also

the backup starts a backup for itself.

The backup appends a new log file to the log of the original daemon, adding a line

indicating that a backup daemon was started.

Maximum XML request size - The maximum number of bytes that the daemon

handles for an XML document.

Maximum XML in memory - The maximum amount of space reserved for the XML

in memory.

Default language - The language that the daemon supports. This setting is used
when working with a client with a code page different from the server code page.

Call timeout - The timeout period for short calls for all daemons. The definition of a
short call is a call that should be completed in a few seconds. For example, most
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calls to a database such as DESCRIBE should be completed in a few seconds as
opposed to call like a GETROWS call, which can take a long time. In heavily loaded
or otherwise slow systems, even short calls such as calls to open a file, may take a
significant amount of time. If a short call takes more than the specified time to
complete, the connection is aborted. The default value for this parameter is 60
seconds. Values of less than 60 seconds are considered to be 60 seconds.

Specifying the timeout in a workspace overrides the value set in this field for that
workspace.

Connect timeout - The time the client waits for a daemon server to start. If the
daemon server does not start within this period, the client is notified that the server
did not respond. The value specified for this parameter serves as the default
timeout for all the workspaces listed in the daemon configuration. The default value
for this parameter is 60 seconds.

Specifying the timeout in a workspace overrides the value set in this field for that
workspace.

Client idle timeout - The maximum amount of time any daemon client may be idle
before the connection with the server is closed.

Specifying the timeout in a Workspace overrides this setting for that workspace.

Daemon Logging

The Daemon Logging section defines the daemon log file settings, the log file
structure and the location where the log is saved. In addition it defines the data that
is logged and traced in the file.

Note: By default the log entries are written to SYSOUT for the
daemon process.

The Daemon Logging section is accessed as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

3. Right-click the machine and choose Open Runtime Perspective.
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4. Right-click the daemon in the Runtime Explorer and choose Edit Daemon
Configuration.

5. Choose the Daemon Logging tab.

6. After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change daemon settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Right-click the daemon and
choose Edit Daemon.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.

Daeman log file location:

—Logging options

[T Client regquests for server I Daemon RPC Function calls

[~ administration requests For Daemaon ™ Daemon inkernal operations
W Daemon operations [ Trace infarmation

[ Daemon logins ™ Display host and darnain name

—Trace options

[ Mo timeout " Extended RPC trace
[ calltrace I Svstem trace

[~ RPC trace r Timing

™ Sockets

Server |og filename Format:

Diaemaon Conkrol lDaemon Logging IDaemon Security |Source

The following fields are displayed:
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Daemon log file location - Where the daemon produces its log data if you want the
data written to a file instead of SYSOUT for the daemon process. The full path must
be specified.

Logging options - Specifies what tracing is performed.

Client requests for server - Logs client requests for server activations; this
provides logging of the process IDs of the started servers along with the
location of the log files.

Administration requests for daemon - Logs all of the administration requests
for the daemon.

Daemon operations - Logs all of the daemon operations.
Daemon logins - Logs daemon logins.

Daemon RPC function calls - Log all daemon RPC function calls.
Daemon internal operations - Log daemon internal operations.
Log trace information - Logs low-level RPC operations.

Display host and client domain name - Whether the client host and domain
name are logged rather than the client IP address. The default is false.

Trace options - Specifies what tracing is performed.

No timeout - Disables the standard RPC timeouts, setting them to a long
duration (approximately an hour) to facilitate debugging.

Call trace - Generates a message in the server log file for each RPC function
called. This is useful for troubleshooting the server.

RPC trace - Enables debugging messages on the server.
Sockets - Generates a message in the server log file for each socket operation.

Extended RPC trace - Generates a verbose message in the server log file for
each low-level RPC function called. This is useful for troubleshooting the server.

System trace - Generates system-specific tracing of various operations.

Timing - Generates a timestamp for every entry to the server log file.

Server log filename format - The name of the server log file if you want the data
written to a file instead of SYSOUT for the server process.

The following tokens can appear in the log file template and will be replaced
accordingly:
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%A - workspace name
%D - date (yymmdd)
%I - instance number of the given workspace server

%L - the path to INSTROOT . TMP. If you specify a file name without this path, the
file is created under INSTROOT. TMP . £11ename, where INSTROOT is the high-level
qualifier where Oracle Connect for IMS/DB is installed.

%P - server's process ID
%T - time (hhmmss)
%U - server's account name (username)

For example, a log file template $L . ATTSRVR%I can produce a log file such as:
INSTROOT.TMP.ATTSRVR5, where INSTROOT is the high-level qualifier where
Oracle Connect for IMS/DB is installed.

Daemon Security
The Daemon Security section is used for the following;:
» To grant administration rights for the daemon
= To determine access to the machine
The Daemon Security section is accessed as follows:

1.  On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

3. Right-click the machine and choose Open Runtime Perspective.

4. Right-click the daemon in the Runtime Explorer and choose Edit Daemon
Configuration.

5. Choose the Daemon Security tab.

6. After making changes to the daemon, right-click the daemon and choose
Reload Configuration.
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Note: You can also change daemon settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Right-click the daemon and
choose Edit Daemon.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.

— Administrator privileges
* allusers

" Selected users only

Add|user |
Add group |
Rename |
Remaove |

—Machine access
V' allows anorymous login W Cached passward

Encryption methods I *

Daemon Conkrol |Daemon Logging IDaemon Security ]Source

The following fields are displayed:

Administrators privileges - Identifies the users (accounts) allowed to perform
administrative tasks (tasks that require administrative login).

All users - Anyone can access the daemon and change the settings.

Selected users only - The names of users (accounts) and groups that can be
administrators.'
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Note: If a user is not specified, the account from which the
daemon was started is considered the administrator. Note that the
daemon does not require the user to log in to the account on the
system, but to log in to the daemon using the account name and
password.

Machine access - Manages access to the machine.

Workspaces

Anonymous login allowed - Whether workspaces allow anonymous logins
(without user name/password entries). For the optimal level of security, keep
this option unchecked and define a username for the Daemon Administrators
parameter.

If unchecked, no workspace can have an anonymous client. If checked, a
particular workspace allows anonymous clients.

Cached passwords - Enables login passwords to be cached. This enhances
performance by reducing login times for future connections from the same
client in a session.

Encryption methods - The encryption method being used to send information
across the network. The default is an asterisk (*), meaning that all methods are
acceptable. If an encryption method is specified, it must be used. The RC4 and
DES3 protocols are currently supported.

A daemon can include a number of workspaces. A workspace defines the server
processes and environment that are used for the communication between the client
and the server machine for the duration of the client request. Each workspace has
its own definition. The workspace definition is divided into the following groups:

WS Info.
WS Server
WS Logging
WS Security

1 The name is prefixed with '@, to utilize the operating system GROUP feature.
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WS Info.

WS Governing

Warning: You must not delete the Navigator workspace.

Using WS Info. you specify the features that control the operation of the
workspace: the server type, the command procedure used to start the workspace
and the binding configuration associated with this workspace.

The WS Info. section is accessed as follows:

1.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

Right-click the machine and choose Open Runtime Perspective.
Drill-down the daemon to display the workspaces in the Runtime Explorer.

Right-click the workspace and choose Edit Workspace Configuration. The WS
Info. tab opens.

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change workspace settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit
Workspace.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.
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Workspace name: | MAYVIGATOR
Description: Cracle Conneck Server ;I
-
< v
Startup scripk: | ATTSRYR.AY
Server bype: Inative

Lef Lef

“Workspace binding name: I

“Workspace database name: I

Clignt idle timeout: IU :I Conneck bimeout: |6U :I

|'Timeout paramekters

Diaemaon Conkrol |Daem0n Logging |Daem0n Security lWS Infa. JWS Server |WS Logging |WS Security |WS Governing |Source

The following fields are displayed:

Workspace name - The name used to identify the workspace.

Note: The default configuration includes the default Navigator
Workspace. This workspace is automatically used if a workspace is
not specified as part of the connection settings.

Description - A description of the workspace.

Startup script - The full pathname of the script that starts the workspace server
processes. The script specified here must always activate the nav_login procedure
and then run the server program (svc). If you do not specify the directory, the
startup procedure is taken from the directory where the daemon resides. Oracle
Connect for IMS/DB includes a default startup script, which it is recommended to
use.

Specify only the script name, since the server is activated as a started task.
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WS Server

Note: The installation includes a default startup script: ATTSRVR.

Server type - For internal use only.
Workspace binding name - For internal use only.

Timeout parameters - The time the client waits for the workspace server to start. If
the workspace server does not start within this period, the client is notified that the
server did not respond. Specifying the timeout here overrides the default setting,
specified in the Control section.

See Also: "Daemon Control" on page D-2 for details about the
Control section

Client idle timeout - The maximum amount of time a workspace client can be
idle before the connection with the server is closed.

Connect timeout - The time the client waits for a workspace server to start. If
the workspace server does not start within this period, the client is notified that
the server did not respond. The value specified for this parameter serves as the
default timeout for all the workspaces listed in the daemon configuration. The
default value for this parameter is 60 seconds.

Using WS Server, you specify the features that control the operation of the servers
started up by the workspace and allocated to clients. For example, you can
configure the workspace to start up a number of servers for future use, prior to any
client request, instead of starting each server when a request is received from a
client.

The WS Server section is accessed as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

3. Right-click the machine and choose Open Runtime Perspective.
4. Dirill-down the daemon to display the workspaces in the Runtime Explorer.

5. Right-click the workspace and choose Edit Workspace Configuration.
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6. Choose the WS Server tab.

7. After making changes to the daemon, right-click the daemon and choose

Reload Configuration.

Note:

You can also change workspace settings in the using the

Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit

Workspace.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime

Manager.

Workspace server mode

—Reuse limit
" None

% Maximurn: I 20 j

Clients per server limit
% None

£ Maximunn: I 0 j

—Server availability

[~ Set maximum rumber of servers: I a ﬂ

Initial number of servers: I 1 :I Minirmurm number of available servers: IU :’

—Resource limitations

Mumber of sub-tasks {05390 specific): I 1] ﬁ
2

[ Limit number of active servers:

—Server priority
{* Use default priority

' Use priority specified: ID ﬂ

Daemon Conkrol |Daemon Logging |Daemon Security |WS Infa. lWS Server ]WS Logging |WS Security |WS Governing |Source

The following fields are displayed:

Workspace server mode - The type of new server processes that the daemon starts
up. The daemon supports the following server modes:
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Single client - Each client receives a dedicated server process. The account in
which a server process runs is determined either by the client login information
or by the specific server workspace.

This mode enables servers to run under a particular user account and isolates
clients from each other (since each receives its own process). However, this
server mode incurs a high overhead due to process startup times and can use a
lot of server resources (since it requires as many server processes as concurrent
clients).

Multi-client - Clients share a server process and are processed serially. This
mode has low overhead since the server processes are already initialized.
However, because clients share the same process, they can impact one another,
especially if they issue lengthy queries.

The number of clients that share a process is determined by the "Clients per
server limit" field.

Multi-threaded - For internal use only.

Reusable - An extension of single-client mode. Once the client processing
finishes, the server process does not die and can be used by another client,
reducing startup times and application startup overhead.

This mode does not have the high overhead of single-client mode since the
servers are already initialized. However, this server mode can use a lot of server
resources (since it requires as many server processes as concurrent clients).

Note: The other modes can be set so that the server processes are
reusable. The number of times a process can be reused is controlled
by the Reuse limit field value.

Reuse limit - The maximum number of times a particular server can be reused. A
one-client server can be reused after its (single) client has disconnected. Reuse of
servers enhances startup performance because it avoids the need to repeat
initialization. The default for this field is none (0), indicating that server reuse is
unlimited. This parameter is enabled only if the server mode value is
Multi-client or reusable.

Clients per server limit - The maximum number of clients a server process for the
current workspace accepts. The default for this field is none (0), indicating that the
number of clients per server is unlimited. This field is enabled only if the server
mode valueis Multi-client.
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Server availability

Initial number of servers - The number of server processes that are prestarted
for this workspace when the daemon starts up. When the number of available
server processes drops below the value specified in the Minimum number field
(see below), the daemon again starts server processes until this number of
available server processes is reached. The default for this field is 0.

Minimum number - The minimum number of server processes in the
prestarted pool before the daemon resumes creating new server processes (to
the value specified in the Initial number of servers field). If this field is set to a
value higher than the Initial number of servers field, the daemon uses the
value specified in the Initial number of servers field. The default for this field
is 0.

Set maximum number of servers - The maximum number of available server
processes. Once this number is reached, no new nonactive server processes are
created for the particular workspace. For example, if a number of server
processes are released at the same time, so that there are more available server
processes than specified by this field, the additional server processes above this
value are terminated. The default for this field is 0, meaning that there is no
maximum.

Resource limitations

Number of subtasks - The number of subtasks for a server that are prestarted
for this workspace when the daemon starts up. Thus, setting 10 prestarted
servers and 10 subtasks results in 100 tasks started (10 subtasks for each
process).

Limit number of active servers - The maximum number of active server
processes (either available or in use). Once reached, no new server processes
will be created for the particular workspace and client connections would be
rejected if there is no available server to accept them. Once the number of active
servers drops below the maximum (for example, a client disconnects from a
server and the server terminates), new servers can again be started. If the value
of this field is set to a nonzero value lower than the value for the Initial number
of servers field, the daemon assumes it is set to the same value as the Initial
number of servers field. The default for this field is 0, meaning that no
maximum is enforced.

Server Priority - The priority for servers. For example, a workspace for applications
with online transaction processing can be assigned a higher priority than a
workspace that requires only query processing.
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Use default priority - Sets the priority as 0. There is no specific priority for this
workspace.

Use priority - Enables setting the priority.

WS Logging

Using WS Logging you specify parameters to log that occur with the workspace
server process.

The WS Logging section is accessed as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

Right-click the machine and choose Open Runtime Perspective.
Drill-down the daemon to display the workspaces in the Runtime Explorer.
Right-click the workspace and choose Edit Workspace Configuration.
Choose the WS Logging tab.

N o a 0

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change workspace settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit
Workspace.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.
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Trace options

[ Mo timeout ™ Extended RPC trace
[T Calltrace I Syskem trace

l_ RPC trace |_ Timing

™ sockets

Diaemaon Conkrol |Daem0n Logging |Daem0n Security |WS Infa. |WS Server | WS Logging | WS Security |WS Governing |Source

The following fields are displayed:
Trace options - Specifies what tracing is performed.

No timeout - Disables the standard RPC timeouts, setting them to a long
duration (approximately an hour) to facilitate debugging.

Call trace - Generates a message in the server log file for each RPC function
called. This is useful for troubleshooting the server.

RPC trace - Enables debugging messages on the server.

Sockets - Generates a message in the server log file for each socket operation.
This is useful for troubleshooting client/server communication - providing a
detailed trace of every client/server communication.

Extended RPC trace - Generates a verbose message in the server log file for
each low-level RPC function called. This is useful for troubleshooting the server.

System trace - Generates operating system-specific tracing.
Timing - Generates a timestamp for every entry to the server log file.

Specific log file format - Defines the name and location of the server log file if you
want the data written to a file instead of SYSOUT for the server process. The
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parameter must specify the full pathname. If no directory information is provided
for the log file, it will be located in the login directory of the account running the
server.

The following tokens can appear in the log file template and will be replaced
accordingly:

%A - workspace name
%D - date (yymmdd)
%I - instance number of the given workspace server

%L - the path to INSTROOT . TMP. If you specify a file name without this path, the
file is created under INSTROOT. TMP . filename, where INSTROOT is the high-level
qualifier where Oracle Connect for IMS/DB is installed.

%P - server's process ID
%T - time (hhmmss)

%U - server's account name (username)

Note: Unless this parameter is specified, the log entries are
written to SYSOUT for the job specified in the Workspace startup
parameter.

WS Security

Using WS Security you specify the level of security at the workspace level, as
opposed to the daemon level, which is set in the Security section of the daemon.

See Also: For details about the Security section, see "Daemon
Security” on page D-7

The WS Security section is used for the following:

= To grant administration rights for the workspace

= To determine access to the workspace by a client

The WS Security section is accessed as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.
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N o a 0

Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

Right-click the machine and choose Open Runtime Perspective.
Drill-down the daemon to display the workspaces in the Runtime Explorer.
Right-click the workspace and choose Edit Workspace Configuration.
Choose the WS Security tab.

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change workspace settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit
Workspace.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.
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—'wWorkspace access

—Workspace users
% pll users

' Selected users only

fdd user |
Add group |
Rename |
Remaye |

™ Enable port range

Franm park I 1]
Tio port I 1]

V¥ Use specific workspace account

‘Waorkspace account I default

¥ allow anonymous client login to server account

Anonymous dient account I default

— Administration

% pll users

' Selected users only

— Administrakor privileges for the workspace

Add user: |
Add group |
Fename |
Remaove |

v aliow lisking

Diaemaon Conkrol |Daem0n Logging |Daem0n Security |WS Infa. |WS Server |WS Logging | WS Security | WS Governing |Source

The following fields are displayed:

Administration - Identifies the users (accounts) allowed to perform administrative
tasks (tasks that require administrative login) on this workspace. For example, a
user with administrative rights to a workspace can refresh the specific workspace
servers using the IRPCD command with the Refresh workspace option.

Administrator privileges - Identifies the users (accounts) allowed to perform
administrative tasks to the workspace (tasks that require administrative login).

All users - Anyone can access the workspace and change the settings.

Selected users only - The names of users (accounts) and groups that can be
administrators.

2

2 The name is prefixed with '@, to utilize the operating system GROUP feature.
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Note: If a user is not specified, the users specified in the
Workspace users field (see below) have administrator rights for
this workspace. In this case, if all users are allowed for the
Workspace users field, all users have administrator rights for
this workspace.

Allow Listing - Determines whether this workspace appears in the list of
workspaces.

Workspace access - Defines the users (accounts) allowed to access this workspace.

Workspace users - Lists the users who are allowed to use the workspace (after
logging on). If All users is specified, any user who has logged on to the daemon
can use the workspace.

All users - Any user who has logged on to the daemon can use the
workspace.

Selected users only - The names of users (accounts) and groups that can
use the workspace.?

Note: If a user is not specified, any user who has logged on to the
daemon can use the workspace.

Enable ports range - The firewall ports through which you access the
workspace. Specifies the range of ports available for this workspace when
starting server processes. Use this option when you want to control the port
number, so that Oracle Connect for IMS/DB can be accessed through a firewall.

Use specific workspace account - The operating system account used for the
workspace. If not specified, the account name that was provided by the client is
used.

Allow anonymous client login to server account - Whether this workspace can
be invoked without authentication (user name/password). If anonymous login
is allowed, specify the server account name to use. If this field is not specified,
the value in the Workspace account field is used.

3 The name is prefixed with '@, to utilize the operating system GROUP feature.
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WS Governing

Using WS Governing you manage the way queries are executed. Since query
governing parameters are defined at the workspace level, the restrictions apply to
all queries.

The WS Governing section is accessed as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for IMS/DB" on
page 2-21.

Right-click the machine and choose Open Runtime Perspective.
Drill-down the daemon to display the workspaces in the Runtime Explorer.
Right-click the workspace and choose Edit Workspace Configuration.
Choose the WS Governing tab.

N o g e

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change workspace settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit
Workspace.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.
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Query governing reskrictions

IMax number of rows in a table that can be read I a ﬁ
Max number of rows allowed in a table before scan is rejected I o ﬂ

Diaemaon Conkrol |Daem0n Logging |Daem0n Security |WS Infa. |WS Server |WS Logging |WS Security WS Governing | Source

The following fields are displayed:

Max Number of Row in a Table That Can Be Read Parameter - Restricts the
number of table rows that are read in a query. When the number of rows read from
a table exceeds the number stated, the query returns an error.

Max Number of Rows Allowed in a Table Before Scan is Rejected Parameter -
Restricts the number of table rows that can be scanned. This parameter impacts on
the query booth during query optimization and execution.

During Query Optimization the value set is compared to the table cardinality. If
the table cardinality is greater than the restriction the scan strategy is ignored as
a possible strategy, unless it is the only available strategy.

During Query Execution a scan is limited to the value set. When the number of
rows scanned exceeds the number stated, the query returns an error.
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Note: You must refresh the daemon as well as reloading the
configuration after changing the values in the WS Governing tab.
The daemon configuration is reloaded by right-clicking the daemon
in the Oracle Studio Runtime perspective and choosing Reload
Configuration. Servers not in use are refreshed by right-clicking the
daemon workspace in the Oracle Studio Runtime perspective and
choosing End Unused Servers.
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COBOL APIs to Applications

The Oracle Application Server Integration Adapter for IMS/DB includes a set of
APIs that enable sending a native event as an inbound interaction from a COBOL
program.

To use the APIs, you must include the following in the COBOL program:

s The ACXAINIT function - This function loads the API functions. The function
does not have any parameters.

s Under CICS, link the COBOL program with the stub
INSTROOT.FIXLIB(ACX3GL), where INSTROOT is the high-level qualifier
where Oracle Connect for IMS/DB is installed

This appendix describes the APIs and functions:
s Connection APIs

» Transaction APIs

»  The Execute Function

»  The Get Event Function

= The Ping Function

s The Get Error Function

See Also: "Sending Inbound Interactions Using a CICS
Transaction" on page 5-4 for details of how to use a CICS
transaction that calls the APIs instead of using the APIs or "Sending
Inbound Interactions Using an IMS/TM Transaction" on page 5-10
for details of how to use an IMSTM transaction that calls the APIs
instead of using the APIs
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Connection APIs

Connection APIs

The following functions handle the connection and connection context for an
inbound interaction:

s The Connect Function
s The Disconnect Function
There are two kinds of connections:

Transient Connection - Transient connections are created for use within a single
inbound interaction. A transient connection is disconnected when an inbound
interaction ends, or when the connection context changes (that is, with the
connect, setConnection or disconnect functions).

Persistent Connection - Persistent connections can persist across multiple inbound
interactions or connection context changes. Persistent connections are disconnected
upon an explicit disconnect function or when a connection idle timeout expires.

The Connect Function

The Connect function establishes a new connection context. All the interactions
defined take place within a connection context.

Upon a successful connect, a connection context is established and an implicit
setConnection is performed with the newly created connection ID. A failed
connect function leaves the inbound interaction with no connection context (that
is, if a connection context was established prior to invoking the connect function,
that connection context will no longer be in effect).

The function returns an integer of 1 (TRUE) or 0 (FALSE), to determine the success
of the function.

Syntax

ACXACNCT using ServersUrls Username Password Workspace AdapterName Persistent IdleTimeout
ConnectMode DefinitionFileName KeyName KeyValue ConnectHandle
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Table E-1 ACXACNCT Parameters

Parameter

Usage

Description

ServersUrls

Username
Password

Workspace

AdapterName

Persistent

IdleTimeout

ConnectMode

Input

Input
Input
Input

Input

Input

Input

Input

DefinitionFileName Input

The address of the server being connected to in the format:
server_name:port.

Or:

TCP/IP_address:port.

A series of servers, separated by commas, can be specified.
The connection is made to the first server, in the list, that is up

The username required by the adapter
The user password required by the adapter

Optional. The name of the workspace where the adapter
associated to the connection runs. The default workspace is
Navigator

The name of the adapter to connect to

To supply the adapter schema as a parameter for the
ACXACNCT call, build an ESDS VSAM file, which holds the
adapter definition. Insert the schema into this VSAM file

You can insert the schema into the VSAM file by creating a
table with one column with a datatype of char X and use an
INSERT INTO SQL statement to enter the data

Persistent connection indication. If true, a persistent
connection is created. Otherwise a transient connection is
created. The defaultis false.

A per-connection client idle timeout setting (in seconds). If the
client does not use the connection for the specified amount of
time, the connection is disconnected by the server and its
associated resources released. This setting is limited by the
server side maximum idle connection timeout setting

The mode of the connection:
0 - Immediate connection

1 - Deferred connection - the connection is made when the
execute function is performed

The name and path of the local definition used for the adapter.
If omitted, the API queries the underlying adapter for the
metadata

This parameter should be specified, when the adapter is
remote
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Table E-1 (Cont.) ACXACNCT Parameters

Parameter Usage Description

KeyName Input  The name of the encryption key

KeyValue Input  The value associated with the encryption key
ConnectHandle Output A pointer to the connection. A pointer is always returned

when the connection fails. This enables calling the getError
function to determine what caused the error

The Disconnect function must always be called to clear the
connection handle

The Disconnect Function

The Disconnect function destroys the current connection context. All the
resources associated with the current connection (persistent or transient) are
released.

Syntax
ACXADSCO using ConnectHandle

Table E-2 ACXADSCO Parameters

Parameter Usage Description

ConnectHandle  Input A pointer to the connection

Transaction APIs
Transaction APIs are used in the following scenarios:

Non-transacted operation - The adapter works in auto-commit mode. Work is
committed immediately and automatically upon execution. This operation mode is
the default operation mode when no transaction APIs are used, or when the
setAutoCommit function sets auto-commit to true.

Local transaction operation - When auto-commit is set to false, the first interaction
starts a transaction that lasts until an explicit commit (using the
transactionCommit function) or an explicit rollback (using the
transactionRollback function) occurs. All interactions performed in between
are part of that transaction.
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Note: 'local'is used here to indicate the scope of the transaction,
rather than its location: the local transaction may be running on a

remote machine.

The following functions handle transaction operations:

s The Set Autocommit Function

s The Transaction Commit Function

s The Transaction Rollback Function

The Set Autocommit Function

The Set Autocommit function sets the auto-commit mode of the connection.

Syntax

ACXASCMT using ConnectHandle AutoCommit

Table E-3 ACXASCMT Parameters

Parameter Usage

Description

ConnectHandle  Input

AutoCommit Input

A pointer to the connection.

New auto-commit mode of the connection. If set to true, each
interaction immediately commits once executed. The
auto-commit mode must be turned off if multiple interactions
need to be grouped into a single transaction and committed or
rolled back as a unit

When auto-commit is reset and no global transaction is in
progress, any interaction starts a local transaction. The client is
required to use transactionCommit or transactionRollback at
the appropriate time to commit or rollback the transaction

The auto-commit mode is true by default and is reset if a
distributed (global) transaction is started

The Transaction Commit Function

The Transaction Commit function commits the work done under the global or

local transaction.
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The Execute Function

Syntax
ACXACMIT using ConnectHandle Xid

Table E-4 ACXACMIT Parameters

Parameter Usage Description
ConnectHandle  Input A pointer to the connection.
Xid Input For internal use only. Supply an empty value

The Transaction Rollback Function

The Transaction Rollback function rolls back the work done under the
(global) transaction.

Syntax
ACXARBCK using ConnectHandle Xid

Table E-5 ACXARBCK Parameters

Parameter Usage Description
ConnectHandle  Input A pointer to the connection
Xid Input For internal use only. Supply an empty value

The Execute Function

The Execute function executes a given interaction against the application. The
function supplies the input record that is required by the application.

Syntax
ACXAEXEC using ConnectHandle InterationName Bufferln BufferOut BufferOutLen

Table E-6 ACXAEXEC Parameters

Parameter Usage Description

ConnectHandle  Input A pointer to the connection
InteractionName Input Name of interaction to execute

BufferIn Input A pointer to the input record

BufferOut Output  For internal use only. Supply an empty value
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Table E-6 (Cont.) ACXAEXEC Parameters

Parameter Usage Description

BufferOutLen Output  For internal use only. Supply an empty value

The Get Event Function

The Get Event function determines the event to wait for and how long to wait.
When an event is received, the function returns the results of performing the event.

Syntax
ACXAGTEYV using ConnectHandle EventName Wait Keep BufferOut BufferOutLen

Table E-7 ACXAGTEYV Parameters

Parameter Usage Description

ConnectHandle  Input A pointer to the connection

EventName Input Name of event to wait for

Wait Input Length of time to wait to receive the event, in seconds
Keep Input Whether the event should be stored in the repository or

deleted once finished. The default is false (to delete the event)
BufferOut Output A pointer to the output record
BufferOutLen Output  The length of the output record

The Ping Function

The Ping function returns, in a pingResponse response, information about an
active adapter.

Syntax
ACXAPING using ConnectHandle OutputStruct

Table E-8 ACXAPING Parameters

Parameter Usage Description
ConnectHandle  Input A pointer to the connection
OutputStruct Output  The return information describing the structure of the adapter
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The Get Error Function

The Get Error function returns error information.

Syntax
ACXAGTER using ConnectHandle Error Status

Table E-9 ACXAGTER Parameters

Parameter Usage Description

ConnectHandle Input A pointer to the connection

Error Output  The error message returned by the function
Status Output  The status of the returned error
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National Language Settings

National Language Support (NLS) is provided by the Oracle Application Server
Integration Adapter for IMS/DB for the following languages:

Arabic

English (the default)
Hebrew

Japanese

Korean

Simple Chinese
Spanish

Traditional Chinese

This appendix describes how to set up language support.
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Defining the Language and Codepage

1.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

Select the machine defined in "Configuring Oracle Connect for IMS/DB" on

page 2-21.

Right-click the NAV binding node and Choose Edit Binding.

In the Binding Properties tab, click the + next to the misc node.

@Eonﬁguration - Oracle Studio for Legacy adapters
File Edit - Search ‘Window Help

=10l x|

| -|HR&] ¥

ﬁ ﬁ' Configuration Explorer = E X ]
@ ED Machines
El@ 05350 Cakegory: IAII 'l
=7 Bindings
EE MaY —Environment propetties
EI Daemans
B Users
= Propetk | Yalue |
comm
debug
=l rise
codepage
cvkSeverityLevel i}
edit
_
nlsstring Restore field |
tempDir Restore all |
wearZ2000Policy 5
odbc Create Environment |
oledb
aptimizer St koA,
queryProcessar
kransackions
[ Properties 5 :%:D @ x [+ turing
Propert | Yalue
Mame Y
Path {05390\ bindings kA
Warkspace MNAYIGATOR
Properties |Machines |Source

ARA - Arabic
ENG - English
HEB - Hebrew

Enter a valid value for the language. The following language codes are valid:
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JPN - Japanese

KOR - Korean

SCHI - Simple Chinese

SPA - Spanish

TCHI - Traditional Chinese

Optionally, in the codepage field, specify the codepage required.

You can skip this step, and just specify a language (see the previous step). In
this case, a default codepage is used. The following shows the default
codepages:

ARA - AR8ISO8859P6

ENG - EBCDIC

HEB - IWS8EBCDIC424

JPN - JA1616DBCS

KOR - KO16DBCS

SCHI - ZHS16DBCS

SPA - WESEBCDICLATIN

TCHI - ZHT16DBCS

The following table lists the supported codepages according to language:

Table F-1 Supported Codepages

Language Supported Codepage Values Description

Arabic ARBSISO8859P6 ISO 8859-6 Arabic (ASCII)

English EBCDIC -

English D8EBCDIC273 EBCDIC codepage 273 8-bit Austrian German
English DKSEBCDIC277 EBCDIC codepage 277 8-bit Danish

English SS8EBCDIC278 EBCDIC codepage 278 8-bit Swedish

English ISEBCDIC280 EBCDIC codepage 280 8-bit Italian

English WESEBCDIC285 EBCDIC codepage 285 West European
English FSEBCDIC297 EBCDIC codepage 297 8-bit French
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Table F-1 (Cont.) Supported Codepages

Language Supported Codepage Values Description
English WESEBCDIC500 EBCDIC codepage 500 West European
Hebrew IWSEBCDIC424 EBCDIC codepage 424 8-bit Latin/Hebrew (new EBCDIC)
Hebrew IWSEBCDIC806 EBCDIC codepage 806 8-bit Latin/Hebrew (old EBCDIC)
Japanese JA16DBCS IBM EBCDIC 16-bit with Latin characters
Japanese JA16EBCDIC930 IBM DBCS codepage 390 16-bit
This codepage has no encoding for lowercase Latin letters.
All resources should be defined in uppercase.
Korean KO16DBCS IBM EBCDIC 16-bit
Simple Chinese ZHS16DBCS IBM EBCDIC 16-bit Simple Chinese
Spanish WESEBCDICLATIN EBCDIC codepage with Spanish extensions
Spanish WESEBCDIC284 EBCDIC codepage 284 8-bit Latin American/Spanish

Traditional Chinese ZHT16DBCS

IBM EBCDIC 16-bit Traditional Chinese

Note: The Codepages for the European languages are based on
English being chosen as the language in the Language field.
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acxTrace parameter, 7-7
analyzerQueryPlan parameter, 7-7
application language

parameter, 7-8
arithmetic operators, C-2
arrays

flattening hierarchical data, 5-3, C-5
autocommit

setting using setAutoCommit verb, E-5

B

buffer size

comCacheBufferSize parameter, 7-7
Business Objects

qualifying catalog and tables names, 7-10

Cc

cache

max queries in, 7-10
cache memory

dsmMaxBufferSize parameter, 7-11
CD-ROM drive requirements

IBM S/390, 2-2

PC, 24
CICS

requirements, 2-3
COBOL, E-6

execute function, E-6
COBOL API

connect verb, E-2

IndeXx

disconnect verb, E-4

setAutoCommit verb, E-5

transaction verbs, E-4

transactionCommit verb, E-5

transactionRollback, E-6
codepage parameter, 7-8
comCacheBufferSize parameter, 7-7
comm parameters

comCacheBufferSize, 7-7

comMaxSocketSize, 7-7

comMaxXmlSize, 7-7
comMaxSocketSize parameter, 7-7
comMaxXmlSize parameter, 7-7
committing a transaction, E-5
comparison operators, C-2
compileAfterLoad parameter, 7-10
compiling procedures and views, 7-10
connect verb, E-2
connecting

connect verb, E-2

using COBOL, E-2
connection

destroying with disconnect, E-4
CREATE PROCEDURE statement

maximum procedures in cache memory, 7-11
cvtSeverityLevel parameter, 7-8

D

daemon
logging, D-4
security, D-7
server modes, 7-3
shutting down, 6-6
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starting, 6-5
timeout, 6-14
workspaces, 6-5
daemon configuration
logging section, D-4
security section, D-7
data source properties
disabling caching, 7-10
data type conversions
cvtSeverityLevel parameter, 7-8
data types
cvtSeverityLevel, 7-8
nlsString, 7-8
database requirements
IMS/DB, 2-3
datatypes
metadata atomic datatypes, B-2, B-11
debug environment parameters, 7-7
debug parameters
acxTrace, 7-7
analyzerqueryPlan, 7-7
generalTrace, 7-7
logFile, 7-7
oledbTrace, 7-7
optimizerTrace, 7-7
queryWarnings, 7-7
traceDir, 7-7
disconnect verb, E-4
disk space requirements
IBM S/390, 2-2
PC, 24
distributed transactions
IMS/DB, 5-16
dsmMaxBufferSize parameter, 7-11
dsmMaxSortBufferSize parameter, 7-11
dsmMidBufferSize parameter, 7-11
dsoThreadingBoth parameter, 7-10

E

edit parameter, 7-8
emptyStringIsNull parameter
queryProcessor parameters
emptyStringIsNull, 7-10
environment parameters

Index-2

acxTrace, 7-7
analyzerQueryPlan, 7-7
codepage, 7-8
comCacheBufferSize parameter, 7-7
comMaxSocketSize, 7-7
comMaxXmlSize, 7-7
cvtSeverityLevel, 7-8
debug, 7-7
dsmMaxBufferSize, 7-11
dsmMaxSortBufferSize, 7-11
dsmMidBufferSize, 7-11
dsoThreadingBoth, 7-10
edit, 7-8
emptyStringIsNull, 7-10
firstTreeExtensions, 7-10
forceQualifiedNames, 7-10
generalTrace, 7-7

goal, 79

hashBufferSize, 7-11
hashEnableParallelism, 7-11
hashMaxDiskSpace, 7-11
hashMaxOpenFiles, 7-12
ignoreSegmentBindFailure, 7-10
language, 7-8

logFile, 7-7
maxColumnsInParsing, 7-10
maxSqlCache, 7-10
miscellaneous, 7-7
nlsString, 7-8
noCommandReuse, 7-10
noCompilationCache, 7-10
noDSPropertyCache, 7-10
noHashJoin, 7-9
nolnsertParameterization, 7-10
noMarkRowFailedFetch, 7-10
noMetadataCaching, 7-10
noParallelExecution, 7-10
noQueryParametrization, 7-10
noQueryReadAhead, 7-10
noSemiJoin, 7-9
noSessionPooling, 7-10
noSQSCache, 7-10
noThreadedReadAhead, 7-10
noThreads, 7-11
noTreeAutoExtend, 7-11



odbc, 7-9
oledb, 7-9
oledbTrace, 7-7
optimisticForUpdate, 7-11
optimizer, 7-9
optimizerTrace, 7-7
parserDepth, 7-11
preferredSite, 7-9
proceduresCacheSize, 7-11
promptDbUserPassword, 7-11
queryProcessor, 7-10
queryWarnings, 7-7
semiJoinInValuesFactor, 7-9
tempDir, 7-8
tokenSize, 7-11
traceDir, 7-7
transactions, 7-11
tuning, 7-11
useAlternatequalifier, 7-11
useTableFilterExpressions, 7-11
year2000Policy, 7-8

error log
logFile parameter, 7-7

execute function, E-6

F

first row optimization

goal parameter, 7-9
firstTreeExtensions parameter, 7-10
forceQualifiedNames parameter, 7-10

G

generalTrace parameter, 7-7
goal parameter, 7-9
group functions, C-3

H

hardware requirements
IBM S/390 CD-ROM drive, 2-2
IBM S/390 disk space, 2-2
IBM S/390 memory, 2-2
IBM S/390 processor, 2-2

PC CD-ROM drive, 2-4

PC disk space, 2-4

PC memory, 2-3

PC processor, 2-3
hash disk space

hashMaxDiskSpace parameter, 7-11
hash joins

disabling, 7-9

hashMaxOpenFiles parameter, 7-12
hash memory

hashBufferSize parameter, 7-11
hashBufferSize parameter, 7-11
hashEnableParallelism parameter, 7-11
hashing

hashEnableParallelism parameter, 7-11
hashMaxDiskSpace parameter, 7-11
hashMaxOpenFiles parameter, 7-12
hierarchical queries

flattening hierarchical data, 5-3, C-5

IBM S/390

installation, 2-7

postinstallation, 2-12

preinstallation, 2-6
ignoreSegmentBindFailure parameter, 7-10
IMS/DB

requirements, 2-3

setting up, 3-2
IMS/DB driver, 5-16

distributed transactions, 5-16
IMS/TM

requirements, 2-3
index cache

dsmMidBufferSize parameter, 7-11
INSERT statement

disabling parameterization of constants, 7-10
installation

IBM S/390, 2-7
installing

Windows, 2-21
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J

joins
disabling hash joins, 7-9
hashBufferSize parameter, 7-11
hashEnableParallelism parameter, 7-11
hashMaxDiskSpace parameter, 7-11
hashMaxOpenFiles parameter, 7-12

K

known restrictions, 5-16

L

language parameter, 7-8
locking

optimistic as default, 7-11
log files

daemon options, D-4

logFile parameter, 7-7
logFile parameter, 7-7
logging

optimizer strategy, 7-7

trace information, 7-7

maxColumnsInParsing parameter, 7-10
maximum size, 7-7
maxSqlCache parameter, 7-10
memory

dsmMaxBufferSize parameter, 7-11

dsmMaxSortBufferSize parameter, 7-11
memory for index cache

dsmMidBufferSize parameter, 7-11
memory requirements

IBM S/390, 2-2

PC, 2-3
metadata

atomic datatypes, B-2, B-11

disabling retrieval from cache, 7-10
Microsoft software requirements, 2-4
miscellaneous environment parameters, 7-7
miscellaneous parameters

codepage, 7-8
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cvtSeverityLevel, 7-8
edit, 7-8

language, 7-8
nlsString, 7-8
tempDir, 7-8
year2000Policy, 7-8

multithreading

disabling, 7-11

N

NAV_UTIL

text editor, 7-8
nlsString parameter, 7-8
noCommandReuse parameter, 7-10
noCompilationCache parameter, 7-10
noDSPropertyCache parameter, 7-10
noHashJoin parameter, 7-9
nolnsertParameterization parameter, 7-10
noMarkRowFailedFetch parameter, 7-10
noMetadataCaching parameter, 7-10
noParallelExecution parameter, 7-10
noQueryParametrization parameter, 7-10
noQueryRead Ahead parameter, 7-10
noSemiJoin parameter, 7-9
noSessionPooling parameter, 7-10
noSQSCache parameter, 7-10
noThreadedReadAhead parameter, 7-10
noThreads parameter, 7-11
noTreeAutoExtend parameter, 7-11

(0]

odbc environment parameters, 7-9
oledb environment parameters, 7-9
oledbTrace parameter, 7-7
operating system requirements

IBM S/390, 2-3

PC, 24
optimisticForUpdate parameter, 7-11
optimizer environment parameters, 7-9
optimizer files

traceDir parameter, 7-7
optimizer parameters

goal, 79



noHashJoin, 7-9
noSemiJoin, 7-9
preferredSite, 7-9
semiJoinInValuesFactor, 7-9
optimizer plan
writing to file, 7-7
optimizerTrace parameter, 7-7
Oracle Application Server ProcessConnect
requirements, 2-3

P

parallel processing

disabling, 7-10
parserDepth parameter, 7-11
password

setting automatic prompt for, 7-11
pooling

disabling, 7-10
postinstallation

IBM S/390, 2-12
preferredSite parameter, 7-9
preinstallation

IBM S/390, 2-6
procedures

columns

maximum referenced in query, 7-10

maximum in cache memory, 7-11

reading from disk, 7-10

setting to compile, 7-10
proceduresCacheSize parameter, 7-11
processor requirements

IBM S/390, 2-2

PC, 23
promptDbUserPassword parameter, 7-11

Q

queries
disabling parallel processing, 7-10
disabling parameterization of constants, 7-10
disabling read-ahead functionality, 7-10
disabling reuse, 7-10
disabling saved compilation, 7-10
enabling retrieval after failure, 7-10

maximum cached in memory, 7-10
maximum length of string, 7-11
maximum size after compilation, 7-10

query optimization
goal parameter, 7-9

query optimizer
logging strategy, 7-7
writing plan to file, 7-7

query optimizer files
traceDir parameter, 7-7

queryProcessor environment parameters, 7-10

queryProcessor parameters
compileAfterLoad

environment parameters
compileAfterLoad, 7-10

dsoThreadingBoth, 7-10
firstTreeExtensions, 7-10
forceQualifiedNames, 7-10
ignoreSegmentBindFailure, 7-10
maxColumnsInParsing, 7-10
maxSqlCache, 7-10
noCommandReuse, 7-10
noCompilationCache, 7-10
noDSPropertyCache, 7-10
nolnsertParameterization, 7-10
noMarkRowFailedFetch, 7-10
noMetadataCaching, 7-10
noParallelExecution, 7-10
noQueryParametrization, 7-10
noQueryReadAhead, 7-10
noSessionPooling, 7-10
noSQSCache, 7-10
noThreadedReadAhead, 7-10
noThreads, 7-11
noTreeAutoExtend, 7-11
optimisticForUpdate, 7-11
parserDepth, 7-11
proceduresCacheSize, 7-11
promptDbUserPassword, 7-11
tokenSize, 7-11
useAlternatequalifier, 7-11
useTableFilterExpressions, 7-11

queryWarnings parameter, 7-7
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R

read-ahead functionality
disabling, 7-10

reading from disk, 7-10

requirements
IBM S/390 hardware requirements, 2-2
IBM S/390 software requirements, 2-2
PC hardware requirements, 2-3
PC software requirements, 2-4

rolling back transactions, E-6

row optimization
goal parameter, 7-9

S

security information

setting automatic prompt for, 7-11
segmented data sources

response upon failure, 7-10
semiJoinInValuesFactor parameter, 7-9
server modes

configuring, 7-3
servers

reusable, 7-4

Reuse limit daemon parameter, D-14

ReuseLimit daemon parameter, 7-4
sessions

disabling pooling, 7-10
setAutoCommit verb, E-5
SMS

system managed storage, 2-6
sockets

comMaxSocketSize parameter, 7-7
software

Microsoft products, 2-4
software requirements

CICS, 2-3

IBM S/390 operating system, 2-3

IMS/DB, 2-3

IMS/TM, 2-3

Microsoft, 2-4

Oracle Application Server ProcessConnect,

PC operating system, 2-4
sort buffer
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dsmMaxSortBufferSize parameter, 7-11
SQL

flattening hierarchical data, 5-3, C-5
stored queries

maximum in cache memory, 7-11
string functions, C-3
system managed storage

SMS, 2-6

T

tempDir parameter, 7-8
temporary files
tempDir parameter, 7-8
threading model, 7-10
timeout
clientidle, 6-14
tokenSize parameter, 7-11
TP Monitor requirements
CICS, 2-3
IMS/TM, 2-3
trace information
logging, 7-7
traceDir parameter, 7-7
transaction verbs, E-4
transactionCommit verb, E-5
transactionRollback verb, E-6
transactions
committing with transactionCommit, E-5
rolling back with transactionRollback, E-6
transactions environment parameters, 7-11
tuning
preferredSite parameter, 7-9
tuning environment parameters, 7-11
tuning parameters
dsmMaxBufferSize, 7-11
dsmMaxSortBufferSize, 7-11
dsmMidBufferSize, 7-11
hashBufferSize, 7-11
hashenableParallelism, 7-11
hashMaxDiskSpace, 7-11
hashMaxOpenFiles, 7-12
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useAlternatequalifier parameter,

useTableFilterExpressions parameter,

\'}

verbs

connection, E-2
views, 7-10

setting to compile, 7-10

w

Windows
installing, 2-21

X

XML documents, 7-7
maximum size, 7-7

Y

Y2K
year2000Policy parameter,

7-8
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